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Getting started

This guide provides instructions on using IMA (Interconnect Mediated Access)
for CLECs (including payphone service providers). The guide assumes you
have a background in telecommunications local service, including some
knowledge of CenturyLink™ products and order-writing conventions.

IMA is available for use by CLECS in the legacy Qwest territories within the
former 14-state Qwest region.

Logging in to IMA

To log in to IMA, open a browser window and follow the guidelines in the
Connection Guide.

Interconnect Login

Interconnect
Medlated
Access

Fnter your Corporate ID, Username and Password then Click 'Login'.

Corporate ID:
Username: I
Password:

Clear

=) 8] Lacd irtranet Ei0 -

1 Fill in the three fields, using the values given to you by your system
administrator.

< Note that the fields are case-sensitive.

< Once you have logged in for the first time, be sure to change your
password. (See “Changing your password” on page 176.)

2 Click Login.

April 2, 2012 6
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Creating your personal profile

Creating your personal profile

The first time you log in to IMA, you must complete a personal profile before
you can go on to other tasks. Your personal profile contains information that
CenturyLink uses to contact you.

{= Personal Profile - Windows Internet Explorer, E@E
G0 e o 1 2l

i Fle Edk WView Favorites Took  Help

ik e Fjreme - dmpant < [ Page + 3 Tadks - @ Hep -
2 :

Either an Email address or valid Fax Number is required as part of the User Profile information.

Personal Profile

Name:
Telephone Number:
E-Mail Address:
Fax:
Street Address:
Floor:
Room/Mail Stop:
City:

State: | AL v
Zip/Postal Code:

[ Update Database ][ Logout ]

&4 Local intranet HA00%  +

1 Fill in the fields. (Floor and Room/Mail Stop are optional.)
a For your telephone and fax numbers, use the format 555-555-5555.

b Fill in your e-mail address, fax number, or both to indicate how you
want to receive system notifications.

2 Click Update Database.

3 Click Return to Main Menu.

Logging out of IMA

To log out of IMA, click Return to Main Menu, then click Logout.

If you're working in PreOrder/Order/PostOrder, you may first have to click
Cancel or Close or Finish to close the window(s), then File > Exit to close
the Interconnect Mediated Access window.
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IMA hours (Mountain Time)

IMA hours (Mountain Time)

Monday—Friday 6 a.m. to midnight
Saturday 6 a.m. to 9 p.m.
Sunday 11 a.m. to 7 p.m.

IMA conventions

Buttons

Several buttons appear throughout IMA (and work the same way):

To ... Click ...

Display the information in a separate browser window Print Preview

E-mail the information in the window E-mail

Clear the fields in the form or window Clear or Reset

Close the form or window without saving the information Cancel

Go on to other forms or tasks OK or Close or Finish
Interrupt a process Abort

Access PreOrder functions while filling out LSR forms PreOrder

Repeating sections

Many forms contain repeating sections, allowing you to add multiple features

or lines for a single account. As you add sections, a counter updates to show

how many sections you’ve added and which section you’re currently viewing.

You can move from one section to another by moving the slider below the Add
button.

April 2, 2012 8
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Additional resources

Additional resources

Websites
IMA GUI Error Messages

http://www.centurylink.com/wholesale/ima/gui/all_errormessages_a-

c.html

Local Service Ordering Guidelines
http://www.centurylink.com/wholesale/clecs/Isog.html

Products and Services
http://www.centurylink.com/wholesale/pcat/index.html

Wholesale Customer Contacts business procedure

http://www.centurylink.com/wholesale/clecs/customercontacts.html

Wholesale Resources—IMA

http://www.centurylink.com/wholesale/ima/index.html

Documents

In addition to this document, CenturyLink provides four other guides to help
you use IMA. The first three guides are available at

http://www.centurylink.com/wholesale/ima/gui/index.html:

< IMA Connection Guide—qguidelines for connecting to IMA

e CLEC System Administrator’'s Guide—qguidelines for managing CLEC users’
accounts

< Facility-Based Directory Listings Guide—qguidelines for submitting orders
for facility-based directory listings

The fourth guide is available at
http://www.centurylink.com/wholesale/training/coursecatalog.htmil:

e Loop Qualification and Raw Loop Data CLEC Job Aid—guidelines for
retrieving raw loop data and for checking whether a loop qualifies (for
CenturylLink HSI/Broadband Service or for unbundled ADSL service)
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Before preparing service requests

Before filling out the LSR (local service request) forms, you can do certain
tasks that save time when you actually fill out the forms and that reduce the
chances for errors in your request. Before preparing a request, always try to

- validate the customer’s service address (directly below)

You validate the service address for a customer to make sure that the
address you use on the LSR matches an address in CenturyLink’s
databases.

e review the customer’s CSR (customer service record) (page 19)
You review the CSR for a customer to make sure that they have a live

account and that your records match CenturylLink’s for the customer’s
current listing, billing information, and services and equipment.

Other tasks must be done before you submit a request, but they can be done
either before you prepare the LSR forms or while you’re actually preparing
them. Because those tasks commonly depend on which forms you're
preparing, they are discussed separately (chapter 3).

Validating addresses

Before preparing a request, you should validate your customer’s service
address—that is, make sure that the address you will use on the request forms
matches an address in CenturyLink’s databases. (If the addresses don’t match,
IMA will reject your request.) There’s no need to validate addresses if you're
requesting conversions for Local Number Portability, Loop with Number
Portability (LNP), Unbundled Loop, Loop Split (Unbundled Loop), or UBL Split
w/ NP. But otherwise, try to validate the service address even if it does not yet
have telephone service (for example, because it is for new construction). If
your customer is moving, be sure to validate both their current service address
and what will be their new service address, so that IMA can automatically fill in
both addresses on the End User form and so that you can check to see
whether Dual Service is available if they’'ve requested it. (See “Checking
whether POTS facilities are available” on page 36.)

As long as you don’t close your browser, IMA saves the last 10 addresses you
validated. When you prepare the request forms, you can select any of those
addresses and IMA will automatically fill in the validated address for your
customer.

April 2, 2012 10
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Validating addresses

11

Searching for your customer’s address

To validate the service address, you search for a matching address in
CenturyLink’s databases. You can search by using either the street address or
the current telephone number for the service address. Experiment to find what
type of search works best for you. In general, searches by street address are
more reliable, but searches by telephone number may be easier under certain
circumstances. More specifically:

You must search by street address if your customer’s service address does
not currently have telephone service or if the telephone number for their
service address was ported in from outside the normal wire center for the
service address. And it’'s most effective to search by street address for
service addresses that have many lines (like businesses or government
buildings) or that have Centrex or designed services.

To search by street address, follow the guidelines directly below.

You can typically search by telephone number for service addresses that
have had no major changes in service during the past few months and that
have a working telephone number and a 1FR or 1FB (or similar)
account—typically, single dwellings or small businesses that have few lines
and that do not have Centrex or designed services.

To search by telephone number, see “Searching by telephone number” on
page 13.

Searching by street address

Search by street address

if your customer’s service address does not currently have telephone
service

if the telephone number for their service address was ported in from
outside the normal wire center for the service address

if the service address has many lines (like businesses or government
buildings) or has Centrex or designed services

To search by street address

1

In the Interconnect Functions window, select PreOrder/Order/
PostOrder.

In the Interconnect Mediated Access window, select PreOrder >
Validate Address.

Address Validation Wizard X
Select Address Validation Type:

) Validate by Street Address

) validate by Telephane Number

[ Print Preview “ E-mail “ Start Qver Next == [ Clear ” Finish ]

[

[E——
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Address Validation Wizard

Address Validation by Street Address

2—Before preparing service requests
Validating addresses

3 Select Validate by Street Address, then click Next.

LMAME:

<>

< >

Waligated Addresses:
NoValidated Address ¥
AFT: BAPR! BAMO! BABF

SASD SASN:

CITY: STATE: 7IF:

.

CALASAGA:

Print Preview E-mail

Start Qwer ” <= Previous " Mext ==

SATH: SABS:

v

AHM: ROUTE: BOX

Clear Finish

[

]

[E——

Fill in the fields in this window, following the guidelines in Pre-Order (POP)
at http://www.centurylink.com/wholesale/clecs/Isog.html.

a Skip the Validated Addresses field unless you want to modify an
address that you've already validated—for example, by adding
supplemental address information (page 17).

b Fill in the at least the SASN, CITY, and STATE fields. If you are
requesting a private line, use the service address for location A of the

circuit.

c If the address includes supplemental information such as an apartment

number and

< If you want to validate just one specific location at this address,
select the location designator from one or more of the LD lists, and
type the correct location value (e.g., the number of the apartment
or floor) in each corresponding LV field.

< If you want to validate two or more specific locations at this

address, skip these fields.

d Select the SAGA (street address geographical area) for the service
address from the CALA/SAGA list. If you don’t know the SAGA, search
(Ctrl+F) for your customer’s city in LFACS-AN Community Names at
http://www.centurylink.com/wholesale/systems/street.html, and use

the SAGA given there. If you can’t find the SAGA, fill in the ZIP Code
(you may still need to select the SAGA later on).

Click Next.
One of the following windows appears:

< an error message or an obvious mismatch (Click Previous and repeat
step 4. Check the information you entered for accuracy and enter
additional address information if necessary.)

< Near Matches found. Select one. (See “Selecting from near

matches” on page 14.)

< Multiple CALA/SAGAs found. Select one. (See “Selecting from

multiple CALA/SAGAS” on page 15.)

12
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Validating addresses
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e SAG Only Match Found. (See “Dealing with a SAG Only match” on

page 16.)
e Supplemental Matches found. Select one. (See “Providing
supplemental address information” on page 17.)

e Address Validation Response (See “Checking the address match” on

page 18.)

Searching by telephone number

You can typically search by telephone number for 1FR or 1FB (or similar)
accounts that have had no major changes in service during the past few

months and that have a working telephone number—typically, single dwellings

or small businesses that have few lines and that do not have Centrex or
designed services.

1 In the Interconnect Functions window, select PreOrder/Order/
PostOrder.

2 In the Interconnect Mediated Access window, select PreOrder >
Validate Address.

Address Validation Wizard X

Select Address Validation Type:

@ yalidate by Street Address

O Validate by Telephane Nurmber

| PrintFreview || Evmail || start Over Nt = [ ctear [ Finish |

[

[1va AceletWindow

3 Select Validate by Telephone Number, then click Next.

Address Validation by Telephone Number

WIN:

CALAISAGA: v

ZIP:

| Prntpreview ][ E-mai | stanover | <<pravious ][ nem>» [ ctear ][ Finisn_|

[E——

4 Fill in the fields in this window.

User’s Guide—IMA 32.0

a

o

In the WTN field, type the current telephone number for the service
address. Be sure it’s the current working number. If there are multiple
lines at the service address, be sure to use the billing telephone
number (the number for the main line). If your customer lives near a
state line and the central office is across the state line, use the area
code for the central office rather than your customer’s actual area code.
(Follow the guidelines in http://www.centurylink.com/wholesale/clecs/
preordering.html.)

Select the SAGA (street address geographical area) for the service
address from the CALA/SAGA list. If you don’t know the SAGA, search
(Ctrl+F) for your customer’s city in LFACS-AN Community Names at
http://www.centurylink.com/wholesale/systems/street.html, and use
the SAGA given there. If you can’t find the SAGA, fill in the ZIP Code
(you may still need to select the SAGA later on).

April 2, 2012
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5 Click Next.

2—Before preparing service requests
Validating addresses

One of the following windows appears:

e an error message or an obvious mismatch (Click Previous and repeat
step 4, checking the information you entered for accuracy. If necessary,

validate by street address.)

e Multiple Matches found. Select one. (See “Selecting from multiple

matches” on page 15.)

e Multiple CALA/SAGAs found. Select one. (See “Selecting from
multiple CALA/SAGAS” on page 15.)

e Address Validation Response (See “Checking the address match” on

page 18.)

Selecting from near matches

If the Near Matches found. Select one. window appears, you select your
customer’s address from a list of possible matches.

Determine whether one of the listed addresses matches the address for your

customer.

If one matches ...

If none match ...

a Select the row that shows the correct
address.

b Click Next.

c Do one of the following:

« If the Multiple SAGA/CALAs found.
Select one. window appears, go to
“Selecting from multiple CALA/SAGAS”
on page 15.

« |If the SAG Only Match Found. window
appears, go to “Dealing with a SAG Only
match” on page 16.

= |If the Supplemental matches found.
Select one. window appears, go to
“Providing supplemental address
information” on page 17.

« If the Address Validation Response
window appears, go to “Checking the
address match” on page 18.

a If the SANO Range or AHN Range column
shows a range of numbers, select the row
that shows the correct range.

b In the SANO or AHN field, type the correct
number within the range.

¢ Click Next and do one of the following:

« If the Multiple SAGA/CALAs found.
Select one. window appears, go to
“Selecting from multiple CALA/SAGAs”
on page 15.

« If the SAG Only Match Found. window
appears, go to “Dealing with a SAG Only
match” on page 16.

« If the Supplemental matches found.
Select one. window appears, go to
“Providing supplemental address
information” on page 17.

= If the Address Validation Response
window appears, go to “Checking the
address match” on page 18.

= If you still don’t get a match, go to
“Dealing with addresses that you can’t
validate” on page 18.

14
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Selecting from multiple matches

If the Multiple Matches found. Select one. window appears, you select your
customer’s address from a list of possible matches.

Determine whether one of the listed addresses matches the address for your

customer.

If one matches ...

If none match ...

a Select the row that shows the correct
address.
b Click Next.
c Do one of the following:
= |If the Multiple SAGA/CALAs found.
Select one. window appears, go to
“Selecting from multiple CALA/SAGASs”
on page 15.
« If the Address Validation Response
window appears, go to “Checking the
address match” on page 18.

a Click Previous.
b Check for errors in the information you
entered.
= If you find errors, correct them and
repeat the rest of the procedure. If you
had to guess at the CALA/SAGA, click
Previous and select another credible
CALA/SAGA.
« If you don't find errors, go to “Dealing
with addresses that you can’t validate”
on page 18.

Selecting from multiple CALA/SAGAs

If the Multiple CALA/SAGASs found. Select one. window appears, you need
to select the correct CALA or SAGA for your customer. (CALA is customer
address location area; SAGA is street address geographical area.)

Determine whether one of the listed CALA/SAGAs is correct for your customer.

If one is correct ...

If none are correct ...

a Select the row that shows the correct CALA
or /SAGA.

b Click Next.

c Do one of the following:

« If the SAG Only Match Found. window
appears, go to “Dealing with a SAG Only
match” on page 16.

« If the Supplemental matches found.
Select one. window appears, go to
“Providing supplemental address
information” on page 17.

= |If the Address Validation Response
window appears, go to “Checking the
address match” on page 18.

a Click Previous and check for errors in the
address you entered.
« If you find errors, correct them and try
again to validate the address.
= If you don’t find errors, go to “Dealing
with addresses that you can’t validate”
on page 18.

For further SAGA data, see http://www.centurylink.com/wholesale/systems/

street.html.

April 2, 2012
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Dealing with a SAG Only match

If the following window appears, the address you entered is not in
CenturyLink’s primary database of addresses with existing phone service—it
appears only in a database of street addresses (the SAG or street address
guide). The message most likely appears because the address you entered
doesn’t currently have phone service. If there’s no phone service, CenturyLink
will need to install facilities at the address.

[¥4]5AG Only Match Found.

Message

Quest TH, wvhen submitting request. Qest cannot guarantee
that your DDD will be met for a 5AG Only address.

< >
[

[E——

1 Click OK.

IMA saves the address so that you can select it from the list of validated
addresses on the LSR forms.

2 Make a note to provide additional information on the Remarks tab of the
LSR form (such as a working CenturyLink telephone number from a nearby
address) before you submit the request. Note too that if CenturyLink has to
install facilities, CenturyLink cannot guarantee to meet your desired due
date (DDD).

3 If your request is for new phone service or for an outside move, make a

note to select A or B from the NCON list on the End User or Resale Private
Line form.

Note: When entering a new LOC at an existing service address due to a
SAG Only match in IMA Address Validation, an NCON=B entry
should be made on the End User form.

4 Do any of the following:

e To show the information in a new browser window, click Print
Preview.
e To e-mail the information in the window, click E-mail.

= To validate another address, click Start Over.
(As long as you don’t close your browser, IMA saves the last 10
addresses you validated so that you can select them when you’re filling
out the request forms and automatically fill in fields on the forms.)

e To go on to other tasks, click Finish.

April 2, 2012 16
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Providing supplemental address information

If the Supplemental Matches found. Select one. window appears, you
need to provide additional address information, such as the building, floor, or
room number of the service address.

1 Do one of the following:

To validate just one location at the address, check whether one of the
rows in the window shows the correct supplemental information for the
service address, then follow the guidelines in either column of the table
below.

To validate two or more locations at the address, follow the guidelines
in the right column of the table (even if the window does show the
correct supplemental address information).

If the window shows the If the window doesn’t show the
supplemental address supplemental address
information ... information ...

a Select the row that shows the correct a Click Cancel to close the
information. (If more than one row Supplemental Matches window.
shows the correct information, select b Click Previous.
any of those rows.) ¢ From the Validated Addresses list,

b Click OK. select the address without any
The Address Validation Response supplemental address information.
window displays the service address (You can select an address with
with the supplemental address supplemental address information, but
information you selected. you may overwrite it if you modify it as

c Click Previous. in the steps below.)

d From the Validated Addresses list, d In one or more of the LD lists, select
select the address that includes the the location designator (e.g., RM -
supplemental address information. Room).

e In the corresponding LV field(s), type
the location value (e.g., 14).

2 Click Next.

If the Address Validation Response window appears, check the
address match, following the guidelines in the next section. If there is a
slider above the WTN field, make sure that one of the repeating
sections shows the TN STATUS as WORKING and the correct name
and TN for the current customer.

If the Supplemental Matches found. Select one. window reappears
or if you don’t find a WTN and WORKING TN status along with the
correct customer name, go to “Dealing with addresses that you can’t
validate” on page 18.

3 If you're validating more than one location at the address, repeat steps b—e
in the right column of the table above.

17
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Checking the address match

If the Address Validation Response window appears, the service address
for your customer matches an address in CenturyLink’s databases.

2—Before preparing service requests
Validating addresses

1 Check that the address in the Validated Addresses field matches your
records of the service address (the address you want to use on the LSR).

a Check the customer’s name to make sure it’s accurate for the current
customer at the service address. (You can’t do this for nonpublished

n

umbers.)

b Check the other fields in the window, including those on the three tabs.
(For definitions of the fields, click Pre-Order (POP) at
http://www.centurylink.com/wholesale/clecs/Isog.html.)

c If there is a slider above the WTN field, make sure that one of the
repeating sections shows the TN STATUS as WORKING and the
correct name and TN for the current customer.

If the addresses match ...

If the addresses don’t match ...

Do any of the following:

= To show the information in a new
browser window, click Print Preview.

e To e-mail the information in the
window, click E-mail.

= To validate another address, click
Start Over
(As long as you don’t close your
browser, IMA saves the last 10
addresses you validated so that you
can select them when you're filling out
the request forms and have IMA
automatically fill in fields on the
forms.)

= To go on to other tasks, click Finish.

Check for errors in the address you

entered. Then do one of the following:

« If you find errors, click Previous and
try again to validate the address. If
you had to guess at the CALA/SAGA,
click Previous and select another
credible CALA/SAGA.

= If you don’t find errors, go to “Dealing
with addresses that you can’t validate”
on page 18.

Dealing with addresses that you can’t validate

If IMA displays a message indicating that the information you entered does not

match a

valid address:

1 Check for errors in the information you entered.
e If you find errors, correct them and try again to validate the address.
e If you don’t find errors and
if you searched by street address, try searching by telephone

April 2, 2012
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if you searched by telephone number, try searching by street

address
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2 If your address records seem to be accurate and you still can’t find a valid
match

a Contact CenturyLink and ask them to enter the address in
CenturylLink’s databases before you submit the request. Follow the
guidelines in
http://www.centurylink.com/wholesale/clecs/customercontacts.htmil.

b Make a note that you may need to enter the service address
information manually when you prepare the End User and Resale
Private Line forms.

Reviewing customer service records

19

Before you submit a service request, you should review the CSR (customer
service record) for the customer to ensure that they have a live account and to
check that your records match the CSR for the customer’s listing, billing
information, and current services and equipment. (If there has been a recent
billing change in the customer’s account, the CSR may not indicate that the
account is live, but you may still be able to submit a request for that account.)
When you retrieve a full CSR, you can use the Recap button to fill in the
Service section on the Centrex Resale, Centrex Resale Split, Port Service,
Resale, and Resale Split forms.

Before you retrieve the CSR, make sure that your company already owns the
customer’s account or that you have an LOA (letter of authorization) to view
the CSR.

When you want to review a CSR, you can retrieve

e the full CSR (directly below)
You typically retrieve a full CSR whenever
= you're converting the account of another service provider
< you want to change features on an account that your company owns

< you know that the CSR isn’t too large—for example, it’'s a CSR for a
single telephone number

e you want to use the Recap function
e a partial CSR (page 23)

You typically retrieve a partial CSR when you need only part of the
information in a large CSR—for example, when you need information on
service and equipment for only a few lines on a large Centrex system.

< the CSR as a downloadable electronic file (page 29)

You typically retrieve the CSR as a downloadable electronic file when it is
too large to view online. You can open the file in many word-processing or
spreadsheet programs and view it or print it.

April 2, 2012
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Before you retrieve the CSR, make sure that you either own the account or
have an LOA (letter of authorization) to view the CSR.

1

April 2, 2012

In the Interconnect Functions window, select PreOrder/Order/

PostOrder.

In the Interconnect Mediated Access window, select PreOrder >

Review CSR > Review Full CSR.

Review Full CSR Wizard X
Review Full CSR
acauth: [ - | DATED: il AUTHNM
win: [ - ECCKT: (N<h= A#84 NNN=hnn=. A%)
Reguest USOC Descriptions: ~ | CSRDATE I
Customer Name:
Validated Addresses
Mo Validated Address v
AFT SAPR: SANO SASF
v
SASD: SASN SATH: SASE:
v v
T STATE
-
Print Preview || E-mail Start Over Next =» Clear || Finish
[1va AceletWindow

Do one of the following, using the guidelines in Customer Service Record
Inquiry (CSR) at http://www.centurylink.com/wholesale/clecs/Isog.html:

If you are the customer’s service
provider ...

If you are not the customer’s
service provider but have an LOA
(letter of authorization) on file ...

In the AGAUTH (agency authorization
status) field, select N—No Authorization.

a In the AGAUTH (agency authorization
status) field, select Y—Authorization on
File

b In the DATED field, type the date of the
LOA (YYYY/MM/DD).

c (Optional) In the AUTHNM (authorization
name) field, type the name of the person
who signed the LOA.

Type the telephone number in the WTN field or the circuit ID in the ECCKT

field.

e For a standard 10-digit telephone number, type the customer's billing
number or working telephone number. If you know the customer code,
type it in the field immediately to the right of the WTN field.

e For trunk-based or circuit-based products such as PRI ISDN, Private
Line, or UBL, use the circuit ID if possible. If you don’t know the circuit
ID, type the special billing number (SBN—for example, 265 A33 2145)

in the WTN field.

If you want the CSR to include descriptions of the USOCs, select Y—Yes in
the Request USOC Descriptions field. (Descriptions are currently
available only for the Western and Eastern regions.)

20
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6 In the CSR DATE field, type the date for which you want the CSR to reflect
pending service orders. Use the current date or a future date—typically, the
due date. (If the CSR reflects all pending service orders, your request can
be handled more efficiently.) If you retrieved the CSR by clicking the
PreOrder button on one of the LSR forms, type the DDD for the LSR here.

7 Click Next.

If the Review Full CSR—Response window appears, continue with
step 8.

If the Multiple matches found. Pick one. window appears, select the

customer’s account from the list. (CenturyLink-specific fields are

explained in Customer Service Record Inquiry (CSR) at http://

www.centurylink.com/wholesale/clecs/Isog.html.) Then click Next, and

continue with step 8.

If the message No active account found appears,

a Check the WTN or circuit ID you entered in step 4 above. If
necessary, correct it and repeat the procedure.

b Type the listed name or the subscriber name of the customer in the

Customer Name field.

- If the customer is a residential customer, type the name in the
format Smith, John

- If the customer is a business customer, type the full business
name without abbreviations, for example, CenturyLink,
Incorporated.

¢ Do one of the following:

« If you have validated the address of the customer whose CSR
you want, select the address from the Validated Addresses
list.

IMA automatically fills in the remaining fields on the window.

« If you weren’t able to validate the address, fill in at least the
SASN, CITY, STATE, and CALA/SAGA fields, following the
guidelines in “Validating addresses” on page 10.

d Click Next and continue with step 8.

8 Check the message in the center of the window (just above the tabs).

21

If the message is Complete Customer Record Displayed, IMA
displays the complete CSR. Go to “If the complete CSR is displayed” on
page 22.

If the window shows any other message, IMA cannot display the
complete CSR. Click Next and go to “If the complete CSR is not
displayed” on page 23.

April 2, 2012
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If the complete CSR is displayed

1 Review the information in the CSR.

The Vcsr field indicates whether the CSR includes information for pending
service orders as of the date shown in the CSR DATE field.

The window shows the Listing, Billing, Service and Equipment, and Pending
Order sections of the CSR as tabs:

The Listing tab displays the customer’s listing information.
The Billing tab displays the customer’s billing name and address.

The Service and Equipment tab displays the type of services and
equipment on the customer’s account.

If there are pending service orders, the Pending Order tab displays
the service order number and due date for each pending service order
and indicates whether the CSR includes data from each of those service
orders as of the date shown in the CSR DATE field. (If the Order Due
Date field is 00000000, no due date has yet been assigned to the
service order.)

2 When you are finished viewing the CSR, do any of the following:

To display the information in a separate browser window, click Print
Preview.

To e-mail the CSR, click E-mail.
To retrieve another full CSR, click Start Over.

(If you plan to use to use the Recap function to fill in the fields in the
Service section on the Centrex Resale, Centrex Resale Split, Port
Service, Resale, or Resale Split form, click Finish and continue filling
out the form before you retrieve any more CSRs.)

To go on to other tasks, click Finish.

22
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If the complete CSR is not displayed

If the message in the center of the window (just above the tabs) displays any
message other than Complete Customer Record Displayed, do one of the

following:

If you need to see more data for the
CSR ...

If you do not need to see any more
data for the CSR ...

a Click Next.
b In the window that appears, do any or all of
the following:
= To retrieve additional data, click
Retrieve Additional CSR Data.
The Review Full CSR—Response
window (the previous window)
reappears, and IMA displays additional
data for the CSR.
= To e-mail the full CSR, click E-mail all/
partial CSR Data.
« To create a downloadable electronic file
of the full CSR, click Create Electronic
File of all/partial CSR Data, then click
Next. When you are ready to download
the electronic file, go to “Retrieving
CSRs as downloadable electronic files”
on page 29.

Do one of the following:

« Click Start Over to retrieve another full
CSR.

« Click Finish to go on to other tasks.

Retrieving a partial CSR

You can retrieve a partial CSR either by WTN (working telephone number) or
by ECCKT (circuit ID). If you search by WTN, you can retrieve CSR information
for up to 30 WTNs on the same account in a single query.

Before you retrieve the CSR, make sure that you either own the account or
have an LOA (letter of authorization) to view the CSR.

Retrieving a partial CSR by WTN

If you want to retrieve more than one CSR for an account, you can retrieve
partial CSRs by WTN (working telephone number).

1 In the Interconnect Functions window, select PreOrder/Order/

PostOrder.

23
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s window, select PreOrder >

Review CSR = Review Partial CSR > Retrieve by WTN(s).

Review Partial CSR - Response

Review Partial CSR by WTN Wizard @

LIVE Accaunt Descriptor.

AN

a70-472-2000 CustCode: [a45  Line Status:

—

Narne: |

ECCKT: |
Summary Billing Number

B-18-97 Class Of Sve:

COrig. Sve. Established

FFMUX  Reseller ID

Listing Billing | Service and Equipment

|

Dept Locn

Start Qver

Print Preview E-mail

i «<Previous :

Finish

[1va AceletWindow

Do one of the following, using the guid

elines in Customer Service Record

Inquiry (CSR) at http://www.centurylink.com/wholesale/clecs/Isog.html:

If you are the customer’s service
provider ...

If you are not the customer’s
service provider but have an LOA
(letter of authorization) on file ...

In the AGAUTH (agency authorization
status) field, select N—No Authorization.

a In the AGAUTH (agency authorization
status) field, select Y—Authorization on
File.

b In the DATED field, type the date of the
LOA (YYYY/MM/DD).

c (Optional) In the AUTHNM (authorization
name) field, type the name of the person
who signed the LOA.

If you want the CSR to include descriptions of the USOCs, select Y—-Yes in

the Request USOC Descriptions field. (Descriptions are currently
available only for the Western and Eastern regions.)

number. If you know the customer cod
the right of the BTN field.

In the BTN field, type the customer’s billing number or working telephone

e, type it in the field immediately to

April 2, 2012

If the WTN field is dimmed, click Add so that you can add a WTN.
(If the field is already filled, check the WTN and revise it if necessary.

The counter updates to show the current number of repeating WTN
sections.
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7

8

In the WTN field, type the customer’s billing number or working telephone
number.

If you want to retrieve CSR information for additional WTNs on the same
account (up to 30), repeat steps 6—7.

 To view a different WTN, drag the slider.
e To delete a WTN, click Delete Current.
« To clear the fields for one of the WTNSs, click Clear Current.

Click Next, and do either of the following:

- If the window that appears indicates that IMA has found the CSR
information, continue with step 10.

- If the message No active account found appears,
a Check the WTN you entered in step 7 above. If necessary, correct it
and repeat the procedure.
b Type the listed name or the subscriber name of the customer in the

Customer Name field.

e If the customer is a residential customer, type the name in the
format Smith, John.

- If the customer is a business customer, type the full business
name without abbreviations, for example, CenturyLink,
Incorporated.

< If you validated the address of the customer whose CSR you
want, select the address from the Validated Addresses list.
IMA automatically fills in the remaining fields on the window.

« If you weren’t able to validate the address, fill in at least the
SASN, CITY, STATE, and CALA/SAGA fields, following the
guidelines in “Validating addresses” on page 10.

c Click Next and continue with step 10.

April 2, 2012
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Review Partial CSR by WTN Wizard X
Review Partial CSR - Response

AN @70-472-2000 CustCode: [ag5 | Line Status:  [CjvE Account Descriptor

Name: |

ECCKT |

Summary Billing Number.

Orig. S, Established, B-18-97 Class OTSve.  [FRMUX Reseller D Dept: Loen

Listing Billing | Service and Equipment

el ;I_‘

Print Preview E-mail Start Cver Finish
‘JavaApp\elW\ndnw

11 Review the information in the window.

The Listing tab displays the customer’s listing information.
The Billing tab displays the customer’s billing name and address.

The Service and Equipment tab displays the type of services and
equipment on the customer’s account.

12 If the CSR contains more information than can be displayed in the window,
the Next button is active. Click Next to see that information.

13 In the window that appears, do any or all of the following:

To retrieve additional data, click Retrieve Additional CSR Data.

The Review Partial CSR—Response window (the previous window)
reappears, and IMA displays additional data for your review.

To e-mail the partial CSR, click E-mail all/partial CSR Data.

To create a downloadable electronic file of the partial CSR, click Create
Electronic File of all/partial CSR Data, then click Next. When you
are ready to download the electronic file, go to “Retrieving CSRs as
downloadable electronic files” on page 29.

14 When you are finished viewing the CSR, do any of the following:

April 2, 2012

To display the CSR information in a separate browser window, click
Print Preview.

To e-mail the CSR, click E-mail.
To retrieve another partial CSR by WTN, click Start Over.
To go on to other tasks, click Finish.
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Retrieving a partial CSR by ECCKT

If you have an ECCKT for the account (circuit ID—for example, for Resale
Private Line), you can use it to retrieve the CSR.

1 In the Interconnect Functions window, select PreOrder/Order/

PostOrder.

2 In the Interconnect Mediated Access window, select PreOrder >
Review CSR > Review Partial CSR > Retrieve by ECCKT.

Review Partial CSR by ECCKT Wizard X
Retrieve Partial CSR by ECCKT
AGAUTH: _Lf DATED I AUTHRM:
ECCKT: {N<n>AAAANNN<nnn>. A8)
Request USOC Deseriptions: j
Customer Name
Validated Addresses:
1o Validated Address - |
AFT. SAPR: SAND BASF
SASD SASN SATH: SASS:
CITY: STATE
Print Preview E-mail Start Over Mext Clear Finish
[E——

3 Do one of the following, using the guidelines in Customer Service Record
Inquiry (CSR) at http://www.centurylink.com/wholesale/clecs/Isog.html:

If you are the customer’s service
provider ...

If you are not the customer’s
service provider but have an LOA
(letter of authorization) on file ...

In the AGAUTH (agency authorization
status) field, select N—No Authorization.

a In the AGAUTH (agency authorization
status) field, select Y—Authorization on

File.

b In the DATED field, type the date of the
LOA (YYYY/MM/DD).

c (Optional) In the AUTHNM (authorization
name) field, type the name of the person
who signed the LOA.

4 In the ECCKT field, type the customer’s circuit ID. If you're using a circuit
ID that is longer that 24 characters, make sure you also fill in the State
field.

5 If you want the CSR to include descriptions of the USOCs, select Y-Yes in
the Request USOC Descriptions field. (Descriptions are currently
available only for the Western and Eastern regions.)

6 Click Next.

- If the window that appears indicates that IMA has found the CSR
information, click Next and continue with step 7.
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« If the message No active account found appears, follow the steps
below or try to retrieve by WTN. (See “Retrieving a partial CSR by
WTN” on page 23.)

a Type the listed name or the subscriber name of the customer in the

Customer Name field.

- If the customer is a residential customer, type the last name
followed by a comma and then the first name, for example:
Smith, John.

e If the customer is a business customer, type the full business
name without abbreviations, for example, CenturyLink,
Incorporated.

b Do one of the following:

< If you have validated the address of the customer whose CSR
you want, select the address from the Validated Addresses
list.
IMA automatically fills in the remaining fields on the window.

< If you weren’t able to validate the address, fill in at least the
SASN, CITY, STATE, and CALA/SAGA fields, following the
guidelines in “Validating addresses” on page 10.

Review the information in the window that appears.
< The Listing tab displays the customer’s listing information.
< The Billing tab displays the customer’s billing name and address.

e The Service and Equipment tab displays the type of services and
equipment on the customer’s account.

If the CSR contains more information than can be displayed in the window,
the Next button is active. Click Next to see that information.

In the window that appears, do any or all of the following:

e To retrieve additional data, click Retrieve Additional CSR Data.

The Review Partial CSR—Response window (the previous window)
reappears, and IMA displays additional data for your review.

< To e-mail the partial CSR, click E-mail all/partial CSR Data.
< To create a downloadable electronic file of the partial CSR, click Create
Electronic File of all/partial CSR Data, then click Next. When you

are ready to download the electronic file, go to “Retrieving CSRs as
downloadable electronic files” on page 29.

10 When you are finished viewing the CSR, do any of the following:

 To display the CSR information in a separate browser window, click
Print Preview.

= To e-mail the CSR, click E-mail.
< To retrieve another partial CSR by ECCKT, click Start Over.

(If you plan to use to use the Recap function to fill in the fields in the
Service section of the Centrex Resale, Centrex Resale Split, Port
Service, Resale, or Resale Split form, click Finish and continue filling
out the form before you retrieve any more CSRs.)

< To go on to other tasks, click Finish.
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Retrieving CSRs as downloadable electronic files

You can retrieve and download both full and partial CSRs as electronic files
that you can open in many word-processing or spreadsheet programs so that
you can view or print them. You commonly do this if the CSR is too large to
view on the screen.

1

In the Interconnect Functions window, select PreOrder/Order/
PostOrder.

In the Interconnect Mediated Access window, select PreOrder >
Review CSR > Retrieve Electronic File List.

Review Electronic File CSR Wizard X

Electronic File List Screen

CCNA: CcC:

Highlight File You Wish to Retrieve

C5R Retrieval ldentifier Date-Time

000-000-0000 |200408231458 |a
000-000-0000 [200208231458 |~
< >

| PrintFreview || Email || Refresh | Retrieve CER Finish

[1va AceletWindow

The window shows the files that you’'ve created.
(If a list of files doesn’t appear, click Refresh.)

In this field ... IMA displays ...

CSR Retrieval lIdentifier The WTN, ECCKT, or AN and Cust Code (REFNUM). If you
retrieved the CSR by WTN, the WTN or the BTN for the
account appears here.

Date-Time The date and time you created the electronic file.

For further information, click Customer Service Record Inquiry (CSR)
at http://www.centurylink.com/wholesale/clecs/Isog.html.

Select the CSR whose file you want to retrieve.

Tip: To retrieve more than one file, hold the CTRL key while you select
additional CSR files.

You can download each file for two IMA business days after you select it.

Do any of the following:

« To retrieve the electronic file, click Retrieve CSR. If you're using
Internet Explorer, select File > Save As in the browser window that
appears and then use the dialog box that appears to save the electronic
file.

< To display the list of files in a separate browser window, click Print
Preview.

e To e-malil the list of files, click E-mail.

< To go on to other tasks, click Finish.
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Before submitting service requests

A number of “preorder” tasks need to be done before you submit an LSR but
not necessarily before you start preparing it. Because some of those tasks
depend on the type of request you’re preparing, you may want to do them
while you’re actually preparing the LSR. You can do many of these tasks by
clicking PreOrder on certain LSR forms while you're preparing them. When
you click PreOrder on the forms, IMA shows the tasks you might need to do
before you submit the request you're preparing.

You can

April 2, 2012

check whether the services you want are available (page 31)
You check whether services are available to determine
< whether the central office supports those services

« whether CenturyLink can provide them to your company, given your
contract with CenturyLink and the state in which you’re requesting
them

check whether the facilities you want are available (page 34)

You check for available facilities to determine whether the facilities needed
to support the services you’re requesting currently exist.

select available CFA units (page 42)

You select available CFA (carrier facility assignment) units for loop services
you are requesting.

find available meet points (page 46)

You search for available meet points when you want to unbundle the data
portion of a loop from the voice portion. You use the meet point data to
find out where your company’s data equipment meets CenturyLink’s
equipment.

retrieve raw loop data (page 53)

You retrieve raw loop data to get the physical characteristics of a loop.
Typically, you do this so your engineers can determine whether the loop
can carry your company’s DSL service without network modifications.

check loop qualification (page 54)

You check loop qualification to determine whether your customer’s line
qualifies for CenturyLink HSI/Broadband Service or unbundled ADSL
service.

30
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e reserve telephone numbers (page 54)

You reserve one or more telephone numbers whenever you request new
service, a new line on existing service, or a change of telephone number.

e manage appointments (page 59)

You schedule appointments to set up a date and time for a technician to
install new facilities or to modify facilities at either the wire center or your
customer’s premises. You change appointments when there’s a need to
reschedule them. You cancel appointments so that your company won’t be
charged for a dispatch that’s not needed.

Checking whether services are available

April 2, 2012

Before you submit a request for POTS products, you should check whether the
services you want to request for your customer are available for you to
resell—that is,

« whether the central office supports them

« whether CenturyLink can provide them to your company, given your
contract with CenturyLink and the state in which you’re requesting them

You can check which features and services, which carriers, and which switches
are available. If you request services that aren’t available, you won’t be able to
submit your LSR successfully. To check whether Dual Service is available,
follow the guidelines in “Checking whether POTS facilities are available” on
page 36.

You can check whether services are available before you prepare the LSR
forms or by clicking PreOrder on various forms while you’re preparing them.

1 In the Interconnect Functions window, click PreOrder/Order/
PostOrder.

2 If you are checking services on behalf of another CLEC and if the menu bar
of the Interconnect Mediated Access window doesn’t already show the
corporate ID for that CLEC, continue with this step. Otherwise, skip to step
3.

a In the Interconnect Mediated Access window, click File > Select
Owner CCNA.

b From the list that appears, select the CLEC for which you are checking
services. Click Submit.

The CCNA for the other CLEC appears in the menu bar for the
Interconnect Mediated Access window.
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3 Click PreOrder > Service Availability.

Service Availability Query E]
Request Section
NPA: NXX: State:  Type: UBaC: INFO TYPE
v Busingss 5- Single %
Response Section
Features / Services | Carriers| Switches
ST usoc Modifier Description NRetail RRetail Switth Supp . NDist RDist
-~
v
< >
Print Freview E-mail Submit Query Clear Close
‘Jave Applet Window

4 Fill in the active fields.

a In the NPA and NXX fields, type the NPA and NXX for the wire center.
b In the USOC field, do one of the following:
« To list all the services that are available, leave the field blank.

« To check whether a specific service is available, type the complete
USOC for that service.

- To list all the services whose USOCs start with certain letters, type
one or more letters of the USOC followed by an asterisk (for
example, type E* to list all the USOCs that start with E).

c In the INFO TYPE list, do one of the following:

« to list the USOCs and PICs for a specific NPA-NXX, select S—Single
- to list the different switch types and the NPA-NXXs for each switch
in a multi-switch wire center, select M—Multiple
5 Click Submit Query.

The Features/Services tab lists the features and services that are
available. (The number in parentheses next to the tab name shows the
number of features and services that are available.)

In this column ... The Features/Services tab displays ...
ST The state in which you’re requesting the service
usocC The Universal Service Order Code for each service
Modifier The modifiers associated with each USOC
Description A description of each USOC
NRetail CenturyLink’s nonrecurring retail rate
RRetail CenturyLink’s recurring retail rate
Switch Supp Whether the service is available on the switch:
Y = yes, U = unknown
NDisc The nonrecurring discount
RDisc The recurring discount
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6 Click the Carriers tab.

Service Availability Query

[

Request Section
NPA:  NAX:  State: Type: usoc INFO TYPE
¥/ [Business v S- Single ¥

Respanse Section

Features / Services| Carriers | Switches

Cartier ID Service Offering Carrier Name
-~
v

< >

Print Preview | E-mail Submit Query Clear Close

‘JaveADD\elW\nduw

The Carriers tab lists the carriers that are available. (The number in

parentheses next to the tab name shows the number of available carriers.)
It displays the following information:

In this column ...

IMA displays ...

Carrier ID

The identification code for the carrier

Tip: To sort the carriers by ID, click the Carrier 1D column
heading.

Service Offering

Whether the carrier offers intraLATA or interLATA service

Carrier Name

The name of the carrier

Tip: To sort the carriers by name, click the Carrier Name
column heading.

Service Availability Query

Click the Switches tab.

[

Request Section
NPA:  NAX:  State: Type: usoc INFO TYPE
¥/ [Business v - Single %
Respanse Section
Features / Services| Carriers| Switches
Print Preview | E-mail Submit Query Clear Clase
‘JaveADD\elW\nduw

The tab lists the swi
parentheses next to

tches available at the wire center. (The number in
the tab name shows the number of available

switches.) If you filled in the NPA and NXX for the wire center and selected
Multiple as the INFO TYPE, the tab also lists the NPA and NXXs serviced by

each switch.

you want to request

Preview.

April 2, 2012
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When you have checked all three tabs to determine whether the services

are available, do any of the following:

To show the information in a new browser window, click Print
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e To e-mail the information, click E-mail.

 To check whether services are available for another NPA/NXX (or
whether different services are available), click Clear.

e To go on to other tasks, click Close.

Checking whether facilities are available

Before requesting certain services, you can check whether the facilities to
support them are currently available between the central office and the
customer’s premises. You can check whether facilities are available before you

prepare the LSR forms or by clicking PreOrder on many of the forms while
you’re preparing them.

Checking whether facilities are available for designed
services or digital services
You can check whether CenturyLink facilities are available for provisioning
most designed and digital (HICAP) services. But to check for the availability of

circuits riding a higher non-CenturyLink facility (for example, a DS1 riding a
DS3), you need to contact your CenturylLink service manager.

1 In the Interconnect Functions window, click PreOrder/Order/
PostOrder.

2 Do one of the following:

To check facilities for designed To check facilities for HICAP digital
services ... services ...
In the Interconnect Mediated Access In the Interconnect Mediated Access

window, select PreOrder > Check Facility window, select PreOrder > Check Facility
Availability > Design Services Request. | Availability > HICAP Request.

(The following figure shows the Designed Services window, but the
HICAP window has the same fields.)

Design Service Facility Availability Request Wizard @
Design Services Facility Request
[Clinglude Losation 2
Main | Location A
Service Request Data
Quantity of Circuits Requested: | 1 Class of Service: Assignable USOC:
Service Code: hiux Location:
CFA Data
Fac. Designation: Fac. Type: Channel
Lacation A: Location Z
Print Preview E-mail Start Cver Mext == Clear Finish
‘Jave Applet Window
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3 On the Main tab, fill in the fields, following the guidelines for each field in

Pre-Order (POP) at http://www.centurylink.com/wholesale/clecs/Isog.html.
The table below shows guidelines for fields specific to IMA.

In this field ... Type ...

Quantity of Circuits The number of lines you're requesting

Requested

Class of Service The USOC for the class of service you're requesting
Assignable USOC The line-assignable USOC that, together with the class of

service and service code, specifies the type of facilities
you’re requesting

Service Code The first two characters of the NC code that defines the
type of service on the circuit
(For guidelines on finding NC codes, see page 181)

Mux Location The CLLI code for the central office that provides
multiplexing for a service riding the designed service

Fac Designation The facility designation

Fac Type The facility type

Channel The channel or time slot to be provisioned
Location A The CLLI code for Location A

Location Z The CLLI code for Location Z

4 Click the Location A tab.

D4 Design Service Facility Availability Request Wizard

Design Senaces Facility Request

[Clinchude Location 2

Main Location &

Validaled Addresses
No Validated Address ¥

AFT. SAPR BAND: GAST
SASD. SASH SATH SASE.
v v

Lot i LD2. w2 LD3. L2, AHN. ROUTE. BOX

;. STATE: 2P

CALNSAGA

3
Print Prisaiw || E-mail Stan Ovie | pient 2= | crear || Finisn

R

A e

5 Do one of the following:

If you validated the address ... If you didn’t validate the address ...
From the Validated Addresses list, Fill in the SANO, SASN, CITY, STATE, and
select your customer’s address. CALA/SAGA fields, following the guidelines
IMA automatically fills in the address in “Validating addresses” on page 10.

fields and the Site ID and TTA fields.
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6 If you need to check a second location, select the Include Location Z
check box, click the Location Z tab, and repeat step 4.

7 Click Next.

IMA indicates whether facilities are available for the service and address
you specified.

In this field ... IMA displays ...

Quantity of Circuits The number of lines you specified

Requested

CFA Status Whether the facility is available

MUX Status Whether the multiplexer is available

Location A Number of The number of facilities available for the request

Facilities Satisfied

Location A Remarks Free-form comments pertinent to Location A

Location Z Number of The number of facilities available for the request
Facilities Satisfied

Location Z Remarks Free-form comments pertinent to Location Z

8 After reviewing the data, do any of the following:

 To display the information in a new browser window, click Print
Preview.

e To e-mail the information in the window, click E-mail.
e To retrieve new data, click Start Over.
 To close the window and go on to other tasks, click Finish.

Checking whether POTS facilities are available

You can check whether POTS facilities are available using either your
customer’s address or their TN. In general, checking by telephone number
may be easier, but checking by street address is more reliable, especially if
you’re checking to see whether Dual Service is available. (If your customer is
moving, Dual Service enables them to use the same telephone number for
both the old and the new service address for up to 30 days.)

Checking availability by address

1 In the Interconnect Functions window, click PreOrder/Order/
PostOrder.
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In the Interconnect Mediated Access window, select PreOrder >
Check Facility Availability > POTS Facility Request.

Address Request | TN Request

POTS Facility Availability Reguest Wizard 3
POTS Facility Request
Quantity of Lines Requested: Local Service Office:

Validated Addresses:
Mo Validated Address ¥
AFT: SAPR SANO: SASF:
-

SASD: SASN: SATH SASS:

~ -
LD1 L1 LDz L2 LD3 Lva: AHN ROUTE: BOX

v v v
Iy STATE: ZIP

-
CALA/SAGA:
v
Print Preview E-mail Start Over MNext == Clear Finish

[

l

[E——

Enter the number of lines you are requesting.

On the Address Request tab, do one of the following:

If you validated the address ...

If you didn’t validate the address ...

From the Validated Addresses list,
select your customer’s address. (If your
customer is moving and you want to
request Dual Service, select either the old
or the new address, then repeat the
procedure for the other address.)

IMA automatically fills in the address
fields and the Site ID and TTA fields.

a Type the NPANXX for the local service office.

b Fill in the SANO, SASN, CITY, STATE, and
CALA/SAGA fields, following the guidelines
in “Validating addresses” on page 10. (If
your customer is moving and you want to
request Dual Service, enter either the old or
the new address, then repeat the procedure
for the other address.)
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POTS Facility Response
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POTS Facility Availability Request Wizard @

POTS Section
Number OTWarking Left-in Lines 1 Dual Service: Available REMINDER: Check both service addresses
Quantity Of Lines Requested 1
Status Dispatch Status Comments
PPOINTMENT SCHEDULER REQUIRED Al
A s
¥+
< >
Mumber Of Unsupported Products: | g
Progucts Not Supported
>
Pending Order Section
Murmber Of Pending Orders: | o
Fending Order Type Order Number Due Date
< b
Print Preview E-mail Start Over == Previous Finish

[

|

[1va AceletWindow

IMA shows the facilities available for POTS service for the account you
specified. For further explanation of each field, click Pre-Order (POP) at
http://www.centurylink.com/wholesale/clecs/Isog.html.

In this field ...

IMA displays ...

Number Of Working Left-In
Lines

The number of lines currently working at the specified
address

Dual Service

Available indicates that Dual Service is available at the
service address you specified. (If your customer is
moving, Dual Service enables them to use the same
telephone number for both the old and the new service
address for up to 30 days.) Be sure to check whether it’s
available at the other address too.

Quantity Of Lines
Requested

The number of lines you specified

Status

The status of the lines you requested
 A=available
= H=held order
e S=available (SDT)

Dispatch Status

Whether a dispatch is required
e Y=yes
* N=no

Comments

Further explanation of the status

Number Of Unsupported
Products

Number of products the loop facility does not support

Products Not Supported

The products that are not supported on the loop facility

Number Of Pending Orders

The number of pending orders for the address you
specified

Pending Order Type

The type(s) of the pending orders

Order Number

The order number(s) for the pending orders

Due Date

The due date(s) for the pending orders

April 2, 2012

38

http://www.centurylink.com/wholesale/cmp/review_archivesystem.html


http://www.centurylink.com/wholesale/clecs/lsog.html
http://www.centurylink.com/wholesale/clecs/lsog.html

User’s Guide—IMA 32.0 3—Before submitting service requests
Checking whether facilities are available

6 If your customer is moving and has requested Dual Service and if you've
found that Dual Service is available at either the old or the new location,
repeat this procedure to ensure that it is available at the other location as
well.

7 After reviewing the data, do any of the following:

 To display the information in a new browser window, click Print
Preview.

e To e-mail the information in the window, click E-mail.
e To retrieve new data, click Start Over.
« To close the window and go on to other tasks, click Finish.

Checking availability by TN

Remember that if you're checking to see whether Dual Service is available, it's
better to check by address—using the WTNs for the old and the new addresses
may not give reliable results.

1 In the Interconnect Functions window, click PreOrder/Order/
PostOrder.

2 In the Interconnect Mediated Access window, select PreOrder >
Check Facility Availability > POTS Facility Request.

POTS Facility Availability Request Wizard 3
POTS Facility Request
Quantity of Lines Requested: Local Service Office:
Address Request | TN Request
Validated Addresses:
Mo validated Address ¥
AFT SAPR SANO: SASF
v
SASD: SASN: SATH sASS:
v v
Lo1: v Lp2: L LD3 va: BHN ROUTE: BOX
v v v
oy STATE: ZIP
v
CALAISAGA:
v
Print Preview E-mail Start Over MNext == Clear Finish

[ l

[E——

3 Type the number of lines you are requesting and the NPANXX for the local
service office.
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POTS Facility Availability Request Wizard K

Address Request| TN Request |

Zip Code:

Quantity of Lines Requested: |:| Local Service Office: |:|

CALAISAGA [

v

PrintPreview || E-mail_|

Stant over Next => [ clear ][ Fmizn |

l

Java Applet Window

5 Enter the telephone number and the ZIP Code or CALA/SAGA.

6 Click Next.

POTS Facility Response

POTS Facility Availability Request Wizard =

POTS Section

Numper OTWorking Laftin Lings Dual Serice: | Available || REMINDER: Check buth senice addresses
Quantity Of Lines Requested
Status Dispatch Status Comments
PPOINTMENT SCHEDULER REQUIRED N
A v
v|v
< >
Mumber Of Unsupponed Praducts El
Products Not Suppoarted
< >
Pending Order Section
Number 07 Pending Crders: E
Pending Order Type Order Number Due Date
< >
PrintPreview || E-mail_| Stanover || << Previous [ Fmnisn_ |

)

Java Applet Window

IMA shows the facilities available for POTS service for the account you
specified. For further explanation of each field, click Pre-Order (POP) at

http://www.centurylink.com/wholesale/clecs/Isog.html.

In this field ...

IMA displays ...

Number Of Working Left-In
Lines

The number of lines currently working at the specified
address

Dual Service

Generally not applicable for searches by TN. Available
indicates that Dual Service is available at the service
address you specified. (If your customer is moving, Dual
Service enables them to use the same telephone number
for both the old and the new service address for up to 30
days.)

Quantity Of Lines
Requested

The number of lines you specified

April 2, 2012
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In this field ...

IMA displays ...

Status

The status of the lines you requested
* A=available
* H=held order
e S=available (SDT)

Dispatch Status

Whether a dispatch is required
e Y=yes
= N=no

Comments

Further explanation of the status

Number Of Unsupported
Products

Number of products the loop facility does not support

Products Not Supported

The products that are not supported on the loop facility

Number Of Pending Orders

The number of pending orders for the address you
specified

Pending Order Type

The type(s) of the pending orders

Order Number

The order number(s) for the pending orders

Due Date

The due date(s) for the pending orders

7 After reviewing the data, do any of the following:

e To display the information in a new browser window, click Print

Preview.

e To e-mail the information in the window, click E-mail.
< To retrieve new data, click Start Over.
< To close the window and go on to other tasks, click Finish.

Checking whether a POTS loop can be unbundled

You can view the characteristics of a POTS loop to see whether it can be
unbundled without being moved.

You can determine

< whether the loop is copper or pair gain

< whether there are bridged taps or load coils on the loop

< whether the loop must be moved to copper to be unbundled

You can retrieve the loop characteristics by entering your customer’s

e street address
« telephone number

e circuit ID (ECCKT)

You can check POTS loops before you prepare the LSR forms or by clicking

PreOrder on many of the forms while you’re preparing them.

The procedure for checking whether a POTS loop can be converted is detailed
in chapter 4 of the Loop Qualification and Raw Loop Data CLEC Job Aid at
http://www.centurylink.com/wholesale/training/coursecatalog.html.
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Checking ISDN facility availability

You need to check whether ISDN facilities are available when you request new
service, a new line for an existing customer, or an outside move for ISDN BRI
lines (Integrated Services Digital Network—Basic Rate Interface). (You can
also check whether an unbundled loop is capable of carrying ISDN signals.)
You check to see whether there are any facilities available that are 1ISDN-
capable and that can support the number and type of ISDN BRI lines you are
requesting—that is, whether they can support the required switching,
channels, and protocol. You check ISDN-capable facilities by entering your
customer’s street address. (Try to validate the address first, if possible.)

You can check ISDN facility availability before you prepare the LSR forms or by
clicking PreOrder on the Resale form while you’re preparing it.

The procedure for checking whether ISDN-capable facilities are available is
detailed in chapter 4 of the Loop Qualification and Raw Loop Data CLEC Job Aid
at http://www.centurylink.com/wholesale/training/coursecatalog.html.

Selecting available CFA units

Either before or while preparing an LSR, you need to select one of the available
carrier facility assignment (CFA) units for the services you are requesting. To
do so, you select one of the available CFA units from a list of units. You can
select available CFA units before you prepare the LSR forms or by clicking Add
and then clicking Validate CFA or PreOrder > Validate CFA on the following
forms while you’re preparing them:

e Loop Service
e Loop Service with Number Portability
= Port Service

If you select unit(s) while you are actually preparing a Loop Service, Loop
Service with Number Portability, or Port Service form, IMA automatically enters
the CFA information (CABNM/CABTYP/<unit>/LOCA/LOCZ) in the CFA list on
the form.

You can find the available CFA units either by specifying the units directly or by
searching first for CFA groups and then selecting the units from the groups.

1 In the Interconnect Functions window, click PreOrder/Order/
PostOrder.

2 If you are selecting CFA units on behalf of another CLEC and if the menu
bar of the Interconnect Mediated Access window doesn’t already show
the corporate ID for that CLEC, continue with this step. Otherwise, skip to

step 3.
a In the Interconnect Mediated Access window, click File > Select
Owner CCNA.
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b From the list that appears, select the CLEC for which you are checking
CFA units. Click Submit.

The CCNA for the other CLEC appears in the menu bar for the
Interconnect Mediated Access window.

3 In the Interconnect Mediated Access window, click PreOrder >
Validate CFA.

CFA Validation Wizard X
CFA Validation
ACNA  LOCA Locz CABHM FIRSTUNIT  LAST UNIT
v v - v v ~
| PrintFreview || Email | [ start ower Next > Clear |[ Finish
[1va AceletWindow

4 Do one of the following:
« To list CFA groups, fill in the ACNA, LOCA, and LOCZ fields.
(If you’ve previously filled in these fields during the time you’ve been
logged on to IMA, you can select from the lists.)
e To list CFA units, fill in all six fields.
(If you don’t know the last three fields, you can list groups and select
units later.)

Follow the guidelines in the table below. For further information, click
PreOrder (POP) at http://www.centurylink.com/wholesale/clecs/

Isog.html.
In this field ... Type ...
ACNA The Common Language code for your company
LOCA The originating CLLI code
LOCZz The terminating CLLI code
CABNM The name of the cable
FIRST UNIT The number of the first unit in a CFA group
LAST UNIT The number of the last unit in a CFA group

5 Click Next.

One of two windows appears:
e CFA Groups. Continue with the procedure immediately below.
e CFA Units. Skip to “Viewing CFA units” on page 45.
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Viewing CFA groups

If you entered information only in the ACNA, LOCA, and LOCZ fields, the
following window appears:

CFA Validation Wizard ®

CFA Graups
TOTALCFAGROUPS [32 | LOCA | PHNIAZEE L0CZ | PHN)AZSEHG!
CABINM CABTVP FIRETUNIT | LASTUNIT | INVET.. OTYSPARE  PCTAYAL
aLTot ZhL 00001 00100 0064 064 ~
AL L i a 8
A L 7 7
AL L B
AL L 0
AL L 5
AL L 5
A L H 0
A L B 5 0
ALTO1 22NL 00901 01000 0100 100
ALTO1 22-NL 01001 01100 0100 100
ALTO1 22-NL 01101 01200 o100 100
AL L o
A L 0
AL L 0
AL L 0
AL -NL 0
A NL E 0
ALTO1 22NL 1801 01800 0100 100
ALTO1 22NL 1901 02000 0100 100
ALTO1 2NL 02001 02100 0100 00 g
< >
| PrintFreview || Evmail | [ startover ][ <= Previous ][ Mewt-- clear || Finish
[12va et indow

The table below shows guidelines for fields specific to IMA. For further
information, click Pre-Order (POP) at http://www.centurylink.com/

wholesale/clecs/Isog.html.

In this field ... IMA displays ...

TOTAL CFA GROUPS The number of CFA groups listed in the window

LOCA The originating CLLI code you entered

LOCZ The terminating CLLI code you entered

CABNM Cable name—the identifier for a cable comprising a number of
CFA groups

CABTYP The type of facility—the cable type, gauge, load coil spacing,
and load coil inductance

FIRST UNIT The number of the first unit in a CFA group

LAST UNIT The number of the last unit in a CFA group

INVSTAT Inventory status—the current status of the CFA group

QTYSPARE Quantity spare—the number of CFA units available

PCTAVAIL Percentage available—the percentage of CFA units available

1 From the CFA groups listed in the window, select a group that has available

units and the cable type you need.

2 Click Next.
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If you entered information in all six fields in the CFA Validation window or
selected a group in the CFA Group window, the following window appears:

CFA Validation Wizard [5

CFA Units

TOTAL CFA UNITS Loca | DNWRGOSL | LocZ | DNVRGOSLHGF I

CABNM CABTYP UNIT SUBDF  SUBDT ' ASGTRSTN = CURACT PNDACT D  CKTIDICLO DATE

ALT1S 24-ML 01801 29/LAFUMD2344  IMS 20020528 -~

AL -ML

AL L 2O/LAFNMD22068  MS 20020418

AL L 29ILAFUNMD2253  MS 20030925

AL L

AL L

AL L

AL L £

AL -ML £l

ALT1S 24-ML 01610

ALT1S 24-PL 01611

ALT1S 24-ML 01612

ALT1S 24-ML 01613

ALT1S 24-NL 01614

ALT16 24-NL 01616

ALT1S 24-ML 01616

ALT1S 24-PL 01617

ALT1S 24-ML 01618

ALT1S 24-ML 01619

ALT1S 24-NL 01620

ALT1S 24-ML 01621 -

< b

Select CFA
< >
Print Preview “ E-mail ] Start Qwer ][ <= Previous ] [ Clear ][ Finish ]"
—\~

< >
Java Applet Window

The table below shows guidelines for fields specific to IMA. For further
information, click Pre-Order (POP) at http://www.centurylink.com/

wholesale/clecs/Isog.html.

In this field ... IMA displays ...

TOTAL CFA UNITS The number of CFA units listed in the window

CABNM Cable name—the identifier for a cable comprising a number of
CFA groups

CABTYP The type of facility—the cable type, gauge, load coil spacing,
and load coil inductance

UNIT A specific unit in the cable identified by CABNM

LOCA The originating CLLI code you entered

LOCZ The terminating CLLI code you entered

SUBDF Subdivision from—the routing from the originating central office

SUBDT Subdivision to—the routing to the originating central office

ASGTRSTN Assignment restriction code—code for restrictions against a
specific CFA

CURACT Current activity for the unit

PNDACT Pending activity for the unit

D Diversity indicator—whether there are alternate transmission
routes

CKTID/CLO Circuit ID/circuit layout order number

DATE Due date

April 2, 2012
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1 Select one of the available CFA units from the list in the window. Available
CFA units are indicated by $ or R in the CURACT column and any value
other than A (pending add or connect) in the PNDACT column.

The window shows just the first 20 units in the group. To scroll through the
units that aren’t displayed, select any row and use the down arrow.

2 Click Select CFA.

IMA stores the information for the CFA unit so that it is available from the
CFA list on the Loop Service, Loop Service with Number Portability, and
Port Service forms.

3 If you want to select another CFA unit, select it in the list, then click Select
CFA again.

4 When you have selected the CFA(s), do any of the following:

< To display the information for both groups and units in a separate
browser window, click Print Preview.

+ To e-mail the information in the browser window, click E-mail.
 To view another list of CFA groups or units, click Start Over.

e To return to the form you were working on or to go on to other tasks,
click Finish.

If you return to the form, the necessary information for the CFA(S) you
selected now appears in the CFA list on that form.

Searching for available meet points

You search for available meet points (POTS splitters or cable connections)
when your company wants to provide data service to your customer through a
shared loop (or line sharing) arrangement with CenturyLink. In a shared loop,
your company provides xDSL-based service and CenturyLink provides
voiceband service on the same loop.

You can search for available meet points before you prepare the LSR forms or
by clicking PreOrder on the Loop Service, Resale Split, and Centrex Resale
Split forms while you’re preparing them. IMA stores the available meet points
you find so that you can select them in the POTSSPLIT or CABCONN lists on
the Loop Service form, Loop Service NP form, Resale Service Split form, and
Centrex Resale Service Split form.

You search for POTS splitters for shared loops where the splitter is in
CenturyLink’s part of the colocation area. You search for cable connections for
subloop unbundling and for shared loops where the splitter or cable connection
is in your company’s part of the colocation area.
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Searching for available POTS splitters
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Searching within a list you specify

You can list up to five individual POTS splitters and see whether they are
available.

1

In the Interconnect Functions window, click PreOrder/Order/
PostOrder.

If you are searching for POTS splitters on behalf of another CLEC and if the
menu bar of the Interconnect Mediated Access window doesn’t already
show the corporate ID for that CLEC, continue with this step. Otherwise,
skip to step 3.

a In the Interconnect Mediated Access window, click File > Select
Owner CCNA.

b From the list that appears, select the CLEC for which you are searching
for POTS splitters. Click Submit.

The CCNA for the other CLEC appears in the menu bar for the
Interconnect Mediated Access window.

In the Interconnect Mediated Access window, select
PreOrder > Meet Point Query > POTS Splitter Query > POTS Splitter
List.

POTS Splitter, List Query E]

Validate POTS Splitter List

LSO POTSSPLIT

[ Prntpreview ][ E-mail | stan over Mot x> [ ctear ][ Finisn_|

[

[E——

In the LSO field, type the NPANXX for the local service office.

In the POTSSPLIT fields, type the code for the POTS splitters you want to
check.
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6 Click Next.

POTS Splitter List Query X

POTS Splitter Respanse:

POTSSPLIT Response Response Message

0200214.01.01-001 INvALID Specified device 0200214010~
0200214.01 01-003 INvALID Specified device 0200214.01.0._|
0200214.01.01-007 INvALID Specified device 0200214010
< >

| PrintPreview || Evmail || startOver || = Previous Finish

[

l

[1v2 AceletWindow

IMA shows which of the POTS splitters you specified are available

(“VALID™).
In this field ... IMA displays ...
POTSSPLIT A POTS splitter you specified
Response Whether each splitter is available (“VALID”)
Response Message If a splitter is not available, indicates why

7 After reviewing the data, do any of the following:

To display the information in a new browser window, click Print
Preview.

To e-mail the information in the window, click E-mail.

To search for additional POTS splitters, click Start Over and repeat the
procedure.

To go on to other tasks, click Finish.

Searching within a range you specify

You can specify a range of up to 10 POTS splitters and see which of them are
available.

1

April 2, 2012

In the Interconnect Functions window, click PreOrder/Order/
PostOrder.

If you are searching for POTS splitters on behalf of another CLEC and if the
menu bar of the Interconnect Mediated Access window doesn’t already
show the corporate ID for that CLEC, continue with this step. Otherwise,
skip to step 3.

a

b

In the Interconnect Mediated Access window, click File > Select
Owner CCNA.

From the list that appears, select the CLEC for which you are searching
for POTS splitters. Click Submit.

The CCNA for the other CLEC appears in the menu bar for the
Interconnect Mediated Access window.
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3 In the Interconnect Mediated Access window, select PreOrder > Meet
Point Query> POTS Splitter Query > POTS Splitter Range.

POTS Splitter Range Query. X
Validate POTS Spitter Range

Lso

LOPOTSSPLIT

HIPOTSSPLIT
[ Prntpreview ][ E-mai | stan over Mot x> [ ctear ][ Finisn_|
[E——

4  Fill in the fields.

In this field ... Type ...
LSO The NPANXX for the local service office
LOPOTSSPLIT The lowest number of the range you want to specify
HIPOTSSPLIT The highest number of the range you want to specify
(This number must be no greater than 10 more than the
lowest number in the range. If you need to retrieve POTS
splitter data for a larger range, repeat the search,
specifying new limits for the range.)
5 Click Next.
POTS Splitter Response
POTSSPLIT Response Response Message
VDA D20 01-001 ALID &=l ifi VDA020 ~
VDA.020 01-| ALID SEZE:T:Z E:E:V)A {i]
VDA 0201 01- ALID Specified device VDAD20
VOA0201 01- ALID Snecified device VDA.D20
VDA 020 01-| ALID Specified device VDA 020
VDA D20 01-| ALID Specified device VDA.020
VDAD20 01-| ALID Specified device VDAD20
VDA.020 01-| ALID Specified device VDA.020
VDA 0201 01- ALID Shecifi VDA 0201 .
VDA0201 01- ALID S;:;l’:: szZVDA 0 .| %
< >
| PrintFreview || Email | | Statower | <<Previnus Finish
‘JaveADD\elW\nduw

IMA shows which POTS splitters are available (“VALID”).

Field Definition
POTSSPLIT The POTS splitter(s) you specified
Response Whether each splitter is available (“VALID”)

Response Message

If a splitter is not available, indicates why

6 After reviewing the data, do any of the following:

 To display the information in a new browser window, click Print

Preview.

e To e-mail the information in the window, click E-mail.

 To search for POTS splitters within a new range, click Start Over and
repeat the procedure.

e To go on to other tasks, click Finish.
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Searching for available cable connections
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Searching within a list you specify

You can list up to five individual cable connections and see whether they are
available.

1

In the Interconnect Functions window, click PreOrder/Order/
PostOrder.
If you are searching for cable connections on behalf of another CLEC and if
the menu bar of the Interconnect Mediated Access window doesn’t
already show the corporate ID for that CLEC, continue with this step.
Otherwise, skip to step 3.
a In the Interconnect Mediated Access window, click File > Select
Owner CCNA.
b From the list that appears, select the CLEC for which you are searching
for cable connections. Click Submit.
The CCNA for the other CLEC appears in the menu bar for the
Interconnect Mediated Access window.

In the Interconnect Mediated Access window, select PreOrder > Meet
Point Query > Cable Connection Query > Cable Connection List.

Cable Connection List Query E]
Validate Cable Connection List

Lso CABCONN
[ Prntpreview ][ E-mail | stan over Mot x> [ ctear ][ Finisn_|
[E——

In the LSO field, type the NPANXX for the local service office.
In the CABCONN fields, enter the cable connections (up to five).

Click Next.

Cable Connections Response

Response Message
|CABLE CONNECTION VDAFPDL...| A
VDAPDT03.252 [InvALID |

Specified device YDA PDTO3 2.,
VDA PDTO3.254 [invALID Specified device VDA.PDT03.2... |+

< ¥

CABCONN
VDAPDTO3.250

Response
[InvALID

[ Print Preview “ E-mail “ Start Qver “ == Previous

[E——

IMA shows which cable connections are available (“VALID").

In this field ... IMA displays ...

CABCONN The cable connection(s) you specified
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In this field ... IMA displays ...
Response Whether each connection is available (“VALID”)
Response Message If a connection is not available, indicates why

7 After reviewing the data, do any of the following:
e To display the information in a new browser window, click Print
Preview.
e To e-mail the information in the window, click E-mail.

« To search for additional cable connections, click Start Over and repeat
the procedure.

< To go on to other tasks, click Finish.

Searching within a range you specify

You can specify a range of up to 10 cable connections and see which of them
are available.

1 In the Interconnect Functions window, click PreOrder/Order/
PostOrder.

2 If you are searching for cable connections on behalf of another CLEC and if
the menu bar of the Interconnect Mediated Access window doesn’t
already show the corporate ID for that CLEC, continue with this step.
Otherwise, skip to step 3.

a In the Interconnect Mediated Access window, click File > Select
Owner CCNA.

b From the list that appears, select the CLEC for which you are searching
for cable connections. Click Submit.

The CCNA for the other CLEC appears in the menu bar for the
Interconnect Mediated Access window.

3 In the Interconnect Mediated Access window, select PreOrder >
Meet Point Query > Cable Connection Query > Cable Connection
Range.

Cable Connection Range Query X
Validate Cable Connection Range

Lso
LOCABCONN
HICABCONN

| Prntpreview ][ E-mail | stan over Mot x> [ ctear ][ Finisn_|

[

[E——

4 Fill in the fields.

In this field ... Type ...
LSO The NPANXX for the local service office
LOCABCONN The lowest number of the range you want to specify
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In this field ...

Type ...

HICABCONN

The highest number of the range you want to specify
(This number must be no greater than 10 more than the
lowest number in the range. If you need to retrieve cable
connection data for a larger range, repeat the search,
specifying new limits for the range.)

5 Click Next.

Cable Connection Range Query E]
Cable Connections Response

CABCONN Response Response hessage

VDA PD 1 ALID Specified device YDA.P ~

IVDAPD ALID Specified device YDA P|

VDAPD’ ALID Specified device YDA.P

VDAPD’ ALID Specified device YDA.P

VDA PD ALID Specified device YDA P

VDAPD ALID Specified device ¥DA P

VDA PD ALID Specified device YDA P|

IVDAPD il ALID Specified device YDA P|

VDAPD' ] ALID Specified device YDA.P .. | ™

< b4
[ PrintFreview || Email || startOver || =< Previous | Finish
‘JaveADD\elW\nduw

IMA shows which cable connections are available (“VALID").

In this field ... IMA displays ...
CABCONN The cable connection(s) you specified
Response Whether each connection is available (“VALID”)

Response Message

If a connection is not available, indicates why

6 After reviewing the data, do any of the following:

e To display the information in a new browser window, click Print

Preview.

e To e-mail the information in the window, click E-mail.

 To search for cable connections within a new range, click Start Over
and repeat the procedure.

< To go on to other tasks, click Finish.
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Retrieving raw loop data

You retrieve raw loop data to get the physical characteristics of a loop—the
presence or absence of pair gain, the number and type of load coils, the
presence and characteristics of bridge taps, and other characteristics of the
loop. Typically, you do this to check whether the loop can support DSL-capable
unbundled loops and shared-loop facilities. Your engineers can use this raw
data to determine whether the loop can carry your company’s DSL service or
whether modifications are required, such as conditioning the loop (removing
load coils and bridge taps).

You can view raw loop data for any working loop or spare facility, regardless of
who owns it. For each telephone number, service address, or circuit 1D, IMA
shows data for the entire loop and detailed characteristics for each segment
and subsegment.

To retrieve raw data for a loop, you use IMA. To retrieve raw loop data for an
entire wire center, you use the Wire Center RLD tool (https://rld.gwest.com/
rld/). (You’ll need to obtain a digital certificate to use the tool. See Requesting
Access to CenturyLink Systems at
http://www.centurylink.com/wholesale/systems/generalinfo.html.)

If you're using IMA, you can retrieve raw loop data before you prepare the LSR
forms or by clicking PreOrder on several of the forms while you're preparing
them.

You can use:

« Your customer’s telephone number or address to retrieve raw loop data for
up to 24 working telephone numbers (including nonpublished and nonlisted
numbers).

< Their address to retrieve data for all working telephone numbers and
working circuits at that address or to retrieve data for spare facilities at the
address. (If you retrieve loop data by address, be sure to validate the
address first so it matches CenturyLink’s databases.)

e Their circuit ID to retrieve data for the working circuit at that address.

The procedures for retrieving raw loop data are detailed in the Loop
Qualification and Raw Loop Data CLEC Job Aid at http://www.centurylink.com/
wholesale/training/coursecatalog.html—the IMA procedure in chapter 3, the
Wire Center RLD tool in chapter 6.
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Checking whether a loop qualifies for
CenturyLink HS1/Broadband Service or
unbundled ADSL service

You can check whether your customer’s loop qualifies for CenturyLink HSI/
Broadband Service or unbundled ADSL service. You can check by using your
customer’s street address or telephone number. If the loop does not qualify,
you can have IMA periodically recheck it. You can check loop qualification
before you prepare the LSR forms or by clicking PreOrder on several of the
forms while you’re preparing them.

The procedure for checking loop qualification is detailed in chapter 5 of the
Loop Qualification and Raw Loop Data CLEC Job Aid at http://
www.centurylink.com/wholesale/training/coursecatalog.html.

Reserving telephone numbers

You need to reserve one or more telephone numbers whenever you request
* new service

< a new line on existing service

 a change of telephone number

If you don’t reserve a number for requests of this kind, IMA rejects your LSR.
(IMA doesn’t reject your LSR if you try to reserve a telephone number after
receiving a notification that the reservation system is not available.) You can
reserve numbers only for nondesigned services.

Note: Reserving a number does not guarantee that your customer will
actually get that number. If the number you reserved cannot be
provisioned, you will be issued a new number.

You can reserve telephone numbers before you prepare the LSR forms or by
clicking PreOrder on the Port Service and Resale forms while you’re preparing
them. You must use the same CLEC codes (RSID/ZCID/ACNA) to submit an
LSR with a reserved TN as you used when you reserved the TN. If you submit
an LSR using a different CLEC code than when you reserved the TN, IMA
creates the service order using a different TN than the one you reserved. The
FOC lists the TN(s) that IMA used.

Before you try to reserve number(s):

1 If you haven’t validated the address for your customer, try to validate it
now, so that the number or numbers you reserve will be assigned to the
correct wire center. (See “Validating addresses” on page 10.)

2 If you need to reserve 10 or more telephone numbers at one address, 3
Easy Numbers, or 5 Consecutive Blocks numbers, contact CenturyLink
following the guidelines in http://www.centurylink.com/wholesale/clecs/
customercontacts.html.
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Caution: After you select the telephone number(s) that you want to
reserve, be sure to submit the LSR within the next 30

calendar days. If you don’t, you’ll need to repeat this
procedure.

To reserve telephone numbers

1 In the Interconnect Functions window, click PreOrder/Order/
PostOrder.

2 If you are reserving a telephone number on behalf of another CLEC and if
the menu bar of the Interconnect Mediated Access window doesn’t

already show the corporate ID for that CLEC, continue with this step.
Otherwise, skip to step 3.

a In the Interconnect Mediated Access window, click File > Select
Owner CCNA.

b From the list that appears, select the CLEC for which you are reserving
the number. Click Submit.

The CCNA for the other CLEC appears in the menu bar for the
Interconnect Mediated Access window.

3 In the Interconnect Mediated Access window, click PreOrder >
Reserve Telephone Numbers.

TN Availability 3]

Administrative Section

P

=]

N: WER

TH Information

Preferred NPA:  Preferred NGt Number of TNs: (QR)  SCATEG:
1w v
Address Information | Custom TN Information

Site ID: TTA:

Walidated Addresses:
Mo Validated Atdress v

=

FT. SAPR: SANO, SASF.

BASD SASN: BATH: BARE:

-

LD1 L LD2 W2 LD3! L3, AHN: ROUTE: BOX:

o

ITY: STATE: ZIF:
v
CALASAGA:

Response Section

Telephone Numbers Current Status Custam?
Get TN List A
Select Highlighted THs
Return Highlightad Ths

Print Previews E-mail Clear Reset Close
[ l

[1va AceletWindow

4 If you want to reserve one or more custom numbers, type the purchase
order number you will use on your LSR. If the LSR is a supplemental LSR,
type the version number in the VER field. (If you clicked PreOrder >
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Reserve Telephone Numbers on the Port Service or Resale forms, these
fields are already filled in.) If you are not reserving custom numbers, these

fields are optional.

5 Fill out the TN Information section.

In this field ...

Type or select ...

Preferred NPA (optional)

The area code (if you want to specify it)

(You must fill in this field if you fill in the Preferred NXX
field. But IMA will disregard this field if you specify a nearby
TN in step 7.)

Preferred NXX (optional)

The number exchange (if you want to specify it)
(IMA will ignore this field if you specify a nearby TN in
step 7.)

Number of TNs: (QR)

The number of telephone numbers or circuits you want to

reserve

= |If you want to reserve a consecutive block of numbers,
the number must be 2-5.

= If you want to reserve an Easy Number or Easy Word to
Find (ECAT or EWORD), the number must be 1-3.

SCATEG

The category of service

6 Do one of the following:

If you validated the address ... If you didn’t validate the address ...
From the Validated Addresses list, a Fill in the SANO, SASN, CITY, STATE, and
select the service address. CALA/SAGA fields, following the guidelines
IMA automatically fills in the address in “Validating addresses” on page 10.

fields and the Site ID and TTA fields. b In the Site ID field, type the NPANXX (in

the Central and Eastern regions) or the CLLI
code (in the Western region) for the
servicing wire center. (Follow the guidelines
for this field in PreOrder (POP) at http://
www.centurylink.com/wholesale/clecs/
Isog.html)

c In the TTA field, type the TN or CLLI code
for the central office. (Follow the guidelines
for this field in PreOrder (POP) at http://
www.centurylink.com/wholesale/clecs/

Isog.html)

Tip: If you want revise the information you entered but keep the same
PON, click Reset. If you want to clear all the information you

entered, click Clear.
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Reserving telephone numbers

7 If you want to reserve one or more custom numbers, click the Custom TN
Information tab. (If you don’t want to reserve custom numbers, skip to
step 9.)

T Availability X

Administrative Section

p

<]

N: WER

TH Information

Preferred NPA: Prefarred N3 Number of TNs: {OR) SCATEG:

1] |
Address Infermation| Custom TN Information

Canzecutive Blacks: (CBLOCK)  MNearky TH: (NTHUM)
]

Custom Numbers

Easy Number: (EASHUM)  Easy Nurnber Category: (ECATEG)
O =

Easy Word to Find: (EWORD)

Easy Word Justification: (EJUST)
O Left @ Right

Response Section

Telephone Numbers Current Status Custam?
Get TN List ~
Select Highlighted Ths
Return Highlighted THs

Print Previews E-mail Clear Reset Close
[ l

[1va AceletWindow

8 Do one—and only one—of the following.

< To reserve a series of consecutive telephone numbers, select the
Consecutive Blocks: (CBLOCK) check box.

« To reserve one or more telephone numbers that are close to an existing
telephone number, type the existing telephone number in the Nearby
TN: (NTNUM) field.

< To reserve an Easy Number or Easy Word to Find, select the Easy
Number: (EASNUM) check box. Then follow the guidelines for these
fields in PreOrder (POP) at http://www.centurylink.com/wholesale/
clecs/lsog.html.

To reserve an Easy Number ...

To reserve an Easy Word ...

Select the format for the number from
the Easy Number Category: (ECATEG)
list.

a In the Easy Word to Find: (EWORD)
field, type the word that you want to
spell out with numbers.

b In the Easy Word Justification:
(EJUST) field, specify whether you
want the custom number to begin with
that word (Left justification) or end
with it (Right justification).

9 Scroll down to the Response Section at the bottom of the window.
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11

12

13

14
15

16

Reserving telephone numbers

Click Get TN List.

The Telephone Numbers column lists the numbers that are available.
Easy Numbers and Easy Word numbers are identified by a Y in the
Custom? column.

Tip: If you want to display all the items in a column in alphabetical or
numerical order, click the column head. (Follow the guidelines in
the Screen Tip for each column.)

From the list, select one or more telephone numbers.

(Be sure to select the number(s) you want to reserve within 30 minutes of
the time they first appear in the list. If you don’t, the list will expire and
you’ll need to repeat the procedure.) If you are adding a line through a
multi-switch wire center to a hunt group or to existing UNE-P Centrex 21,
Resale Centrex 21, or Resale POTS services, select only number(s) whose
NPA-NXX matches the NPA-NXX of your customer. If none are available,
contact CenturyLink following the guidelines in http://
www.centurylink.com/wholesale/clecs/customercontacts.htmil.

 To select a single number, click on it.

e To select a block of numbers, press and hold SHIFT, then click on the
first and last numbers in the block.

= To select nonsequential numbers, press and hold CTRL, then click on
each number you want to select.

Click Select Highlighted TNs.

The status changes to SELECTED for the number or numbers you reserved
and to CANCELED for the rest of the numbers.

If you don’t want to reserve one or more of the numbers you selected,
highlight those numbers, then click Return Highlighted TNs.

The status of the highlighted numbers changes to CANCELED.

If you want to search for additional numbers, repeat steps 10—13.

When you are finished reserving the number(s), do any of the following:

e To show the information in a new browser window, click Print
Preview.
e To e-mail the information in the window, click E-mail.

e To reserve numbers for a different PON, click Clear and return to
step 4.

e To go on to other tasks, click Close.

To actually reserve the telephone number(s) you selected, be sure to
submit your LSR within the next 30 calendar days. If you don’t, you’ll lose
the number(s) you reserved and you’ll need to repeat this entire
procedure. When you submit the LSR, remember to use the same CLEC
code (RSID/ZCID/ACNA) as you used to reserve the telephone number.

Note: Remember that reserving a number does not guarantee that
your customer will actually get that number.
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Managing appointments

Managing appointments

You can schedule or “reserve” (directly below), change (page 63), and cancel
(page 64) appointments. You can change or cancel appointments if you have
not yet scheduled another appointment, clicked Clear, or closed the
Appointment Scheduler window. You can change or cancel appointments for
unbundled products if you have not yet closed the Appointment Scheduler
window. To change or cancel appointments for other products, you must
submit a supplemental LSR. (See “Preparing a supplemental LSR” on

page 164.)

When you schedule an appointment, be sure to submit an LSR (or a
supplemental LSR) with the same PON within 24 IMA business hours (page 8)
so that IMA doesn’t cancel the appointment.

Scheduling appointments

April 2, 2012

When you schedule an appointment, you schedule a date and time for a
technician to install new facilities or to modify facilities at either the wire
center or your customer’s premises. When you schedule an appointment, IMA
automatically fills in the confirmation number and the appointment date and
time on the LSR forms.

If your LSR requires an appointment, be sure to schedule one so that IMA
doesn’t reject the LSR. (IMA doesn’t reject your LSR if you try to schedule an
appointment after receiving a notification that the reservation system is not
available.) When you schedule an appointment, be sure to consider the
standard service interval for the product or service you're requesting. (See
http://www.centurylink.com/wholesale/guides/sig/index.html.)

You can schedule appointments before preparing the LSR forms or by clicking
PreOrder on the Resale, Centrex Resale, Resale Split, and Centrex Resale
Split forms as you prepare them:

Before you schedule an appointment:

< Check whether the facilities you want are available (page 34) to see
whether IMA indicates that a dispatch is necessary (pages 38 and 41).

e If you are ordering an unbundled product, you’ll need to specify the NC
code. If you don’t know the code, see “Finding the NC, NCI, and SECNCI
codes for a product” on page 181.

After you schedule an appointment, if you want a connection made at your
customer’s NID, make a note to request this in the Remarks field on the LSR
form.
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To schedule an appointment

1 In the Interconnect Functions window, click PreOrder/Order/
PostOrder.

2 If you are scheduling an appointment on behalf of another CLEC and if the
menu bar of the Interconnect Mediated Access window doesn’t already
show the corporate ID for that CLEC, continue with this step. Otherwise,
skip to step 3.

a In the Interconnect Mediated Access window, click File > Select
Owner CCNA.

b From the list that appears, select the CLEC for which you are scheduling
the appointment. Click Submit.
The CCNA for the other CLEC appears in the menu bar for the
Interconnect Mediated Access window.

3 In the Interconnect Mediated Access window, click PreOrder >
Schedule Appointment.

Appointment Scheduling @
Calendar | Reservation | Confirmation
(<2 Check for Existing Appointment
WINor NPANKX: | - - # Of Lines:
LST:
#Of Jacks: TXTYP: D - Other Products v
Type of Service: ~| NC Code
Enter Other Work Required Usog:; | | CINerwork Reaulred US0Cs -
.
< >
General | Specific
Reserve Available Appointment
Print Preview | E-mail Clear Close
‘Jave Applet Window

4 In the PON field (on the Calendar tab), type the purchase order number.

5 (Optional) Click Check for Existing Appointment.

< If an appointment has already been scheduled, the Confirmation tab
appears.
If the appointment is for a batch hot cut and the LSR has not yet been
submitted, you can change the number of lines and due date that were
originally requested.

« If no appointment has been scheduled, the message No Appointment
found appears. Click OK to close the message box, and continue with
the next step.
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6 Fill in the fields, following the appropriate guidelines below.

e If you're scheduling an appointment for products that you’re requesting
(TXTYP = D or U), use these guidelines:

In this field ...

Type or select ...

WTN or NPANXX

The 10-digit working telephone number

or

The 3-digit area code plus the first 3 digits of the
telephone number

Note: For number pooling, use NPA-NXX.

# Of Lines

The number of lines that require service

# Of Jacks (if applicable)

The number of internal line jacks that require
service

TXTYP

The type of transaction (here, select D or U)

Type of Service

The type of service you are requesting

NC Code

The NC code for your product (unbundled products
only; TXTYP=U)
(For guidelines on finding NC codes, see page 181)

Enter Other Work Required
usocC

If other work is needed (e.g., to specify the need
to install facilities), type the USOC (Universal
Service Order Code), then click Add. Repeat as
necessary for additional USOCs.

The USOC appears in the adjacent list

(If you need to delete a USOC from the list, select
it, then click Delete.)

e If you're scheduling a batch hot cut (TXTYP = C), use these guidelines:

In this field ... Type or select ...

# Of Lines The number of lines that require service

LST The CLLI code of the end office switch from which
service is being provided

TXTYP The type of transaction (here, select C)

Type of Service

The type of service you are requesting

NC Code

(IMA automatically fills in LX--)

April 2, 2012
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3—Before submitting service requests
Managing appointments

appointment ...

To schedule the next available

To schedule an appointment on a
specific date or more than 25 days
in the future ...

a Click the General subtab.

a Click the Specific subtab.

b Click Reserve Available Appointment. b In the Appointment Date field, type the

date you'd like to specify. Use the format
YYYY/MM/DD.

c Click Reserve Available Appointment.
Be sure to save or submit the LSR for the
appointment within 24 IMA business
hours (page 8). Otherwise, IMA will
cancel the appointment.

- If the Confirmation tab appears, continue with the next step.

< If an error message appears instead, click the Calendar tab and check
for errors. Then repeat steps 4—7.

« If IMA displays the message

No appointment available, enter Desired Due Date (DDD) on

LSR form

make a note to manually enter the desired due date when you prepare

the LSR form for this request.

8 Check the information on the Confirmation tab for the appointment you

reserved:

< If you're scheduling an appointment for products that you’re requesting

(TXTYP=D or U)

In this field ...

The Confirmation tab displays ...

PON

The purchase order number for the request

Confirmation Number

The confirmation number assigned for the
appointment

Completion Date

The completion date for the appointment

Completion Time

The completion time for the appointment

After - Before Time

The time reserved for the work to be done

< If you're scheduling a batch hot cut (TXTYP=C)

In this field ...

The Confirmation tab displays ...

PON

The purchase order number for the request

Confirmation Number

The confirmation number assigned for the
appointment

Completion Date

The completion date for the appointment

# of Lines

Nothing—the field is blank. If the LSR has not yet
been submitted, you can change the number of
lines that require service by typing the number
you now want.

April 2, 2012
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In this field ... The Confirmation tab displays ...

New Due Date Nothing—the field is blank. If the LSR has not yet
been submitted, you can change the due date you
scheduled by typing a new date.

9 sStill on the Confirmation tab, do any of the following:

To reserve the appointment, you need do nothing more (you might
want to write down the confirmation number or print the Confirmation
tab page).

To change the appointment:

« If you're scheduling an appointment for products that you’'re
requesting (TXTYP = D or U): click the Reservation tab, select one
of the available appointments from the list, then click Reserve
Highlighted Appointment.

IMA again displays the Confirmation tab, showing the revised
appointment data.

< If you're scheduling a batch hot cut (TXTYP = C) and the LSR has
not yet been submitted: type the number of lines and/or the due
date you now want, then click Change Appointment.

To cancel the appointment without making it, click Return
Appointment.

To schedule another appointment, click the Calendar tab and return to
step 4. If you want to save the appointment and clear the information
that applied to the previous request, click Clear.

To show the information in a new browser window (so you can print the
confirmation information), click Print Preview.

To e-mail the information, click E-mail.
To save the appointment and go on to other tasks, click Close.

Changing appointments

To reschedule an appointment that has already been made, you typically need
to submit a supplemental LSR. (See “Preparing a supplemental LSR” on

page 164.) If you create a supplemental LSR to change the DDD, be sure to
change the appointment first.

You can reschedule an appointment directly

April 2, 2012

if you reserved the appointment within the past 24 IMA business hours but
have not yet submitted an LSR with the same PON. (Appointments are
automatically canceled after 24 IMA business hours if you haven’t
submitted a request with the same PON.)

Follow the procedure for scheduling an appointment (above) using the PON
for the appointment that you want to change but reserving a different
appointment time.

if you’'ve not yet scheduled another appointment or clicked Clear

Click the Reservation tab, select one of the available appointments from
the list, then click Reserve Highlighted Appointment.

IMA again displays the Confirmation tab with the new date.
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Managing appointments

if you've scheduled a batch hot cut and the LSR has not yet been submitted

Click the Calendar tab, type the PON, and click Check for Existing
Appointment. When the Confirmation tab appears, type the number of
lines and/or due date you now want.

Canceling appointments

If you no longer need an appointment that you’'ve scheduled, you should
cancel it so that your company won’t be charged for a dispatch that’s not
needed.

April 2, 2012

If you're requesting an unbundled product and you’'re still in the
Appointment Scheduling window, you can cancel the appointment by
clicking Return Appointment on the Confirmation tab.

If you've left the Confirmation tab (or if you're requesting anything other
than unbundled products), postpone submitting an LSR with the PON you
used to schedule the appointment. (IMA automatically cancels
appointments after 24 IMA business hours if you haven’t submitted an LSR
with the same PON.) If you want to submit the LSR sooner, submit it with a
new PON and don’t schedule an appointment with the new PON.

If, within 24 IMA business hours of scheduling the appointment, you
submitted an LSR with the same PON as the appointment, submit a
supplemental LSR. (See “Preparing a supplemental LSR” on page 164.)
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Preparing and submitting service requests

With IMA, you prepare LSRs (local service requests) and BRCs (bulk requests
to create) by filling out the LSR forms online rather than on paper. The online
forms closely resemble the paper forms.

This chapter gives guidelines for using IMA to prepare and submit the forms
online. It assumes that you're already familiar with the forms and the
processes for preparing and submitting them.

Centrex Resale (CRS)—page 76

Centrex Resale Split (CRSS)—page 82

DID Resale Services (DRS)—page 89

Directory Listings (DL) Request—page 90

End User (EU)—page 94

Facility Based Directory Listings Request—page 98
Hunt Group Information (HGIl)—page 104

Local Service Request (LSR)—page 106

Loop Service (LS)—page 111

Loop Service with Number Portability (LSNP)—page 115
Number Portability (NP)—page 118

Port Service (PS)—page 121

Resale (RS)—page 127

Resale Frame Relay (RFR)—page 133

Resale Private Line (RPL)—page 134

Resale Split (RSS)—page 138

Simple Port Request (SPR)—page 145

Before you fill out the online forms, be sure to validate your customer’s
address and review their customer service record (CSR). Chapter 2 gives
guidelines for these tasks. By doing so, you save time and reduce the chance
of error when you fill out the online forms.

April 2, 2012
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For definitive guidelines on filling out the forms, refer to the appropriate Form
Preparation Guide(s) at http://www.centurylink.com/wholesale/clecs/
Isog.html. You can also double-click any field name (on all forms) to view help
on filling in the field.

For a listing of activity types, see the “Local Service Ordering—QOverview”
portion of the CenturyLink’s LSOG at http://www.centurylink.com/wholesale/
clecs/lsog.html.

For product-specific information, see http://www.centurylink.com/wholesale/
pcat/index.html.

Creating a new LSR or BRC (local service
request)

You can create a new LSR or BRC two ways: from scratch and by using an
existing LSR or BRC as a template. BRC submissions are limited to 1000
accounts per hour (e.g., 10 BRCs with 100 accounts each or 20 BRCs with 50
accounts each).

Before you create a new LSR or BRC, validate your customer’s address and
review their CSR. (Follow the guidelines in chapter 2.) IMA will then fill in some
of the fields on the forms for you. Except for new requests, all CSRs must be in
Active status for the request to be processed. If the CSR has a Final status,
IMA automatically rejects the request.

Creating a new LSR or BRC from scratch

1 In the Interconnect Functions window, click PreOrder/Order/
PostOrder.

2 If you are creating an LSR on behalf of another CLEC and if the menu bar
of the Interconnect Mediated Access window doesn’t already show the
corporate ID for that CLEC, continue with this step. Otherwise, skip to step
3. (You can’t create a batch hot cut for another CLEC.)

a In the Interconnect Mediated Access window, click File > Select
Owner CCNA.

b From the list, select the CLEC for which you are creating the LSR. Click
Submit.

The CCNA for the other CLEC appears in the menu bar for the
Interconnect Mediated Access window.
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3

Creating a new LSR or BRC (local service request)

In the Interconnect Mediated Access window, select Order > New
LSR/BRC.

Order Information for Mew LSR / BRC @

PON: VER:
REQTYP: | |B-Firm Order %
Activity: v
TOS: MNaone w
BAMN: v
Farm Mame Required Include
-
v
< >
Edit Form Clear All Forms
’ Frint Preview ” E-mail ” Save ” Submit ’ Clear ” Reset ” Close ]
|Java Applet Window

Fill in the fields in the window. You can leave the BAN field blank;

CenturyLink finds the correct BAN and uses it on any generated service

orders. (You can also find it on the CSR.)

Be sure you select B—Firm Order in the right REQTYP field. If you select

A—Service Inquiry, your request is not processed to completion, even if

you receive an FOC.

IMA automatically lists the forms you fill out for your request.

 If a form is required, the word Yes appears in the Required column
and a check appears in the Include column.

e If a form is not required, you can include it by clicking the check box in
the Include column.

To access a form, highlight the form name and click Edit Form.
Complete the forms in the order they are listed.

Schedule any necessary appointments and reserve telephone numbers.
(See chapter 3.)

When all of the forms are complete, click Submit to submit the request.
(See “Submitting a service request (LSR or BRC)” on page 75.)

Using an existing LSR or BRC as a template

You can use an existing LSR or BRC (that hasn’t been submitted) as a
template.

April 2, 2012

There is an indirect method to make a template from a non-saved LSR. See
“Use an existing (issued) LSR that has not been saved” on page 69.

1

In the Interconnect Functions window, click PreOrder/Order/
PostOrder.
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2

68

If you are creating an LSR on behalf of another CLEC and if the menu bar
of the Interconnect Mediated Access window doesn’t already show the
corporate ID for that CLEC, continue with this step. Otherwise, skip to step
3. (You can’t create a batch hot cut for another CLEC.)

a In the Interconnect Mediated Access window, click File > Select
Owner CCNA.

b From the list, select the CLEC for which you are creating the LSR. Click
Submit.

The CCNA for the other CLEC appears in the menu bar for the
Interconnect Mediated Access window.

In the Interconnect Mediated Access window, click Open LSR/BRC.

Selection Criteria
CChA [ele]
PON: VER: THE

User 1D

The Date Range will not be used when a PON is specified.
If the Completed Only, Canceled Only or Completed and Canceled Onty Radio Button is selected, the Date Range can not exceed 90 calendar days.

@) All Pending Statuses (ncluding Purged) O All Pending Staluses () Bulk Only
O Completed Only O Ganeeled Gnly - O Gompleted, Bulk, and Ganceled Only
From Date i) To Date "

Selection Results

PON WER Original User 1D Original Save Date Status LSRID

v
< bl

| Prntpreview ][ E-man_] [_reunLsrercs || open Hignigntza || Purge Highiightea | [ ciear ][ Reset | cancel |

[

[E——

If you know the PON for the LSR or BRC you want to use as a template,
enter it to find the LSR directly. If you don’t know the PON, find the LSR or
BRC that you want by specifying the criteria you want to search by and
clearing the fields that you don’t want to search by.

To search for ... Do the following ...

A specific LSR or BRC Type its PON (and version number if it has one)

LSRs or BRCs prepared by a Type their user ID
specific user (Your user ID appears by default)

LSRs or BRCs with a specific Select the status
status

LSRs or BRCs submitted ina | Fill in the From Date and To Date fields (YYYY/MM/DD)
specific date range

Click Fetch LSR/BRCs.

IMA displays a list of the LSRs or BRCs that meet your search criteria. (If
you specified the PON, the list shows just one.) To sort a column, click the
column heading.
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6 Highlight the LSR or BRC you want to use as a template and click Open

Order Information for Existing LSR / BRC X
PON: 123123 VER: |1
REQTYP:
Activity:
Tos: 3BF - Residence, Single-Line, Flat Rate v
BAR v

Formm Marne Required  Include

7] Yes ~

Hunt Graup Infarmation (] N0

End User [ves [] e

Resale Form Yes [v] Yes

Listing Forms [ves [4] Yes @

< >

Edit Form Clear All Forms

[ _Prntpreview ][ E-man || save || suormn ][ useasTempiate ][ clear ][ meset || cioce |
[E——

7 Click Use as Template.

IMA copies the LSR or BRC (and clears the PON, VER, LSR NO, DDD,
APTCON, APPTIME, and TNS fields).

Order Information for New LSR / BRC E|
PON: VER:

REQTYP: |E - Resale (POTS,PAL, PEX, ISDM, and Qwest DSL) | B-Firm Order v

Activity: M - Mew Installation andior Account 4

TOS: 9BF - Residence, Single-Ling, Flat Rate v

BAN: v

Include

Required
Yes ‘res -~

acal Service Reguest
|Hunt Group Information Mo Mo

End User [ves [F] ¥es

[Resale Form [Yes 7] es

|Listing Forms ves ] Yes 3

< >
Edit Form Clear All Farms

[[ FrintPreview || Evmail || ave ][ sunmit mmm}

[1va AceletWindow

8 Fill in the PON and VER fields.

9 Verify the information in the REQTYP, Activity, TOS, and BAN fields.
Make changes if necessary.

10 To access a form, highlight the form name and click Edit Form.
11 Complete the forms in the order they are listed.

12 Schedule any necessary appointments and reserve telephone numbers.
(See chapter 3.)

13 When all of the forms are complete, click Submit to submit the request.
(See “Submitting a service request (LSR or BRC)” on page 75.)

Use an existing (issued) LSR that has not been saved

You can use an existing LSR or BRC (issued, but not saved) as a template.

1 Find the ISSUED (non-pending) status LSR.
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2 Change the version (VER). In this example, we changed it to version 2.

i R-Ehjrder Information for Existing LSR £ BRC El
PON:  HEILATNT o VER: |2 |

REQTYP: | k -1 I |

Acthity: | k|

Tos: |2 Residence j

BAN:

PrintPreview | Email || swe || suoma | [ ctear || Reset || ciose |
Java Applet Window

3 Select a supplemental value of 3 in the LSR form.

¥ Local Service Reguest

Administrative Section

CoNA PO VER  LERMO
uBs | HBIUATNT |z | 35479908

AN (MHN-E5-3395-933) HAR

DLEC CONA

612-870-0630-255

Admin Billing Contact Remarks

PGOL DT SENT
[ 201112081036 |

[ =l [anans il

DSFTCH  DOD APPTIME APTCON

PROJECT CHC TEST

| Il 2

REQTYPE ACT RETTYP

EN E El

CONMNG W
[ ] - Funmigration 1o a new secaunt =1
oo NNEF  AENG ALER

| onvn | |

[r- aumorzaion =] 30110 207

1- Cancal

AGAUTH DATED AUTHNM

2 - DOC changs

4 Save the LSR.

5 An Informational window appears. You may ignore the information in the

window. Click OK.

You are now able to use this newly saved LSR with the “Use As Template”

option. (The LSR with the new version is in SAVED status.)

6 Find the saved LSR with its modified version (VER) number.

7 Remove the SUP value selected earlier.
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8 Click on “Use As Template.”

[¥3 Order Information for Lxisting L5R f BRC

TOS: 28M - Resldence, Multi-ling, Maasuread =]
BAR: -

Forrm Narna Required  Include
L F Ragquast B

Yes Yes ad
[IHa
End User ves [+T¥es
Port Service es [+]ves
Lizting Farms ves [+l ves a3
4 13
Edit Form CIEST All Forms &
£ >
Prnt Praview " E-mail || Save | Submit || Use 32 Template ] Clear || Ressi " Close |
4y

Javen Appiet Wirdaw

9 You can now use the processes described in “Using an existing LSR or BRC
as a template” on page 67.

Correcting errors when you close a form

If there are data errors on the form, IMA displays a list of the errors.

Messages: E\
Errors:
~
Errors on 'Adwin' tab:
DOD is mandatory and must bhe filled.
RTR i3 mandatory and must be filled.
v
< >
Frint Preview || E-mail Return to Form || lgnore Errars and Close Farm |
[12va et indow

Do any of the following:
< To return to the form and correct your errors, click Return to Form.

e To return to the Order Information for New LSR/BRC window without
correcting your errors, click Ignore Errors and Close Form.

< To preview a printable version of the error message, click Print Preview.

< To e-mail the error message, click E-mail.

Saving a service request

April 2, 2012

IMA allows you to save any unsubmitted service requests (as long as you’'ve
filled in the minimum required information). Everyone under your company’s
corporate ID has access to view, edit, submit, resave, and purge these saved
service requests for your company. When a service request is saved, all the
data on the forms (complete, partially complete, and not started), including
prepopulated data, is saved.
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After you retrieve a saved service request, you can modify any data on the
forms. But if you want to transfer information from the CSR, you need to
retrieve the full CSR for that request. (See page 20.)

1
2

Important: Unsubmitted (pending) service requests are automatically
purged 30 days after they were first saved regardless of
how many times you access the request after saving it.

Close any open forms.
In the Order Information for New LSR/BRC window, click Save.

IMA saves the request information and associated forms. IMA checks the
service request for errors. (You can ignore any error messages IMA
displays; your request will still be saved.)

Note: Reserved telephone numbers and appointments associated with
pending service requests are automatically canceled after 24 IMA
business hours. When you retrieve a pending request with an
expired TN or appointment, IMA informs you that the resource
reservation has timed out.

Purging an LSR or BRC

You purge LSRs that you’ve saved if you decide not to submit them.

1

72

In the Interconnect Functions window, click PreOrder/Order/

PostOrder.

If you are purging an LSR on behalf of another CLEC and if the menu bar of

the Interconnect Mediated Access window doesn’t already show the

corporate ID for that CLEC, continue with this step. Otherwise, skip to

step 3.

a In the Interconnect Mediated Access window, click File > Select
Owner CCNA.

b From the list, select the CLEC for which you are purging the LSR. Click
Submit.

The CCNA for the other CLEC appears in the menu bar for the
Interconnect Mediated Access window.
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3 In the Interconnect Mediated Access window, select Order > Open

LSR/BRC.

Selection Criteria

CChA [ele]

PON: VER: THE

User 1D

The Date Range will not be used when a PON is specified.

If the Completed Only, Canceled Only or Completed and Canceled Onty Radio Button is selected, the Date Range can not exceed 90 calendar days.
@) All Pending Statuses (ncluding Purged) O All Pending Staluses () Bulk Only

O Completed Only O Ganeeled Gnly - O Gompleted, Bulk, and Ganceled Only

From Date i) To Date "

Selection Results

PON WER Original User 1D Original Save Date Status LSRID

v
< bl

| Prntpreview ][ E-man_] [_reunLsrercs || open Hignigntza || Purge Highiightea | [ ciear ][ Reset | cancel |

[

[E——

4 If you know the PON for the LSR or BRC you want, enter it to find the LSR
or BRC directly. If you don’t know the PON, find the LSR or BRC that you
want to purge by specifying the criteria you want to search by and clearing
the fields that you don’t want to search by.

To search for ... Do the following ...

A specific LSR or BRC Type its PON (and version number if it has one)

LSRs or BRCs prepared by a Type their user ID
specific user (Your user ID appears by default)

LSRs or BRCs with a specific Select the status
status

LSRs or BRCs submitted in a Fill in the From Date and To Date fields
specific date range

5 Click Fetch LSR/BRCs.

IMA displays a list of the LSRs or BRCs that meet your search criteria. (If
you specified the PON, the list shows just one.) To sort the list using a
different column, click that column heading.

6 Highlight the LSR(s) or BRC(s) you want to purge and click Purge
Highlighted.

Note: You can reuse the PON and VER of a purged order. If you reuse
the PON and VER, there will be one LSR or BRC with Purged
status and one LSR or BRC with Pending status.
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Correcting errors when you submit a service
request (LSR or BRC)

If you click Submit before you’ve fill in all the mandatory fields or if there are
errors in the Order Information for New LSR/BRC window, IMA displays a
list of the errors.

Invalid Data E‘

Messages:

Local fervice Request

Errors on 'Adwin' tab:
DDD is mandatory and must be £illed.
RIR is pandatory and must be filled.

< >
Ok Print Preview E-mail

[1va AceletWindow

1 Do any of the following:

< To return to the form and correct your errors, click Return to Form.

e To return to the Order Information for New LSR/BRC window
without correcting your errors, click Ignore Errors and Close Form.

« To preview a printable version of the error message, click Print
Preview.

e To e-mail the error message, click E-mail.

2 Select the forms that must be corrected, make the necessary changes, and
resubmit your request.

74 April 2, 2012
http://www.centurylink.com/wholesale/cmp/review_archivesystem.html



User’s Guide—IMA 32.0 4—Preparing and submitting service requests
Submitting a service request (LSR or BRC)

Submitting a service request (LSR or BRC)

Once you've filled in the information for the LSR or BRC, you submit it.

1 In the Order Information for New LSR/BRC window, click Submit.

Order Submit Confirmation E]
PON

YER

Desired Due Date:

Activity Type: I - New Installation andfor Account

Supplemental LSR Ind

Carmmit Close

‘Java Applet Window

2 Verify that the information is correct.

3 Do one of the following:

- If the information is incorrect, click Close and correct the error(s) in
the Order Information for New LSR/BRC window.

« If the information is correct, click Commit.

Order, Confinmation, @

PON ,7 VER ,_

SUP ’7
LSRID ’—
Wessages =
o o
Firm Order request has heen successully submittad
Print Preview E-mail Close

[E——

The window displays the LSR ID number assigned to your request and
indicates the type of request and the success of submission.

Important: When you submit requests after IMA business hours, IMA
places them in a queue to be processed the next business
day. Disconnect orders are processed the next bill pull date
for the account.

4 To close the window, click Close.
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Completing the Centrex Resale (CRS) form

76

For definitive guidelines on filling out this form, see the Centrex Resale
Services form preparation guide at http://www.centurylink.com/wholesale/
clecs/Isog.html. You can also double-click the field nhame to get help filling in
that field.

While you’re working on this form, you can do related tasks by clicking
PreOrder (at the bottom of the window) and selecting the task. Follow the
appropriate guidelines:

e “Retrieving a full CSR” on page 20

e “Checking whether POTS facilities are available” on page 36
e “Checking whether services are available” on page 31

e “Managing appointments” on page 59

To complete the Centrex Resale form

1 In the Order Information for New LSR/BRC window, select Centrex
Resale Form under Form Name.

2 Click Edit Form.

Centrex Resale E]
Administrative Section
PON VER RSCTY: AN (NNN-393-0939-399) B ChE 1D
)
Station Details | common Block Details
Oof0
Add
LOCHUM:  LNUM: i Features ¥ TC| Inside Wire | Remarks
TERS: L LTC:
LNA;
J CLN
NS
. TSP
OTH:
— SAN:
FIC: LPIE:
MEGACEMTNM:
NP
J TCOPT: TCTOPRI TCID:
TC NAME: TCPER
H
OK Print Preview E-mail PreCrder Recap Clear Reset Cancel
‘Java Applet Window

3 In the Administrative Section, type the common block identifier (CB)
and the Centrex management system identifier (CMS 1D).
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9

Completing the Centrex Resale (CRS) form

Do one of the following:

« If you're preparing a request for activities T, V, or Z, and if you've
retrieved a full CSR during the current session, you can fill in the fields
automatically. Continue with step 5.

< If you haven't retrieved a full CSR for the request you're preparing,
click PreOrder and do so now. (See page 20.) If only one number/
account appears when you retrieve the CSR and your search returns a
near match error, go back and enter the customer code so you get an
exact match.

e Otherwise, skip to step 9 and fill in the fields manually.

Telephone Number Recap Selection @
Name and Address being recapped:
Name: Address
Telephone numbers for above address:
™ usoc Features and Feature Details
1FR /EXK 303 274 A
JRTHN
MM
OE3R1
|aLm ==Y
~
< >
| Select Highiighted Tis || Selectal THs |
‘Java Applet Window

Do one of the following:

 Select the TNs you want to recap and click Select Highlighted TNs.
+ Click Select All TNs.

For each selected TN, check each feature and revise it if necessary.

IMA creates a Station Detail section for each TN you select and
automatically fills in the fields with the information in this window.

Do one of the following:

< If you need to add additional station detail sections, continue with step
9.

« If you've added all the information you need, skip to step 25.
Click the Station Details tab.

10 Click Add to activate a new section.

The counter updates to show the current number of repeating sections.

11 Enter the station details information in the fields on the left and fill in the

Miscellaneous subtab. The following table shows guidelines for
CenturyLink-specific fields. For help with blocking combinations see http://
www.centurylink.com/wholesale/clecs/features/blockingjobaid.html.

In this field ... Do the following ...

TLI Type the lead number for a multi-line hunt group

MEGACENTNM Type the name of the ISP for CenturyLink HSI/Broadband
Service

TC OPT Select the transfer of calls option the end-user requested

TC TO PRI Type the primary number calls will be transferred to
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In this field ... Do the following ...

TCID Select the transfer of calls to identifier (the code for the
intercept message requested for a primary telephone
number associated with intercept service)

TC NAME Type the name associated with the number that calls will be
transferred to

TC PER Type the date (CCYYMMDD) that the transfer of calls

message should be removed

13 Click the Features subtab.

12 If you need to request additional lines, repeat steps 10-11.

l

Administrative Section
PON WER  RSQTY. AN (NNN-x98-3989-388) cB CMS ID:
0
Station Details  common Block Details
0org
Addd
LOCNUM: LNUM: 1eous| Features y TC| Inside Wire | Remarks
0ofo
LR
TNS: I
OTN Fa
I LPics FEATURE:
= FEATURE DETAIL:
< >
QK Print Preview E-mail PreQrder Recap Clear Reset Cancel
‘JavaApp\Elednw

14 Click Add to a activate a new section.

15 Enter the features information in the fields.

16 If you need to add additional features, repeat steps 14 and 15.
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17 Click the Secondary TC subtab.

Administrative Section
PON WER  RSQTY: AN (NNN-X99-3999-999) CB CMS ID:
0 -
Station Details | Common Block Details
Dof0
Add
LOCHUM:  LNUM: i 1eous | Features ¥ TC | Inside Wire | Remarks
Dofo
LIA:
NS 3
OTH TC TO SEC TCID
PIC: LPIC: TC MAME
NP
J SGhIL. NIDR:
OK Print Preview E-mail PreCrder Recap Clear Reset Cancel
‘JavaApp\elW\ndnw

18 Click Add to activate a new section.

19 Fill in the secondary transfer of calls information.The following table shows
guidelines for CenturyLink-specific fields.

In this field ... Do the following ...
TC TO SEC Type the secondary number calls will be transferred to
TCID Select the transfer of calls to identifier (the code for the

intercept message requested for a secondary telephone
number associated with intercept service)

TC NAME Type the name associated with the number that calls will be
transferred to

NIDR Indicate whether you need a new network interface device

™

20 If you need to add additional sections, repeat steps 18 and 19.
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21 Click the Inside Wire subtab.

Centrex Resale E]

Administrative Section
PON VER  RSQTY AN (NNN-98-3933-999) cB NS D
Station Details | Common Block Details
0af0
Add
LOGNUM:  LNUM: 1eous | Features y TC| Inside Wire | Remarks
Qofd
LMA
TNS 3
Gk K I
FIC LPIC:
LEGCP: BA:
NP -l =]
J BLOCK:
~
v
0K || PrintPreview || E-mail PreOrder Recap Clear Reset | Cancel
‘JaveADD\elW\nduw

22 Click Add to activate a repeating section.

23 Enter the inside wire information in the fields.

24 If you need to add additional sections, repeat steps 22 and 23.

25 If you need to add additional information relevant to this form, click the
Remarks subtab and do the following:

In this field ..

Do this ..

Remarks

Enter any additional information relevant to the form

Manual Ind

If CenturyLink requires information that you couldn’t
provide on the form, select Y so that the request will be
processed manually
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26 Click the Common Block Details tab.

Centrex Resale E]
Administrative Section
PON WER  RSQTY: AN (NNN-X99-3999-999) CB CMS ID:
0 -
Station Details| Commeon Block Details
cos:
xu DPA
DEPT: Loc:
MIL:
0K Print Freview E-mail Predrder Recap Clear Reset Cancel
‘JaveADD\elW\nduw

27 Fill in the fields on the tab. The following table shows guidelines for
CenturyLink-specific fields.

In this field ... Type ...

Ccos The class of service (for example, C21XX for Centrex 21
service)

XLI The Centrex location

DPA The different premises address

DEPT The department code

LOC The location

MIL The distance (in quarter miles) between the serving central
office and your customer’s location

28 To go on to other forms, click OK.

If you receive an error message when closing the form, see “Correcting
errors when you close a form” on page 71.

April 2, 2012 81
http://www.centurylink.com/wholesale/cmp/review_archivesystem.html



4—Preparing and submitting service requests User’s Guide—IMA 32.0
Completing the Centrex Resale Split (CRSS) form

Completing the Centrex Resale Split (CRSS)
form

For definitive guidelines on filling out this form, see the Centrex Resale
Services Split Form Preparation Guide at http://www.centurylink.com/
wholesale/clecs/Isog.html. You can also double-click the field name to get help
filling in that field.

While you’re working on the Centrex Resale Split form, you can do related
tasks by clicking PreOrder (at the bottom of the window) and selecting the
task. Follow the appropriate guidelines:

e “Managing appointments” on page 59

e “Checking whether services are available” on page 31

e “Checking whether POTS facilities are available” on page 36
e “Reviewing customer service records” on page 19

e “Retrieving raw loop data” on page 53

e “Checking whether a loop qualifies for CenturyLink HSI/Broadband Service
or unbundled ADSL service” on page 54

e “Searching for available meet points” on page 46
To complete the Centrex Resale Split form

1 In the Order Information for New LSR/BRC window, select Centrex
Resale Split Form under Form Name.
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2 Click Edit Form.

Centrex Resale Split E\
Administrative Section
PON VER RSCTY: AN (NNN-393-0939-399) CB
)
Station Details | Common Block Details
Oof0
Add
LOCHUM:  LNUM: Features Y TC | Inside Wire | Cable Connections  Remarks
TERS! TLI LTC:
LNA;
J SAN:
NS
. POTSSPLITLOC:
OTH: J
POTSEPLIT.
FIC LPIC: -1
MEGACERTHIM.
NP
J TC OPT. TCTO PRI TCID
TC NAME: TC PER.
I
OK Print Preview E-mail Pre0rder Recap Clear Reset Cancel
‘Java Applet Window

3 In the Administrative Section, fill in the CB field with the common block

identifier.

4 Do one of the following:

« If you're preparing a request for activities T, V, or Z, and if you've
retrieved a full CSR during the current session, you can fill in the fields

automatically. Continue with step 5.

< If you haven't retrieved a full CSR for the request you're preparing,
click PreOrder and do so now. (See page 20.) If only one number/
account appears when you retrieve the CSR and your search returns a
near match error, go back and enter the customer code so you get an

exact match.

e Otherwise, skip to step 9 and fill in the fields manually.
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5

9

Telephone Number Recap Selection 3
Name and Address heing recapped:
Marng: Address
Telephone numbers for above address:
™ Usoc Features and Feature Details
1FR [EXK 303 274 -~
IRTMIN
NMC
OE3RT
|sLm JCSMN 00
v
< >
| Select Highiighted Ths || Select &1l T
‘Jave Applet Window

Do one of the following:

 Select the TNs you want to recap and click Select Highlighted TNs.
e Click Select All TNs.

For each selected TN, check each feature and revise it if necessary.

IMA creates a Station Details section for each TN you select and
automatically fills in the fields with the information in this window.

Do one of the following:

« If you need to add additional station detail sections, continue with step
9.

e If you've added all the information you need, skip to step 28.
Click the Station Details tab.

10 Click Add to activate a new section.

The counter updates to show the current number of repeating sections.

11 Fill in the station details information on the left and fill in the

Miscellaneous subtab. The following table shows guidelines for
CenturyLink-specific fields.

In this field ... Do the following ...

TLI Type the telephone line identifier (the pilot number of a
multi-line hunt group)

POTSSPLIT Specify the location of the cable connection points for POTS
splitters outside your company’s cage. You can type in the
location or select it from the list if you retrieved meet point
data (See page 46.)

POTSSPLITLOC Specify the location of the POTS splitter

MEGACENTNM Type the name of the ISP for CenturyLink HSI/Broadband
Service

TC OPT Select the transfer of calls option the end-user requested

TC TO PRI Type the primary number calls will be transferred to

TCID Select the transfer of calls to identifier (the code for the

intercept message requested for a primary telephone
number associated with intercept service)

TC NAME Type the name associated with the number that calls will be
transferred to
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In this field ...

Do the following ...

TC PER

Type the date (CCYYMMDD) that the transfer of calls
message should be removed

12 Click the Features subtab.

Centrex Resale Split @

Administrative Section
PON WER  RSQTY: AN (NNN-X99-3999-999) CE
0
Station Details | Common Block Details
Dof0
Add
LOCKHUM: LNUM: Features Y TC Inside Wire | Cable Connections Remarks
r 0ofd
LIA:
NS I
OTH; il
PIC LPIe FEATURE: X
WPl FEATURE DETAIL:
= 3
~
< >
0K Print Preview E-mail PreQrder Recap Clear Reset Cancel
‘JavaApp\elW\ndnw

13 Click Add to activate a new section.

14 Fill in the features information.

15 If you need to add additional features section, repeat steps 13—14.
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16 Click the Secondary TC subtab.

Centrex Resale Split @

Administrative Section
PON VER  RSQTY. AN (NNN-X98-3933-359) CE
i 5
Station Details  common Block Details
Qoro
Add
LOCNUM:  LNUM: Miscellaneous | Features| Secondary TC | Inside Wire | Cable Connections | Remarks
0of0
LA,
ThS: J
il TCTO SEC TCID:
PIC LPIC: TC NAME
NP
= SGNL: NIDR:
0K || PrintPreview || E-mail PreOrder || Recap Clear | Reset || cancel
‘JaveADD\elW\nduw

17 Click Add to activate a new section.

18 Fill in the secondary transfer of calls information.

In this field ... Do the following ...

TC TO SEC Type the secondary number calls will be transferred to

TCID Select the transfer of calls to identifier (the code for the
intercept message requested for a secondary telephone
number associated with intercept service)

TC NAME Type the name associated with the number that calls will be
transferred to

NIDR Indicate whether you need a new network interface device
™

19 If you need to add additional sections, repeat steps 17—18.
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20 Click the Inside Wire subtab.

Administrative Section
PON WER  RSQTY: AN (NNN-X99-3999-999) CE
| station Details | Commeon Block Details
Dof0
Add
N
J
LOCHUM: LNUM: i Features y Tc| Inside Wire | cable Connections | Remarks
O vero
LIA:
NS
N
- ]
v [ e [
PIC: LPIC:
LSCP: BA:
NP l—_l \—_I
-~
v
0K ” Print Preview ][ E-mail ] PreQrder “ Recap ] [ Clear ” Reset ” Cancel ]
Jawva Applet Window

21 Click Add to activate a new section.

22 Fill in the inside wire information. For help with blocking combinations see
http://www.centurylink.com/wholesale/clecs/features/blockingjobaid.htmil.

23 If you need to add additional inside wire sections, repeat steps 21-22.
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24 Click the Cable Connections subtab.

Centrex Resale Split @

Administrative Section
PON WER  RSQTY: AN (NNN-X99-3999-999) CE
0
Station Details | Common Block Details
Dof0
Add
LOCHUM: LNUM: Features ¥y TC | Inside Wire Cable Connections | Remarks
r 0ofd
LIA:
NS 0
OTH CABCONNTYP: [ |
CABCONMN -1
PIC: LPIC:
NP
0K Print Preview E-mail PreQrder Recap Clear Reset Cancel
‘JavaApp\elW\nduw

25 Click Add to activate a new section.

26 Fill in the cable connection information.

In this field ... Do the following ...
CABCONNTYP Select the cable connection type
CABCONN Specify the location of the cable connection points for POTS

splitters inside your company’s cage. You can type in the
location or select it from the list if you retrieved meet point
data (See page 46.)

27 If you need to add additional cable connections, repeat steps 25—26.

28 If you have any additional information relevant to this form, click the
Remarks subtab and do the following:

In this field ...

Do the following ...

Remarks

Add any additional information that is relevant to this form

Manual Ind

If CenturyLink requires information that you couldn’t
provide on the form, select Y so that the request will be
processed manually
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29 If you need to add additional station details sections, repeat steps 10-28.
30 Click the Common Block tab.
31 In the COS field, type the account-level USOC.

32 To go on to other forms, click OK.

If you receive an error message when closing the form, see “Correcting
errors when you close a form” on page 71.

Completing the DID Resale Service (DRS)

form

April 2, 2012

For definitive guidelines on filling out this form, see the DID Resale Service

Form Preparation Guide at http://www.centurylink.com/wholesale/clecs/
Isog.html. You can also double-click the field name to get help filling in that

field.

1 In the Order Information for New LSR/BRC window, select DID
Resale Service under Form Name.

2 Click Edit Form.

DID Resale Service E]
Administrative Section
PON VER AN (NNN-(93-3339-938) ORD
Service | Remarks
Oof0
Add
LOCHUM:  DIDMUM: CKR.
DTGN: DRTI: oL DGOUT: DPULSE! DSGNL:
DTKACT: DOTK: DTKID!
r Oof0
DTNRACT: DTHRG DTHR:
DSTHG
0ol
DSTNACT: DSTN:
OK Print Preview E-mail Clear Reset Cancel
‘Java Applet Window

3 Click the Service tab.

4 Click Add to activate a new section.
The counter updates to show the current number of repeating sections.
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Completing the Directory Listings Request (DL) form
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5 Fill in the service information.

6
Remarks tab and do the

If you have any additional information relevant to this form, click the

following:

In this field ...

Do the following ...

Remarks

Add any additional information that is relevant to this form

Manual Ind

If CenturyLink requires information that you couldn’t
provide on the form, select Y so that the request will be
processed manually

7 To go on to other forms, click OK.

If you receive an error message when closing the form, see “Correcting
errors when you close a form” on page 71.

Completing the Directory Listings Request

(DL) form

For definitive guidelines on filling out this form, see the Directory Listing form
preparation guide at http://www.centurylink.com/wholesale/clecs/Isog.html.

You can also double-click the field name to get help filling in that field.

1 In the Order Information for New LSR/BRC window, select Listing
Forms under Form Name.
2 Click Edit Form.
Directory Listings Request E|
CCNA PON YER LSR MNO; AN (NMNMN-X99-8999-999)
usa 123486 -
r Oofd
Add
I
Control | Indicators | Instruction| Caption/SLU| Delivery Address/Info | Remarks
LACT: AL FBOL CCMA FBDL CC
o
RTY: LT EQS
=] =1 I
8TYC TOA: Dol
= = [O=1
pDaTy
=l
oK Print Preview E-mail Clear Reset Cancel
[ )
‘JavaApp\elW\ndnw
3 Click Add to activate a new section.
The counter updates to show the current number of repeating sections.
4 Click the Control tab and enter the control information in the fields.
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Click the Indicators tab.

4—Preparing and submitting service requests
Completing the Directory Listings Request (DL) form

Directory Listings Request |£|
CCHNA  PON YER  LSRNO! AN (HNN-X99-2999-399)
| | [ | | I |
r 0ofd
Add Delete Gurrent Clear Current Delete All
-
d
control | Indicators | instruction | caption/sLU| Delivery Address/info| Remarks
DML NOSL:  THMKT:
Contomit -] ] [pent omit -]
BRO:
| |
DIRNAME:
|
ok [ printFreview || E-mail [ ciear ][ Reset | cancel
Java Applet Window
6 Fill in the indicators information.
7 Click the Instruction tab.
Directory Listings Request |z|
CCHNA  PON YER  LSRNO! AN (HNN-X99-2999-399)
| | [ | | I |
r 0of0
Add Delete Current Clear Current Delete All
=
d
Control| Indicators | Instruction. caption/SLU| Delivery Address/info| Remarks
LN NSTH OMTN:
= Il | ont omit =]
LNPL LNLH:
ford placement -] |
LNFN
~
=
< >
Hs: HTT HNSTN
[ kaf - - | \
DES L TITLE
| Il I \
NICK: PLA 80
| A
~|
< >
FAINFO
Py
v
< >
FATN FANSTH. LT
| Il I |
LTEXT: ADI
4] [Dont omit 7|
-
< 3
LAPR LANO: LASF:
| I ||
LASD! LASN] LATH
I = Il \
LASS LALO LALOC(CH): LAST:
L =i Il | [
ok [ printFreview || E-mail | [ ciear [ Reset | cancel
Java Applet Window
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8 Fill in the instruction information. The following table shows guidelines for
CenturyLink-specific fields.

In this field ... Do the following ...

HS If this an SLU listing, select whether the caption or SLU
header is new (N) or existing (E). Otherwise, leave this
field blank

HTN If this an SLU listing, fill in the telephone number for the

SLU header. Otherwise, leave this field blank. Otherwise,
leave this field blank

HNSTN If this an SLU listing, fill in the nonstandard telephone
number for the SLU header (e.g., 303-ABC-DEFG).
Otherwise, leave this field blank

SO Select whether the normal sequencing for an “indent”
should be overridden

FAINFO If you selected A in the SO field, type the indent or
subcaption header you want this listing filed after. If the
indent or subcaption header is longer than 100 characters,
type only the first 100

FATN If you selected A in the SO field and the text this listing
follows text that contains a standard phone number, type
the phone number

FANSTN If you selected A in the SO field and the text this listing
follows text that contains a nonstandard phone number,
type the phone number

9 Click the Caption/SLU tab.

CCNA  PON WER  LSR MO AN {NNN-%99-9999-959)
r 0of0
Add
Contrel| Indicators | Instruction| Caption/SLU | Delivery Address/Info| Remarks
0of0
L. PLE:
PLINFO
Lo
L
3| 3
PLTM: PLNSTM: 50:
FAINFO!
~
v
< >
FATN FANSTN
0K || PrintPreview || E-mail Clear Reset || Gancel

[ l

[1va AceletWindow

10 Click Add to activate a new section.
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Completing the Directory Listings Request (DL) form

11 Fill in the caption and SLU information. The following table shows
guidelines for CenturyLink-specific fields.

In this field ... Do the following ...

PLNSTN If you filled in the PLS field and the prior level contains a
nonstandard number, type the nonstandard number

FANSTN If you select N in the PLS field, A in the SO field, and the
text this listing is following contains a nonstandard number,
type the nonstandard number

12 Click the Delivery Address/Info tab.
CCNA  PON ¥ER  LSRMNO| AN {MNN-X99-9999-959)
uga 123456
r 0of0
Add
0
Control| Indicators | Instruction| Caption/SLU| Delivery Address/Info | Remarks
0of0
J
DACT, DDAPR: DDAMNO DDASF DDASD,
=] =]
DDASN;
DDATH. DDASE, DDALO,
=]
Iy STATE: ZIP:
DIRGTYNC:
=]
0K || PrintPreview || E-mail Clear Reset || Gancel

l

[1va AceletWindow

13 Click Add to activate the repeating section.

14 Fill in the delivery address information. If you have additional address
information (such as a specific floor), type it in the DDALO field.

15 If you have any additional information relevant to this form, click the
Remarks tab and fill in the Remarks field.

16 To go on to other forms, click OK.

If you receive an error message when closing the form, see “Correcting
errors when you close a form” on page 71.
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Completing the End User (EU) form

If you're filling in a bulk request, see page 97 for instructions on filling in this
form. For all other LSRs, use the instructions directly below.

For definitive guidelines on filling out this form, see the End User form
preparation guide at http://www.centurylink.com/wholesale/clecs/Isog.html.
You can also double-click the field name to get help filling in that field.

... for individual LSRs

To complete the End User form

1 In the Order Information for New LSR/BRC window, select End User
under Form Name.

2 Click Edit Form.

End User X
Administrative Section
PON WER AN (NNN-X89-0935-358) Dary:
Loc Access/Inside Wire | Billing | Disconnect| Remarks
(%) One Location Tab ) Two Location Tabs
First Location | Second Location| Third Location | Fourth Location
LOCNUM  Narne;
001
NCON
v
Walidated Addresses:
Mo Validated Address ¥
AFT. SAPR: SANOD, SASF.
v
SASD SASN SATH SASS
v v
LD1 L1 LD2 Lv2 LD3: L¥3
v v v
AN
AHN: ROUTE:  BOX:
CITY: STATE: ZIP
v
CALAISAGA
v
LCOM: TELNO:
ACC
~
v
< ¥
WSOP WEOP TEL NO EUMI
w|[ - v
CPE MFR CPE MOD 0
v
OK Print Preview E-mail Clear Reset Cancel
‘Java Applet Window

3 On the Loc Access/Inside Wire tab, select the number of location tabs

you want to activate—that is, the number of locations for which you want
to enter information.
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Completing the End User (EU) form

Caution: If you reduce the number of locations you selected, you lose
the information you entered.

4 Click the First Location tab.

5 In the Name field, type your customer’s name. Use the Customer Name
from the CSR if it's available.

6 Do one of the following:

If you validated the address ... If you didn’t validate the address ...
In the Validated Addresses list, select a If you couldn’t validate the address—or if
the address for your customer. you got a SAG Only match—and this is a
new installation or account, indicate in the
IMA automatically fills in the address NCON field whether this is a new service
information. address (A) or a new location within an

existing service address (B).
b Do one of the following:

 For LNP, LSNP, UBL Split with Number
Portability, or for UBL and UBL Split
Conversions As Specified, fill in the
SANO field.

= Otherwise, fill in the SANO, SASN,
CITY, STATE, and CALA/SAGA fields,
following the guidelines in “Validating
addresses” on page 10.

7 Fill in the remaining fields as appropriate. If there is working service on the
premises, type the telephone number in the WSOP TEL NO field.

8 In the EUMI field, indicate whether your customer is moving (Y) to the
service address shown on the form.

9 If you activated any additional locations in step 3, click the Second
Location subtab and repeat steps 5 and 6. If applicable, repeat steps 5
and 6 for the Third and Fourth Locations also.

10 Click the Billing tab.
[ndUser El

Administrative Section

POM WER AN (NNMN-X95-0995-055) DATY:

Loc Access/Inside Wire | Billing | Disconnect| Remarks

EAN FEI
v

BILLMAM: SBILLMNA

AFT: BAPR: BAMO! BASF

SASD SASN SATH: SASS:

FLOOR ROOMMAIL STOP:

CITY, STATE. ZIP,

v

BILLCON TELNO 58N

Ok Print Preview E-mail Clear Reset Cancel
[ l

[1va AceletWindow
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11 If you are converting an entire account and if your customer wants their
final bill to be sent to an address different from their billing address, select

D—Different in the FBI list and fill in at least the BILLNM, SANO, SASN,
CITY, STATE, and ZIP fields.

12 Do one of the following:

< If you are disconnecting an entire account, continue with steps 13—-17.
< If you are not disconnecting an entire account, skip to step 18.
13 Click the Disconnect tab.

End User %
Administrative Section
PON WER AN (NNN-%99-8998-999) DaTY:
Loc Access/Inside Wire | Billing Disconnect Remarks
Qoro
Addd
DNUM:  DISC NBR: TC OPT:
TCTOPRI TCID: TG NAME TC PER
I
00f0- Secondary Transfer of Calls
TC TO SEC TG ID: TG NAME
0K || PrintPreview || E-mail Clear Reset | Cancel
‘JaveADD\elW\nduw

14 Click Add to activate a new section.
The counter updates to show the current number of repeating sections.

15 Fill in the fields on the tab. The following table shows guidelines for
CenturyLink-specific fields.

In this field ... Do the following ...

TCID Select the transfer of calls to identifier (the code for the
intercept message requested for a primary telephone
number associated with intercept service)

TC NAME Type the name associated with the number that calls will be
transferred to

16 If you need to specify a secondary transfer of calls, click Add to activate a
new subsection and fill in the fields.

17 If you need to disconnect additional lines, repeat steps 14-16.

18 If you need to add additional information relevant to this form, click the
Remarks tab and do the following:

In this field ... Do the following ...

Remarks Enter the additional information relevant to this form
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In this field ... Do the following ...

Manual Ind If CenturyLink requires information that you couldn’t

provide on the form, select Y so that the request will be
processed manually

19 To go on to other forms, click OK.

If you receive an error message when closing the form, see “Correcting
errors when you close a form” on page 71.

... for bulk requests

To complete the End User form

1 Click the Disconnect tab.

End User 3
Administrative Section
PON DaTY:
0
Disconnect
Qoro
Add
DISC NER: DOD
i
TC OPT. TC PER
I
TCTOPRIE TCID: TC MAME:
00f0- Secondary Transfer of Calls
TC TO SEC: TCID: TG NAME:
0K Print Freview E-mail Clear Reset Cancel
‘JaveADD\elW\nduw

2 Click Add to activate a new section.
The counter updates to show the current number of repeating sections.

3 Fill in the disconnect information. The following table shows guidelines for
CenturyLink-specific fields.

In this field ... Do the following ...

DISC NBR Use this field to list a number on the account you want to

disconnect, suspend, or change the PIC/LPIC

TC ID Select the transfer of calls to identifier (the code for the

intercept message requested for a primary telephone
number associated with intercept service)

TC NAME Type the name associated with the number that calls will be
transferred to

4 If you need to specify a secondary transfer of calls, click Add to activate a
new subsection and fill in the fields.
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5 If you need to disconnect additional lines, repeat steps 2—4.

6 To go on to other forms, click OK.

If you receive an error message when closing the form, see “Correcting

errors when you close a form” on page 71.

Completing the Facility Based Directory

Listing Request form

For definitive guidelines on filling out this form, see the Directory Listing form
preparation guide at http://www.centurylink.com/wholesale/clecs/Isog.html.

You can also double-click the field name to get help filling in that field.

To complete the Facility Based Directory Listing Request form

1 In the Order Information for New LSR/BRC window, select Listing

Forms under Form Name.
2 Click Edit Form.

Facility Based Directory Listing Request X
CCNA FOM LER MO AN (NMM-X88-3959-399)
uga 123456
r 0ofdo
Add
Centrol | Indicators | Instruction Caption/SLU | Delivery Address/Info, Remarks
LACT: AL FBEDL CCHA FEDLCC
=]
RTY: LT
=) =
8TYC TOA Dol
=) |
DLNUM: oDaTyY
=
0K Print Preview E-mail LSTR RECAP Clear Reset Cancel
‘JaveADD\elW\nduw
3 Do one of the following:
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Completing the Facility Based Directory Listing Request form

« If you want to retrieve directory listing information so IMA can fill in the
fields on this form for you, continue with step 4. (You must be
authorized to retrieve directory listing information. If you're not
authorized, skip to step 10 and fill in the information manually.)

< If you'd like to fill in the directory listing information manually, skip to
step 10.

Click LSTR.

To retrieve listings, follow the directions in the Facility-Based Directory
Listings Guide.
On the Facility Based Directory Listing Request form, click Recap.

Multiple Matches Found

LhiL & PAIR
Y N

REC TYPE  DIRNAME DIRIDL

ROL REF ALl STVC TMF CODE
0 [ 0000

IndA 7101, TR

~
< ¥

| Select Highiighted Listings || Select All Listings [ Toggle Selected Listings 0&I Fair

[1va AceletWindow

Do one of the following:

e Select the directory listings you want to recap and click Select
Highlighted Listings.

* Click Select All Listings.

For each selected directory listing, check the information and revise it if
necessary.

IMA creates a section for each directory listing you select and automatically
fills in the fields with the information in this window.

Do one of the following:

< If you need to add additional directory listings, continue with step 10.
e If you've added all the information you need, skip to step 23.

10 Click Add to activate a new section.

The counter updates to show the current number of repeating sections.

11 Click the Control tab and enter the control information in the fields. The

April 2, 2012

following table shows guidelines for CenturyLink-specific fields.

In this field ... Type ...

FBDL CCNA The CCNA (customer carrier name abbreviation) for the
customer submitting the listing request and receiving the
confirmation

FBDL CC The company code for the exchange carrier requesting the
listing
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Completing the Facility Based Directory Listing Request form

12 Click the Indicators tab.

Facility Based Directory Listing Request

H
CChA FPON LSR MO AR (MMM 98-9999-999)
e | 12ses ] | - |
r 0ofd
Add Delete Current Clear Current Delete All
i

Control| Indicators | Instruction | Caption/SLU| Delivery Address/info| Remarks

DML NOSL: TMKT:

[Dant Omit 'l 'l [Dant Omit 'l
BRO:

DIRMAME .

oK | printPreview ][ E-mail ] [ Lo ][ Recap [ clear ][ Reset ][ cancel

Java Applet Window

13 Fill in the indicators information.
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14 Click the Instruction tab.

Facility Based Directory Listing Request E]
CCNA PON L3R MNO: AN (NMN-X98-9998-998)
usa 123456 -
r 0of0
Add
Control| Indicators | Instruction | Caption/SLU | Delivery Address/Info | Remarks
LTN: NSTH! OMTHN
LMNPL: LNLN:
LNFM:
~
v
< >
HE: HTH: HNSTH:
DES L TITLET:
NICK: PLA 80
= E
v
< >
FAINFO
~
v
< >
FATH FANSTH. LTHTY.
LTEXT: ADI!
= =
v
< >
LAPR LANO: LASF
LASD LASN LATH
LASS! FLOOR: ROOMMAIL STOP BLDG:!
LALOC(City) LAST:
oK Print Preview E-mail LETR RECAP Clear Reset Cancel
‘Java Applet Windows

15 Fill in the instruction information. The following table shows guidelines for
CenturyLink-specific fields.

In this field ...

Do the following ...

HS

If this an SLU listing, select whether the caption or SLU
header is new (N) or existing (E). Otherwise, leave this
field blank

HTN

If this an SLU listing, fill in the telephone number for the
SLU header. Otherwise, leave this field blank. Otherwise,
leave this field blank

HNSTN

If this an SLU listing, fill in the nonstandard telephone
number for the SLU header (e.g., 303-ABC-DEFG).
Otherwise, leave this field blank

SO

Select whether the normal sequencing for an “indent”
should be overridden

FAINFO

If you selected A in the SO field, type the indent or
subcaption header you want this listing filed after. If the
indent or subcaption header is longer than 100 characters,
type only the first 100

April 2, 2012
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In this field ... Do the following ...

FATN If you selected A in the SO field and the text this listing
follows text that contains a standard phone number, type
the phone number

FANSTN If you selected A in the SO field and the text this listing
follows text that contains a nonstandard phone number,
type the phone number

16 Click the Caption/SLU tab.

Facility Based Directory Listing Request @
CCNA  PON L5R NO: AN (NNN-399-0999-058)
usa 123456
- 0of0
Add
Control| Indicators | Instruction| Caption/SLU | Delivery Address/Info | Remarks
0ofo
VL PLS:
PLINFO
~
v
< >
PLTN PLRETH: 50
FAINFO:
-~
v
< >
FATN FANSTN
0K Print Preview E-mail LSTR RECAP Clear Reset Cancel
‘Java Applet Window

17 Click Add to activate a new section.

18 Fill in the caption and SLU information. The following table shows
guidelines for CenturyLink-specific fields.

In this field ... Do the following ...
PLNSTN If you filled in the PLS field and the prior level contains a
nonstandard number, type the nonstandard number
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In this field ...

Do the following ...

FANSTN

If you select N in the PLS field, A in the SO field, and the
text this listing is following contains a nonstandard number,

type the nonstandard number

19 Click the Delivery Address/Info tab.

Facility Based Directory Listing Request

E3]
CCHA POM LSR MO AN (NMM-X05-9999-099)
uga 123456 -
r Oofo
Add
J
Control| Indicators | Instruction | Caption/SLU| Delivery Address/Info | Remarks
oofo
I
DELNUM: DACT: DDAPR. DOANO: DDASF: DDASD:
= =
DDASH:
DDATH DDASS
=
LD1: Lt Loz vz LD3: LV3: AHN ROUTE  BOX
=l | =l
cITY: STATE: ZIP:
DIRGTYNC:
=l
0K Print Preview E-mail LSTR RECAP Clear Reset Cancel
[ l
‘JaveADD\elW\nduw
20 Click Add to activate the repeating section.
21 Fill in the delivery address information.
22 If you have any additional information relevant to this form, click the
Remarks tab and fill in the Remarks field.
23 To go on to other forms, click OK.
If you receive an error message when closing the form, see “Correcting
errors when you close a form” on page 71.
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Completing the Hunt Group Information (HGI)
form

You use the Hunt Group ldentification Section to establish, change, or
discontinue hunting. You use the Hunt Detail Section to specify the line
activity, number type, and terminal or telephone number for the line(s) in the
Hunt Group ldentification Section.

For “conversion as specified” orders (ACT = V or Z), you must specify the end
state of the hunting on the account. If you have hunting on an account and
you submit an LSR for that account without including the HGI form,
CenturyLink removes the hunting from the account.

Hunting change requests normally require you to include a product form with
your request. If you are changing the hunt sequence on an existing hunt group
for any product except Centrex, fill in only the LSR, EU, and HGI forms; Leave
the product form blank.

A hunt group cannot be split between CSRs on a partial conversion; you must
establish a new hunt group for the new account.

For definitive guidelines on filling out this form, see the Hunt Group
Information form preparation guide at http://www.centurylink.com/wholesale/
clecs/lsog.html. You can also double-click the field name to get help filling in
that field.
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Completing the Hunt Group Information (HGI) form

To complete the Hunt Group Information form

1 In the Order Information for New LSR/BRC window, select Hunt
Group Information under Form Name.

2 Click Edit Form.

Hunt Group Information @
Administrative Section
FON VER AN (NNN-98-3588-350)
123456
Hunt Group Identification Section
r 0of0
Add
LOCHUM:  HMNUM:  HA; HID: TL!
HNTYP
HTSEQ:
~
v
< ¥
Hunt Detail Section
Oof0
HLA KNOTYP: HTH.
oK Print Preview E-mail Clear Reset Cancel
‘Java Applet Window

3 Click Add to activate a new section.
The counter updates to show the current number of repeating sections.

4  Fill in the hunt group identification information. The following table shows
guidelines for CenturyLink-specific fields.

In this field ... Do the following ...
HTSEQ

If you are adding or changing hunting, type the hunting
sequence or range of hunt sequences

In the Hunt Detail Section, click Add to activate a new section.

Fill in the hunt detail information.
Repeat steps 5 and 6 for each line in the hunt group.

If are requesting more than one hunt group, repeats steps 3-7.

© 0 N o O

To go on to other forms, click OK.

If you receive an error message when closing the form, see “Correcting
errors when you close a form” on page 71.
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Completing the Local Service Request (LSR)
form

You use the Local Service Request form to enter or verify general
administrative, billing, and contact information about your customer. You must
use a separate form for each service request. If you are preparing a BRC (bulk
request to create LSRs), you can use a single LSR form to request multiple
disconnections or suspensions.

If you're filling in a bulk request, see page 110 for instructions on filling in this
form. For all other LSRs, use the instructions directly below.

For definitive guidelines on filling out this form, see the Local Service Request
form preparation guide at http://www.centurylink.com/wholesale/clecs/
Isog.html. You can also double-click the field name to get help filling in that
field.

... for individual LSRs

To complete the Local Service Request form

1 In the Order Information for New LSR/BRC window, select Local
Service Request under Form Name.
2 Click Edit Form.

[¥] Local Service Request E‘

Administrative Section

CChA POM WER LSR MO LOCATY HTGTY LSR REJECT OVERRIDE
a v

AN (NNMN-Y98-9999-995) MNAN DLEC GCNA

Admin | Billing| Contact| Remarks

PG_of_  DITSENT
DSFTCH DDD APPTIME APTCON DODO DFDT
w|[ s I
PROJECT cHC TEST
~ -
REQTYPE ACT RSTTYP cP csot: csox P
EB N v v 3
CONVIND M SUP EXF RTR
v v v v
cc AENG  ALBR SCA
~ ~ ~
AGAUTH DATED AJTHNM
w|[
PORTTYP: ACTL Al APOT LST Lso: TOS: NFDI! SPEC
v 1 v
NG el SECNCI RPN RORD: DLQTY.
0
oK | PrintPreview || E-mail clear || Reset | cancel

[ l

[1va AceletWindow

The Administrative Section identifies the LSR you are processing.

3 Fill in the LOCQTY, AN, NAN, and DLEC CCNA fields, following the
guidelines in the Local Service Request form preparation guide
(http://www.centurylink.com/wholesale/clecs/Isog.html). Skip the LSR
REJECT OVERRIDE field unless you have received an event notification
indicating that you need to use reject override or an error message when
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you tried to submit the LSR (page 74) saying that you need to override the
rejection to submit the LSR. If you don’t know the account number, you
can leave the AN field blank. But if there are two or more CSRs for a single
TN, be sure to fill in the account number—including the customer code. You
can obtain the customer code from your customer’s CSR (see page 19).

4  Fill in the fields on the Admin tab. The following table shows guidelines for
CenturyLink-specific fields. The due date (DDD) cannot be later than one
year from today’s date. If you need a later due date, either re-submit
closer to that date or fax in your order for manual processing.

In this field ... Do the following ...

APTCON IMA automatically fills in the appointment confirmation
number if you scheduled an appointment

CHC Indicate whether you need a single hot cut (Y - Yes), batch

hot cut (B - Batch Hot Cut), or none (N - No). (You can’t

create a batch hot cut for another CLEC.)

Note: If you've scheduled a batch hot cut, make sure that
the LOCZ CLLI code matches the switch CLLI code
(LST) you used when you scheduled the appointment.

TEST Select the type of testing requested for the installation, if
applicable

RSTTYP If you are requesting that service be restored, indicate
whether the restore is from a seasonal suspend (S) or a
deny (D)

CIP You can select Y to speed up the processing of your request

if you're requesting a change in an account (ACT=C) and if
a conversion is in progress but isn’t reflected in the
customer’s CSR (see page 22) Be sure to follow the
guidelines for the CIP field in the Local Service Request
(LSR) form preparation guide at http://
www.centurylink.com/wholesale/clecs/Isog.html. If you
select Y, type the service order number(s) for the pending
conversion(s) in the CSO1 field and, if necessary, the
CSO2 field

PMI Indicate whether your customer is requesting a partial
move of their account

RTR If you want to request a DLR (design layout record), select
D or X
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5 Click the Billing tab.

Administrative Section

User’s Guide—IMA 32.0

[ Local Service Request @

CCNA PON WER

LSR MO

LOCQTY HTGTY LSRR REJECT OVERRIDE

| | [ |

[

AN (NNN-X99-0933-935) AN

DLEG CCNA

]

Adminl Billing ‘ Contact| Remarks

BI BANT BIZ:

BANZ: BAPC: ACHA,

\ d |

“f

BILLMAM:

SBILLMNM

o] .

TE

BTREET:

FLOOR: ROOMIMAIL STOP

CITY.

BTATE:. ZIP

|y

VTA

L 1

OK ” Print Preview ][ E-mail ]

[ Clear “ Reset ][ Cancel

Java Applet Window

6 Fill in the active fields as appropriate.
7 Click the Contact tab.
Local Service Request \z\
Administrative Section
SONA PN VER  LBRND LOGGTY HTGTY LSR REJECT OVERRIDE
| | I | I
AN (NNN-I99-0595-939) rA DLEC CONA
- I -
Admin EIiIImgl Contact ‘ Remarks
‘"'ITMT‘ Design Contact
INIT: TEL HO:
\ Il
EMAIL: Fa O
\ Il
STREET:
\
FLOOR ROOMAMAIL STOF
\ || \
T STATE. ZF
\ |Eo] |
IMPGON TEL MO FAGER
\ J[-- - I |
ALT IMPCON TELHO FAGER
\ IL--- Il |
ok [ printFreview || E-mail [ ctear || meset | cance |
l
Java fiplet Window

8 As appropriate, fill in the
Design Contact subtab.

9
Remarks tab and do the

active fields on the Initiator subtab and the

If you need to add additional information relevant to this form, click the

following:

In this field ...

Do the following ...

Remarks

Enter any additional information relevant to the form
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In this field ... Do the following ...

Manual Ind If CenturyLink requires information that you couldn’t
provide on the form, select Y so that the request will be
processed manually

Pending Order Indicate whether another request is pending for the
account

10 To go on to other forms, click OK.

If you receive an error message when closing the form, see “Correcting
errors when you close a form” on page 71.
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... for bulk requests

To complete the Local Service Request form

1 Click the Admin tab.

[ Bulk Request

Administrative Section

CONA  PON
[
‘ATmn‘ Contact

DIT SENT

200704161140

DDD

PIC LPIC

[ —

User’s Guide—IMA 32.0

ok printPreview [ E-man_|

[ clear ][ Reset |[ cancer

Java Applet Window

2 Fill in the DDD field.

3 If necessary, fill in the PIC and LPIC fields.

4 Click the Contact tab.

Hulk Request

Administrative Section

CChA POM
[ —

Admin | Contact:‘

| Initiator |

INIT: TEL NO:

EnAIL:

FAR NO:

BTREET:

FLOOR: ROOMIMAIL STOP

BTATE:. ZIP

CITY.
|

|[co-] |

IMPCON TELNO

PAGER

ALT IMPCON TELNO

ok [ printFreview || E-mail |

[ ciear ][ Reset || cancel

Java Applet Window

As appropriate, fill in the active fields on the Initiator subtab.

6 To go on to other forms, click OK.

If you receive an error message when closing the form, see “Correcting

errors when you close a form” on page 71.
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Completing the Loop Service (LS) form

You can create a single LSR to establish multiple unbundled loops at a single
location (for unbundled local loop (UBL), unbundled feeder loop, and loop
splitting). You can also submit a single LSR for moves or changes to multiple
loops if the loops were established with a single LSR. IMA verifies that requests
on local multi-loop accounts are valid and support flowthrough of eligible
product/activity types.

For disconnects or disconnect requests, the LSR may contain multiple circuits
with different addresses and/or NC/NCI codes as long as the Near Match rules/
edits in flowthrough are met.

For UBL requests with ACT=T M, or C, the CFA, NC, NCI, and SECNCI fields
must match the CSR.

For definitive guidelines on filling out this form, see the Loop Service form
preparation guide at http://www.centurylink.com/wholesale/clecs/Isog.html.
You can also double-click the field name to get help filling in that field.

For more information about this form, see the Loop Qualification and Raw Loop
Data CLEC Job Aid at http://www.centurylink.com/wholesale/training/
coursecatalog.html.

While you’re working on the Loop Service form, you can do related tasks by
clicking PreQOrder and selecting the task. Follow the appropriate guidelines:

e “Checking whether a POTS loop can be unbundled” on page 41

e “Checking whether a loop qualifies for CenturyLink HSI/Broadband Service
or unbundled ADSL service” on page 54

e “Selecting available CFA units” on page 42

e “Searching for available meet points” on page 46
e “Retrieving raw loop data” on page 53

To complete the Loop Service form

1 In the Order Information for New LSR/BRC window, select Loop
Service Form under Form Name.
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2 Click Edit Form.

Loop Service E]
Administrative Section
PON WER AN (NNN-¥99-9939-999) Lary:
- 0
Service | Remarks
Dof0
Add
Line Shared TH:
LOCHUM:  LNUM: LMA: CKR:
TEP: SAN ECCKT: (N=n> AARANNN=nnn>_A%)
CFA NIDR:
POTESEPLIT. POTSSPLITLOC:
Inside Wire | Transfer of Calls | Cable Connections
0of
ALK [}
0K Print Preview E-mail PreQrder Clear Reset Cancel
‘Java Applet Window

3 On the Service tab, click Add to activate a new section.
The counter updates to show the current number of repeating sections.

4 Enter the service information in the fields. The following table shows
guidelines for CenturyLink-specific fields.

In this field ... Do the following ...
Line Shared TN Type the telephone number of the loop to be shared
Validate CFA Use as a shortcut for selecting available CFAs (See

“Selecting available CFA units” on page 42.)

POTSSPLIT Specify the location of the cable connection points for POTS
splitters outside your company’s cage. You can type in the
location or select it from the list if you retrieved meet point
data (See page 46.)

POTSSPLITLOC Select the location of the POTS splitter

If you need to add additional services, repeat steps 3 and 4.
Click the Inside Wire subtab.
Click Add to activate a new section.

Enter the inside wire information in the fields.

© 0 N o O

If you need to add additional sections, repeat steps 7 and 8.

112 April 2, 2012
http://www.centurylink.com/wholesale/cmp/review_archivesystem.html



User’s Guide—IMA 32.0

4—Preparing and submitting service requests
Completing the Loop Service (LS) form

10 Click the Transfer of Calls subtab.

Administrative Section

Loop Service E]

Service | Remarks
00f0

POM WER AR (NRN-X99-09595-055) LOTY:

0

Add

Line Shared TH:
LOCNUN  LNUM: LA
TSP, SAN,

POTSEPLIT:

Inside Wire | Transfer of Calls | cable Connections

ECCKT: (M=n= ARAANNN <nnn=. A8)

MIDR:

POTSSPLITLOC:

DISC NBR TCOPT: TCTOPRI TCID
TC MNAME TCPER:
I
0of 0- Secondary Transfer of Calls
TC TO SEC, TCID: T WAME:
Ok Print Preview E-mail PreOrder Clear Reset Cancel

[

l

[1va AceletWindow

11 Enter the transfer of calls information in the fields at the top of the subtab.

In this field ...

Do the following ...

TC ID Select the transfer of calls to identifier (the code for the
intercept message requested for a secondary telephone
number associated with intercept service)

TC NAME

Type the name associated with the number that calls will be
transferred to

12 Click Add to activate a new section.

13 Enter the secondary transfer of calls information in the fields.

14 If you need to add additional sections, repeat steps 12 and 13.
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15 Click the Cable Connections subtab.

Loop Service E|

Administrative Section

POM WER AR (NRN-X99-09595-055) LOTY:

Service | Remarks
00f0

Addd

0

Line Shared TH:
LOCHUM:  LNUM: LMA: CKR:

TEP. BAN, ECCKT: (M=n= AAAA MMN<nnn=_AA)

CFA NIDR:

POTESEPLIT. POTSSPLITLOC:

Inside Wire | Transfer of Calls| Cable Connections
000

0

CABCOMNTYP:
CABCONN

[Cor ) PrmPreven || et | [ Freomn | [otem ]| Reset ]| caneel |
[ |

[1va AceletWindow

16 Click Add to activate a new section.

17 Enter the cable connections information in the fields. The following table
shows guidelines for CenturyLink-specific fields.

In this field ... Do the following ...
CABCONNTYP Select the type of cable connection
CABCONN

Specify the location of the cable connection points for POTS
splitters inside your company’s cage. You can type in the
location or select it from the list if you retrieved meet point
data (See page 46.)

18 If you need to add additional cable connections, repeat steps 16 and 17.

19 If you need to add additional information relevant to this form, click the
Remarks tab and do the following:

In this field ... Do the following ...

Remarks Add any additional information relevant to the form

Manual Ind If CenturyLink requires information that you couldn’t
provide on the form, select Y so that the request will be
processed manually

20 To go on to other forms, click OK.

If you receive an error message when closing the form, see “Correcting
errors when you close a form” on page 71.
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Completing the Loop Service with Number
Portability (LSNP) form

April 2, 2012

For definitive guidelines on filling out this form, see the Loop Service Number
Portability form preparation guide at http://www.centurylink.com/wholesale/
clecs/Isog.html. You can also double-click the field name to get help filling in

that field.

While you’re working on the Loop Service with Number Portability form, you
can do related tasks by clicking PreOrder (at the bottom of the window) and
selecting the task. Follow the appropriate guidelines:

e “Checking whether a POTS loop can be unbundled” on page 41

e “Checking whether a loop qualifies for CenturyLink HSI/Broadband Service
or unbundled ADSL service” on page 54

e “Selecting available CFA units” on page 42
e “Retrieving raw loop data” on page 53
To complete the Loop Service with Number Portability form

1 In the Order Information for New LSR/BRC window, select Loop
Service with Number Portability under Form Name.

2 Click Edit Form.

Loop Service NP E|
Administrative Section
PON WER AN (NNN-X89-0935-358) Lary:
Service  Remarks
Qoro
Add
LHUM: LI
CKR TEP.
TOT: SAR ECCKT: (N=n= AAAA HNN<nnn=, A&}
CFA: NIDR
POTSSPLIT, POTSSPLITLOC:
Inside Wire | PortTransfer of Calls | Cable Connections
0070
UK e}
OK || PrintPreview || E-mail PreOrder Clear Reset || Cancel
‘Jave Applet Window

3 Enter the number of loops you need ported in the LQTY field.
4 Click the Service tab.

5 Click Add to activate a new section.
The counter updates to show the current number of repeating sections.
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6 Enter the service information in the fields. The following table shows
guidelines for CenturyLink-specific fields.

In this field ... Do the following ...

POTSSPLIT Specify the location of the cable connection points for POTS
splitters outside your company’s cage. You can type in the

location or select it from the list if you retrieved meet point
data (See page 46.)

POTSSPLITLOC Select the location of the POTS splitter

7 If you need to add additional sections, repeat steps 5 and 6.

8 Scroll to the lower part of the screen and click the Inside Wire subtab.
9 Click Add to activate a new section.

10 Enter the inside wire information in the fields.

11 If you need to add additional sections, repeat steps 9 and 10.

12 Click the Port/Transfer of Calls subtab.

Loop Service NP El

Administrative Section

POM WER AR (NRN-X99-09595-055) LOTY:

Service | Remarks
00f0

LNUM: LA
CKR TSP
TOT: SAN,

EGCKT: (N=n> AAAA NNN=nfn=. A8
NIDR:
POTSSPLIT

POTSSPLITLOC:

Inside Wire | PortTransfer of Calls | Cable Connections

FORTED NBR: TNP CFTN NPT RTI NPTG!
BA BLOCK: FPI LPIC:
TC OPT: TCTO PRI TCID
TC NAME! TCPER:
I
0of 0- Secondary Transfer of Calls
TCTOSEC TCID: TC NAME:
OK Print Preview E-mail PreOrder Clear Reset Cancel

[ l

[E——
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13 Enter the port/transfer of calls information in the fields.

In this field ... Do the following ...
FPI Leave this field blank
TC ID Select the transfer of calls to identifier (the code for the

intercept message requested for a secondary telephone
number associated with intercept service)

TC NAME Type the name associated with the number that calls will be
transferred to

14 Click Add to activate a new repeating section.

15 Enter the secondary transfer of calls information in the fields.
16 If you need to add additional sections, repeat steps 14 and 15.
17 Click the Cable Connections subtab.

Loop Service NP E|
Administrative Section
PON WER AN (NNN-X89-0935-358) Lary:
Service  Remarks
Qoro
Add
LHUM: LI
CKR TEP.
TOT: SAN ECCKT: (N=n= AAAA NNN<nnn= AR}
CFA: NIDR
FOTSSPLIT, POTSSPLITLOC:
Inside Wire | PortTransfer of Calls| Cable Connections
Qoro
CABCONNTYP:
CABCONN
OK | PrintPreview || E-mail PreOrder Clear Reset || Cancel
‘Jave Applet Window

18 Click Add to activate a new section.

19 Enter the cable connections information in the fields. The following table
shows guidelines for CenturyLink-specific fields.

In this field ... Do the following ...
CABCONNTYP Select the cable connection type
CABCONN Specify the location of the cable connection points for POTS

splitters inside your company’s cage. You can type in the
location or select it from the list if you retrieved meet point
data (See page 46.)
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20 If you need to add additional sections, repeat steps 18 and 19.

21 If you need to add additional information relevant to the form, click the
Remarks tab and do the following:

In this field ... Do the following ...
Remarks Add any additional information relevant to the form
Manual Ind If CenturyLink requires information that you couldn’t

provide on the form, select Y so that the request will be
processed manually

22 To go on to other forms, click OK.

If you receive an error message when closing the form, see “Correcting
errors when you close a form” on page 71

Completing the Number Portability (NP) form

On each request, you can specify one or more ported telephone numbers or
one range of ported numbers. If you are porting a range of numbers, you can
specify only one range; if you need to port an additional range, you must
submit an additional request.

For definitive guidelines on filling out this form, see the Number Portability
form preparation guide at http://www.centurylink.com/wholesale/clecs/
Isog.html. You can also double-click the field name to get help filling in that
field.

1 In the Order Information for New LSR/BRC window, select Number
Portability under Form Name.
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2 Click Edit Form
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Completing the Number Portability (NP) form

MNumber Port g‘
Administrative Section
FON VER AN (NNN-98-3538-888) MPOTY:
- 1)
Service  Remarks
Qoro
Add
LINUM: LNA: TOT: PORTED NBR: RANGE THP: CFTN:
NPT RTI MNPTG: BA
BLOCK: FPI LPIC: TCOPT: TCTO PRI TCID
TC NAME: TCPER:
I
00f0- Secondary Transfer of Calls
TC TO SEC TCID: TC NAME:
OK Print Preview E-mail Clear Reset Cancel
‘Jave Applet Window

Click the Service tab.

Click Add to activate a new section.

The counter updates to show the current number of repeating sections.

Enter the service information in the fields. The following table shows

guidelines for CenturyLink-specific fields.

In this field ...

Do the following ...

RANGE

The highest value of the range of ported TNs

FPI

Leave this field blank

TC 1D

Select the transfer of calls to identifier (the code for the
intercept message requested for a secondary telephone
number associated with intercept service)

TC NAME

Type the name associated with the number that calls will be
transferred to

If you are disconnecting numbers, do one of the following:

e If you filled in the RANGE field, complete the TC ID, TC NAME, and
TCPER fields.

« If you did not fill in the RANGE field, complete the Secondary
Transfer of Calls section.

If you need to add additional services, repeat steps 4—6.
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8 If you have additional information relevant to this form, click the Remarks
tab and do the following:

In this field ... Do this ...
Remarks Enter any additional information relevant to the request
Manual Ind If CenturyLink requires information that you couldn’t

provide on the form, select Y so that the request will be
processed manually

9 To go on to other forms, click OK.

If you receive an error message when closing the form, see “Correcting
errors when you close a form” on page 71.

To complete a request for simple port, see “Completing a request for Simple
Port” on page 145.
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Completing the Port Service (PS) form

For definitive guidelines on filling out this form, see the Port Service form
preparation guide at http://www.centurylink.com/wholesale/clecs/Isog.html.
You can also double-click the field name to get help filling in that field.

While you’re working on the Port Service form, you can do related tasks by
clicking PreOrder (at the bottom of the window) and selecting the task. Follow
the appropriate guidelines:

< “Reserving telephone numbers” on page 54

e “Checking whether a POTS loop can be unbundled” on page 41
e “Checking whether POTS facilities are available” on page 36

e “Selecting available CFA units” on page 42

e “Retrieving a full CSR” on page 20

< “Checking whether services are available” on page 31

- “Retrieving raw loop data” on page 53

April 2, 2012 121
http://www.centurylink.com/wholesale/cmp/review_archivesystem.html


http://www.centurylink.com/wholesale/clecs/lsog.html

4—Preparing and submitting service requests

Completing the Port Service (PS) form

To complete the Port Service form

User’s Guide—IMA 32.0

1 In the Order Information for New LSR/BRC window, select Port

Service under Form Name.

2 Click Edit Form.
Port Service E\
Administrative Section
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0
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NP TC OPT. TC TOPRI TCID
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I
OK Print Preview E-mail Pre0rder Recap Clear Reset Caneel

‘Java Applet Window

3 Do one of the following:

e If you're preparing an LSR for activities T, V, or Z, and if you've
retrieved a full CSR during the current session, you can fill in the fields
automatically. Continue with step 4.

< If you haven't retrieved a full CSR for the request you're preparing,
click PreOrder and do so now. (See page 20.) If only one number/
account appears when you retrieve the CSR and your search returns a
near match error, go back and enter the customer code so you get an
exact match.

e If you are going to fill in the fields manually, skip to step 8.
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4 Click Recap.

4—Preparing and submitting service requests
Completing the Port Service (PS) form

Telephone Number Recap Selection 3
Name and Address heing recapped:
Marng: Address
Telephone numbers for above address:
™ Usoc Features and Feature Details
1FR [EXK 303 274 -~
IRTMIN
NMC
OE3RT
|sLm JCSMN 00
v
< >
| Select Highiighted Ths || Select &1l T
‘Jave Applet Window

5 Do one of the following:
e Select the TN(s) you want to recap and click Select Highlighted TNs.
e Click Select All TNs.
6 For each selected TN, check each feature and revise it if necessary.

IMA creates a Service section for each TN you select and automatically fills
in the fields with the information in this window.

7 Do one of the following:
« If you need to add additional service sections, continue with step 8.
e If you've added all the information you need, skip to step 22.

(00]

Click the Service tab.

9 Click Add to activate a new section.
The counter updates to show the current number of repeating sections.

10 Enter the service information in the fields on the left and fill in the
Miscellaneous subtab. The following table shows guidelines for
CenturyLink-specific fields:

In this field ...

Do the following ...

TLI

Type the telephone line identifier (the pilot number of a
multiline hunt group)

MEGACENTNM

Type the name of the ISP for CenturyLink HSI/Broadband
Service

TC ID

Select the transfer of calls to identifier (the code for the
intercept message requested for a secondary telephone
number associated with intercept service)

TC NAME

Type the name associated with the number that calls will be
transferred to

11 If you need to add additional sections, repeat steps 9 and 10.
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Completing the Port Service (PS) form

12 Click the Features subtab.

Administrative Section
PON VER AR (RNN-X93-9999-995) PQTY: ORD!
\ | I [0 ||

| Service | Remarks
Oof0

Addd

S
uJ

LOCHUM:  LNUM:

O
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Yy TC | CFA
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3
J
FAl

[ — |

FEATURE:

FEATURE DETAIL.

OK ” Print Preview ][ E-mail ]

Pre0rder “ Recap ]

[ Clear ” Reset ” Cancel ]

Java Applet Window

13 Click Add to activate a new section.

User’s Guide—IMA 32.0

14 Enter the features information in the fields. (If you filled in the TNS field,
click Get Feature List to get a list of features you can use for the number

you entered.)

15 If you need to add additional features, repeat steps 13 and 14.
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Completing the Port Service (PS) form

16 Click the Secondary TC subtab.

Administrative Section
PON VER AN (NIN-X99-3999-999) PGTY:  ORD
\ | I | [ |
| Service | Remarks
noro
A
5
-
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¢ oot
L
(I
\
d
™S
[EE = =
.- ]
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[ e
FIC LFIC |
[ [ =
" &=
| E—
ok [ printFreview || E-mail Freorer || Recap [ ciear |[ Reset | cancel |
Jva Applel Window

17 Click Add to activate a new section.

18 Enter the secondary transfer of calls information in the fields. (In the NIDR
field, select Y if you’re requesting a new network interface device.)

19 If you need to add additional sections, repeat steps 17 and 18.
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20 Click the CFA subtab.

Port Service @

Administrative Section
PON VER AN (NNN-G9-0909-990) PQTY: ORD:
- 0
Service | Remarks
0af0
Add
LOGHNUM:  LNUM: i Features yTC| CFA
SGNL: SSIG: BA,
LMA & &
J PULSE: BLOCK:
J ~
LS LsCF:
2o = v
OTH:
FIC LPIC:
CFA;
NP J
0K || PrintPreview || E-mail PreOrder || Recap Clear | Reset || cancel
‘JaveADD\elW\nduw

21 Enter the CFA information in the fields.

22 If you need to add additional information relevant to the form, click the
Remarks subtab and do the following:

In this field ... Do the following ...
Remarks Add any additional information relevant to the form
Manual Ind If CenturyLink requires information that you couldn’t

provide on the form, select Y so that the request will be
processed manually

23 To go on to other forms, click OK.

If you receive an error message when closing the form, see “Correcting
errors when you close a form” on page 71.
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Completing the Resale (RS) form

Completing the Resale (RS) form

April 2, 2012

When you order CenturyLink HSI/Broadband Service, be sure you check to see
that the customer's loop qualifies (see the Loop Qualification and Raw Loop
Data CLEC Job Aid). If you are ordering CenturyLink HSI/Broadband Service
for a new connection, first order the new service, then check to see whether
the loop qualifies. If the loop qualifies, then order CenturyLink HSI/Broadband
Service. (See page 54.)

You can migrate UNE-P POTS customers and their current feature sets by
specifying the end state of the account. This means that you can specify which
USOCs and FIDs should appear on the account after conversion, rather than
listing the changes to each USOC on the existing CSR. In addition, you can
convert UNE-P products (excluding UNE-P Centrex) by submitting the account
telephone number and customer code or SANO.

For definitive guidelines on filling out this form, see the Resale form
preparation guide at http://www.centurylink.com/wholesale/clecs/Isog.html.
You can also double-click the field name to get help filling in that field.

While you’re working on the Resale form, you can do related tasks by clicking
PreOrder (at the bottom of the window) and selecting the task. Follow the
appropriate guidelines:

e “Retrieving a full CSR” on page 20
e “Checking whether POTS facilities are available” on page 36
e “Checking ISDN facility availability” on page 42

e “Checking whether a loop qualifies for CenturyLink HSI/Broadband Service
or unbundled ADSL service” on page 54

e “Checking whether services are available” on page 31
e “Managing appointments” on page 59
e “Reserving telephone numbers” on page 54

e “Retrieving raw loop data” on page 53
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Completing the Resale (RS) form
To complete the Resale form

1 In the Order Information for New LSR/BRC window, select Resale
Form under Form Name.

2 Click Edit Form.

Resale Form @
Administrative Section
PON VER AN (NNN-X89-3983-080) REQTY:
- 0
Sarvice) Remarts
Qoro
Add
LNUM: Miscell Features| S dary TC| Inside Wire
TERS: LI TSP PRIBD:
LA,
I AR PILI
1111
THE: ECCKT: (N=h= AAAANNN=nni=. AR) PTKCON
QTN DI
FIC: LPIC: B
NP MEGACENTHNM
TG OPT: TCTO PRI TCID:
TC NAME: TC PER
it
oK || PrintPreview || E-mail Prerder || Recap Clear | Reset || cancel
[ 15+ Aopiet Window

3 Do one of the following:

e If you're preparing an LSR for activities T, V, or Z, and if you've
retrieved a full CSR during the current session, you can fill in the fields
automatically. Continue with step 4.

< If you haven't retrieved a full CSR for the request you're preparing,
click PreOrder and do so now. (See page 20.) If only one number/
account appears when you retrieve the CSR and your search returns a
near match error, go back and enter the customer code so you get an
exact match.

e If you are going to fill in the fields manually, skip to step 8.
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Click Recap.

Name and Address heing recapped:

4—Preparing and submitting service requests
Completing the Resale (RS) form

Telephane Number Recap Selection 3]

Mame: Address

Telephone numbers for above address:

Usoc
1FR

™

Features and Feature Details
/EXK 303 274

[RTMMN

MNMC

OE3RT

|sLm

fCSM 00

<

| Select Highiighted Ths || Select &1l T

~

>

Cancel

[1va AceletWindow

Do one of the following:

Click Select All TNs.

Select the TN(s) you want to recap and click Select Highlighted TNs.

For each selected TN, check each feature and revise it if necessary.

IMA creates a Service section for each TN you select and automatically fills
in the fields with the information in this window.

Do one of the following:

If you've added all the
Click the Service tab.

The counter updates to sh

If you need to add additional service sections, continue with step 8.

information you need, skip to step 23.

Click Add to activate a new service section.

ow the current number of repeating sections.

10 Fill in the service information fields on the left and fill in the
Miscellaneous subtab. The following table shows guidelines for

CenturyLink-specific fields

In this field ... Do the following ...

TLI Type the telephone line identifier (the pilot number of a
multi-line hunt group)

PTLI Type the PBX lead telephone line (the lead telephone line
identifier assigned to the trunk group)

PTKCON Select the PBX trunk configuration (the directional
configuration of the PBX trunk being ordered)

MEGACENTNM Type the name of the ISP for CenturyLink HSI/Broadband
Service

TC ID Select the transfer of calls to identifier (the code for the
intercept message requested for a primary telephone
number associated with intercept service)

TC NAME Type the name associated with the number that calls will be
transferred to
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11 Do one of the following:

and continue with step 12.

Resale Form

User’s Guide—IMA 32.0

If you need to add features to your request, click the Features subtab

If you do not need to add features to your request, skip to step 15.

Administrative Section
PON WER AN (NNN-93-3358-399) REOTY:
0
Service | Remarks
Oof0
Add
LNUM: Features ¥ TC| Inside Wire
RPA-NAGC
LNA;
J Oaf0
ThS:
OTH: J
- FA:
PIC: LPIC: J
FEATURE:
NP J
J FEATURE DETAIL:
~
v
< b
Feature Detail Format Guids
JCFND nnn nnn-nnm ~
JMEE menooo: HEIERP . 000
JMES Fee MESGRE
US55 Txkx MSSERP.XKXK
/RCYC n
/$H1 rmn nom-nonn
/$H] rmn nam-nonn nn
/8H] rmn nom-nonn nnn
/U0 nmm nnn-mmon
-
OK Print Preview E-mail Predrder Recap Clear Reset Cancel
‘JavaApp\elW\ndnw

12 Click Add to activate a new section.

13 Fill in the features information. (If you filled in the TNS field, click Get
Feature List to get a list of features you can use for the number you

entered.)

For POTS Resale and UNE-P POTS, follow the formatting guidelines on the
tab. For all other products, see CenturyLink’s USOC and FID Finder at
http://usocfidfind.centurylinkapps.com/ or the Product Catalog Features at
http://www.centurylink.com/wholesale/clecs/features/.

Note: If you type a TN in the FEATURE DETAIL field, you must type
10 digits. (If you are typing a TN in the Eastern region, you may

enter only 7 digits.)

Important: For UNE-P products, the only valid USOCs are PORNX,

PORPX, and PORXX.

14 If you need to add additional features, repeat steps 12—13.
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Completing the Resale (RS) form

15 Click the Secondary TC subtab.

16 Click Add to activate a new section.

Resale Form @
Administrative Section
PON WER AN (NNN-X99-0999-998) REGTY:
0
Service | Remarks
0af0
Add
LNUM: i Features Yy TC | Inside Wire
Qofd
LMA
TS -
B TC TO SEC TCID:
OTH: - J
TC NAME
FIC LPIC:
NPI NIDR:
0K || PrintPreview || E-mail PreOrder Recap Clear Reset || GCancel
[ 15+ Aopiet Window

17 Enter the secondary transfer of calls information on the tab. The following
table shows guidelines for CenturyLink-specific fields.

In this field ... Do the following ...

TC ID Select the transfer of calls to identifier (the code for the
intercept message requested for a secondary telephone
number associated with intercept service)

TC NAME Type the name associated with the number that calls will be
transferred to

18 If you need to add additional subsections, repeat steps 16 and 17.
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Completing the Resale (RS) form

19 Do one of the following:

If you need to specify block or inside wire information for your request,
click the Inside Wire subtab and continue with step 20.

If you do not need to specify block or inside wire information for your
request, skip to step 23.

Resale Form 3
Administrative Section
PON YER AN (NNN-X99-9998-288) RSQTY:
0
Service | Remarks
00f0
Add
LNUM: Features y TC | Inside Wire
0ofD
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TS .
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PIC LPIC: = ] ]
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NP =] =
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QK Print Preview E-mail Preorder Recap Clear Reset Cancel
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20 Click Add to activate a new section.
21 Enter the inside wire information in the fields.
22 If you need to add additional sections, repeat steps 20 and 21.

23 If you need to add additional information relevant to this form, click the
Remarks subtab and do the following:

In this field ... Do the following ...

Remarks Enter any additional information that is relevant to this

form

Manual Ind If CenturyLink requires information that you couldn’t

provide on the form, select Y so that the request will be
processed manually
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24 To go on to other forms, click OK.

If you receive an error message when closing the form, see “Correcting
errors when you close a form” on page 71.

Completing the Resale Frame Relay (RFR)
form

For definitive guidelines on filling out this form, see the Resale Frame Relay
form preparation guide at http://www.centurylink.com/wholesale/clecs/
Isog.html. You can also double-click the field name to get help filling in that
field.

While you’re working on the Resale Frame Relay form, you can do related
tasks by clicking PreOrder and selecting the task. Follow these guidelines:

e “Checking whether facilities are available for designed services or digital
services” on page 34

To complete the Resale Frame Relay form

1 In the Order Information for New LSR/BRC window, select Resale
Frame Relay under Form Name.

2 Click Edit Form.

Resale Frame Relay @
Administrative Section
FON VER AN (NNM-X88-3335-538)
'UNI Circuit] virtual & Related Circuit Detail| Remarks
CKR: ECCKT. (N=n=A%AANMNK<nnn=. A%)
I IWJQ:  CFA
MY, PSPEED: LhiP
o
OK Print Preview E-mail PreCrder Clear Reset Cancel
‘Java Applet Window

3 Click the UNI Circuit tab.

4 Enter the UNI circuit information in the fields.
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Completing the Resale Private Line (RPL) form

5 Click the Virtual & Related Circuit Detail tab.

Resale Frame Relay 3
Administrative Section
PON VER AN (NNN-X89-9998-998)
UNI Circuit| Virtual & Related Circult Detail] Remarks
00f0
Add
VirtualCircuit | RelatedCircuit
LNEX ~ VYCACT: DLl CIR: Be Be:
oK || PrintPreview || E-mail PreOrder clear | Reset | cancel

[ l

[1va AceletWindow

Click Add to activate a new repeating section.
Fill in the Virtual Circuit and Related Circuit information.

If you need to add additional circuit detail, repeat steps 6—7.

© 00 N O

If you need to add additional information relevant to this form, click the
Remarks tab and do the following:

In this field ... Do the following ...
Remarks Add any additional information that is relevant to this form
Manual Ind If CenturyLink requires information that you couldn’t

provide on the form, select Y so that the request will be
processed manually

10 To go on to other forms, click OK.

If you receive an error message when closing the form, see “Correcting
errors when you close a form” on page 71.

Completing the Resale Private Line (RPL)
form

For definitive guidelines on filling out this form, see the Resale Private Line
form preparation guide at http://www.centurylink.com/wholesale/clecs/
Isog.html. You can also double-click the field name to get help filling in that
field.

1 In the Order Information for New LSR/BRC window, select Resale
Private Line under Form Name.
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2 Click Edit Form.

Resale Private Line

4—Preparing and submitting service requests
Completing the Resale Private Line (RPL) form

Administrative Section
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1 v -
Primary Lo¢ | Secondary Loc | Billing | Remarks | Primary Service | Secondary Service
L PRILOC NAME
v
AAl RLSO:
~
-
& 2
NGO,
-
Walidated Addresses:
Mo Validated Address .
AFT: SAPR: SANO SASF
-
SASD SASH SATH: SASS:
~ v
LD1 L1 Loz Lz LD3: Lv3 AHM: ROUTE: BOX
v ~ ~
CITY STATE:  ZIF:
v
CALAISAGA;
~
ALOC LCON ACTELNO
-~
-
< »
ALCON AACTEL NO! IW0:
v
ACC
~
~
& %
ok || FrintPreview || E-mail Clear || Reset || cancel
[ 15+ Aoglet Window

The Administrative Section identifies the LSR you are processing.

3 Select the resale quantity (RSQTY) and disconnect quantity (DQTY) from

the lists.
4 Click the Primary Loc tab.

5 Verify all the information on the Primary Loc tab.

If you validated the address ...

If you couldn’t validate the address

a In the Validated Addresses list,
select the address for your customer.
IMA automatically fills in the address
information.

a If you couldn’t validate the address—or if
you got a SAG Only match—and this is a
new installation or account, indicate in the
NCON field whether this is a new service
address (A) or a new location within an
existing service address (B).

b Fill in the SANO, SASN, CITY, STATE, and
CALA/SAGA fields, following the guidelines
in “Validating addresses” on page 10.

6 Do one of the following:

< If you need to add additional locations, continue with steps 7-9.
- If you have only one location, skip to step 10.
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7 Click the Secondary Loc tab.
Resale Private Line 3
Administrative Section
PON WER AN (NNMN-X99-9999-998) RSQTY: DATY:
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8 Click Add to activate a new section.
The counter updates to show the current number of repeating sections.
9 Enter the location information in the fields.
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If you validated the address ...

If you couldn’t validate the
address ...

In the Validated Addresses list, select the
address for your customer.

IMA automatically fills in the address
information.

Fill in the SANO, SASN, CITY, STATE, and
CALA/SAGA fields, following the guidelines
in “Validating addresses” on page 10.
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10 Click the Billing tab.

4—Preparing and submitting service requests
Completing the Resale Private Line (RPL) form

Resale Private Line E‘
Administrative Section
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11 If you are converting an entire account and if your customer wants their

final bill to be sent to an address different from their current billing
address, select D—Different in the FBI list and fill in at least the BILLNM,
SANO, SASN, CITY, STATE, and ZIP fields.

12 If you have any additional information relevant to this form, click the

Remarks tab and do the following:

In this field ...

Do the following ...

Disc ECCKT

Verify the ECCKT to be disconnected

Remarks

Add any additional information that is relevant to this form

Manual Ind

If CenturyLink requires information that you couldn’t
provide on the form, select Y so that the request will be

processed manually

13 Click the Primary Service tab.

Resale Private Line

Administrative Section
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14 Fill in the active fields.
15 Click Add to activate a repeating section.

April 2, 2012
http://www.centurylink.com/wholesale/cmp/review_archivesystem.html

137



4—Preparing and submitting service requests User’s Guide—IMA 32.0
Completing the Resale Split (RSS) form

16 Enter the inside wire information in the fields.

17 If you need to add additional inside wire information, repeat steps 15 and
16.

18 Do one of the following:
e If you need to add additional services, continue with steps 19-22.
- If you have only one location, skip to step 23.

19 Click the Secondary Service tab.

Resale Private Line %
Administrative Section
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20 Click Add to activate a repeating section.

The counter updates to show the current number of repeating sections.
21 Fill in the secondary service information.
22 Enter the inside wire information in the fields.

23 To go on to other forms, click OK.

If you receive an error message when closing the form, see “Correcting
errors when you close a form” on page 71.

Completing the Resale Split (RSS) form

For definitive guidelines on filling out this form, see the Resale Services Split
Form Preparation Guide at http://www.centurylink.com/wholesale/clecs/
Isog.html. You can also double-click the field name to get help filling in that
field.

While you’re working on the Resale Split form, you can do related tasks by
clicking PreOrder (at the bottom of the window) and selecting the task. Follow
the appropriate guidelines:

e “Retrieving a full CSR” on page 20

e “Scheduling appointments” on page 59
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4—Preparing and submitting service requests
Completing the Resale Split (RSS) form

e “Reserving telephone numbers” on page 54

e “Checking whether services are available” on page 31

e “Checking whether POTS facilities are available” on page 36

e “Checking ISDN facility availability” on page 42

e “Retrieving raw loop data” on page 53

e “Checking whether a loop qualifies for CenturyLink HSI/Broadband Service
or unbundled ADSL service” on page 54

e “Searching for available meet points” on page 46

To complete the Resale Split form

1 In the Order Information for New LSR/BRC window, select Resale
Split Form under Form Name.
2 Click Edit Form.
Resale Split Form E\
Administrative Section
PON VER AR (RNN-X93-9999-995) RSGQTY:
0
Service | Remarks
0of0
Addd
J
LHNUM: Features yTC Inside Wire Cable Connections
TERS: LI TSP
LMA:
J ECCKT: (M= AAAA NNMN=nnn=_ A% PTLI
THE: SAN PTKCON
: =
QT POTSSPLITLOC!
= =l
PIC LPIC: POTSSPLIT:
|
NPl MEGACENTNM
=]
TC OPT. TCTOPRI TCID
=1 I |
TC MNAME: TC PER:
1N
QK Print Preview E-mail Prerder Recap Clear Resst Cancel
[ )
‘JavaApp\elW\ndnw

3 Do one of the following:

« If you're preparing a request for activities T, V, or Z, and if you've
retrieved a full CSR during the current session, you can fill in the fields
automatically. Continue with step 4.
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10

< If you haven't retrieved a full CSR for the request you're preparing,
click PreOrder and do so now. (See page 20.) If only one number/
account appears when you retrieve the CSR and your search returns a
near match error, go back and enter the customer code so you get an
exact match.

e Otherwise, skip to step 8 and fill in the fields manually.

Telephone Number Recap Selection @
Name and Address being recapped:
Name: Address
Telephone numbers for above address:
™ usoc Features and Feature Details
1FR /EXK 303 274 A
JRTHN
MM
OE3R1
|aLm ==Y
~
< >
| Select Highiighted Tis || Selectal THs |
‘Java Applet Window

Do one of the following:

e Select the TNs you want to recap and click Select Highlighted TNs.
e Click Select All TNs.

For each selected TN, check each feature and revise it if necessary.

IMA creates a Service section for each TN you select and automatically fills
in the fields with the information in this window.

Do one of the following:

< If you need to add additional service sections, continue with step 8.
« If you've added all the information you need, skip to step 28.

Click the Service tab.

Click Add to activate a new section.

The counter updates to show the current number of repeating sections.

Fill in the service information fields on the left and fill in the
Miscellaneous subtab. The following table shows guidelines for
CenturyLink-specific fields.

In this field ... Do the following ...

TLI Type the telephone line identifier (the pilot number of a
multiline hunt group)

PTLI Type the PBX lead telephone line (the lead telephone line
identifier assigned to the trunk group)

PTKCON Select the directional configuration of the PBX trunk

POTSSPLIT Specify the location of the cable connection points for POTS

splitters outside your company’s cage. You can type in the
location or select it from the list if you retrieved meet point
data (See page 46.)

POTSSPLITLOC Specify the location of the POTS splitter
MEGACENTNM Type the name of the ISP for CenturyLink HSI/Broadband
Service
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In this field ...

Do the following ...

TCID

Select the transfer of calls to identifier (the code for the
intercept message requested for a primary telephone
number associated with intercept service)

TC NAME

Type the name associated with the number that calls will be
transferred to

11 Click the Features subtab.

Resale Split Form 3
Administrative Section
PON VER AN (NNN-X99-9999-998) RSQTY:
0
Service | Remarks
Qofd
Add
LNUM: Features y TC | Inside Wire | Cable Connections
- Dofo
LA
THS:
Fa
OTH B
FEATURE:
PIC: LPIC:
FEATURE DETAIL
~
NP
v
< >
QK Print Preview E-mail PreQrder Recap Clear Reset Cancel
‘Java Applet Window

12 Click Add to activate a new section.

13 Fill in the features information.

14 If you need to add additional features, repeat steps 12—13.
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15 Click the Secondary TC subtab.

Resale Split Form

)
Administrative Section
PON VER AN (NNN-X39-9999-939) RSQTY.
\ | I | [
Service | Remarks
Dof0
Add
=
J
LNUM: i Features ¥ TC | Inside Wire | Cable Connections
. - oern
LIA:
[—
I
ThS:
- TC TO SEC: TC ID:
OTH! - =]
] TC NAWE
PIC: LPIC: [
NP MNIDR:
\ 2]
0K ” Print Preview ][ E-mail ] PreQrder “ Recap ] [ Clear ” Reset ” Cancel ]
Java Applet Window

16 Click Add to activate a new section.

17 Fill in the secondary transfer of calls information.

User’s Guide—IMA 32.0

18 If you need to add additional sections, repeat steps 16—17.
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19 Click the Inside Wire subtab.

4—Preparing and submitting service requests

Completing the Resale Split (RSS) form

Resale Split Form 3
Administrative Section
PON VER AN (NMNM-X93-0935-035) REQTY:
| [ | [
Sirvice) remarss
000
Add Delete Current Clear Current Delete All
=
U
LNUM: | Features | s dary TC | Inside Wire | cable Connections
e - aor0
Lua
: Add Delete Current Clear Currant
T List -
TS -
| e [ e [
OTN
T Lacr — o
PIC LPIC:
- = Al -
BBIG BLOCK:
4 [I— A
— ] | ] e :
[ &= v
ok [ printFreview || E-mail Freomer || Recap [ ciear |[ Reset | cancer |
Java Apple Windaus

20 Click Add to activate a new section.

21 Fill in the inside wire information.
22 If you need to add additional inside wire sections, repeat steps 20-21.
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23 Click the Cable Connections subtab.

Resale Split Form E‘
Administrative Section
PON VER AR (hNN-X90-9999-093) RSQTY
- 0
Service | Remarks
00f0
Add
LNUM: Features ¥y TC | Inside Wire Cable Connections
r 0of0
LNa:
THS:
CABCONNTYP:
CABCONM
OTH -]
PIC LPIG:
NP
ok || printPreiew ]| E-mal PreOrder || Recap Clear || Resst || cancel
‘JavaApp\elW\ndnw

24 Click Add to activate a new section.

25 Fill in the cable connection information.

In this field ...

Do the following ...

CABCONNTYP

Select the cable connection type

CABCONN

Specify the location of the cable connection points for POTS
splitters inside your company’s cage. You can type in the
location or select it from the list if you retrieved meet point
data (See page 46.)

26 If you need to add additional cable connections, repeat steps 24—25.

27 If you need to add additional service sections, repeat steps 9—26.

28 If you have any additional information relevant to this form, click the
Remarks subtab and do the following:

In this field ...

Do the following ...

Remarks

Add any additional information that is relevant to this form

Manual Ind

If CenturyLink requires information that you couldn’t
provide on the form, select Y so that the request will be
processed manually.
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29 To go on to other forms, click OK.

If you receive an error message when closing the form, see “Correcting
errors when you close a form” on page 71.

Completing a request for Simple Port

For definitive guidelines on filling out this form, see the Number Portability
(NP) Request Form Preparation Guide at http://www.centurylink.com/

wholesale/clecs/Isog.html. You can also double-click the field name to get help
filling in that field.

To complete a request for Simple Port:

1 In the Order Information for New LSR/BRC window, select C - Local

Number Portability in the REQTYP list. Then select Number Portability
under Form Name.

Order Information for New LSR / BRC ®
PON; Simple Part Test VER: |:|
REQTYP: |G - Local Number Fortability =l |e-Firm order =]

Activity:  |7- Conversion 3 specified /no DL =

|1 - Business

i

Farm Name Required Include

al Senvice Reguest

End User
Murmiber Portability

<

Edit Form Clear All Forms

Print Preview || E-mail [ save [ submit |

1€

[ clear ][ Reset || cose

Java Applet Window

2 Click Edit Form.

Administrative Section

®

>

PON VER AN (NINN-X99-3999-050) NPGTY
imple Port Test [ - |lu
Service | Remarks

0or0

LMNURM; LHa: TOT: PORTED NBR: RAMNGE!

e i o | o
NPT: RTI NPTG BA
[Dise. TH &t port outtime =] | I I

BLOCK: FPI

LPIC: TCOPT. TCTOPRI TCID

[ = Il K - - | [5=]
A~ Mo collect and 3rd party|
B - Mo 3 party
© - No colleet call

TC MNAME TCPER:

[

r 0of0- Secondary Transfer of Calls

I

TC TO SEC, TCID: T HAME:
= =] | v

| >
ok | printPreview | E-man_| [ ciear ][ Reser ][ cance

Java Applet Window
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3 Fill in the fields on the form.

4 When you're done, click OK.

If you receive an error message when closing the form, see “Correcting
errors when you close a form” on page 71.
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After submitting service requests

As CenturyLink processes a service request (an individual LSR or BRC bulk
request) that you’'ve submitted, IMA faxes and/or e-mails notices to you at
stages in the processing that may require action on your part. In addition, at
any time, you can check the status of the service request and its service
orders.

You can

view the notices associated with a service request (page 148)

You view notices to see any of the notices associated with a specific service
request. You can view any notices that are routinely sent to you. You can
view error messages only if your system administrator has not canceled
them and BCN and PSON notices only if your system administrator has
requested them.

monitor the current status (“status update”) of all service requests or
service orders that have certain characteristics (you specify those
characteristics) (page 151)

You monitor the status of LSRs or service orders to view continually
updated statuses for them in a separate browser window.

check the status history of a specific LSR and its associated service orders
(“LSR service inquiry”)(page 155)

You check the status history to get a complete history of the status of the
LSR and its service orders.

check the estimated start time for a service order (page 160)

After submitting a service request, you can also

April 2, 2012

resubmit a service request that has been rejected (page 163)

prepare a supplemental LSR (page 164)

You prepare a supplemental LSR to cancel, reschedule, or otherwise modify
an LSR that IMA has accepted.

review the LSR/BRC queue (page 159)

You review the LSR/BRC queue to view service requests that were
submitted outside IMA business hours.
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« review design layout records (DLRs) (page 168)

You review DLRs to get technical information—usually, for your design
services engineers—on the facilities and terminations that CenturyLink
provides for a circuit. (Be sure to request the DLR when you prepare the

LSR form.)

Viewing notices for a service request

You can view the notices associated with a specific LSR or BRC, such as
Completion notices and Confirmation notices. You can view all notices that are
routinely sent to you. You can view Error notices if your system administrator
has not canceled them, and you can view Billing Completion and Pending
Service Order notices if your system administrator has requested them.

Type of notice

Meaning

What you need to do

BCN (Billing
Completion
notice)—if your
system
administrator has
requested BCNs

CenturyLink has finished
processing all service orders for
the LSR and has posted them to
be billed.

Nothing except possibly to confirm
that the AN shows the most recent
BTN or SBN including the
customer code.

processing all service orders for
the LSR.

Bulk CenturylLink has received your Nothing, except possibly to
request for a bulk disconnection, confirm that the notice accurately
suspension, or PIC/LPIC change identifies the individual LSRs for
and created the individual LSRs. your request.

Completion CenturyLink has finished Nothing except possibly to confirm

that the Completion notice
matches your request.

Confirmation

IMA has issued an FOC because
CenturylLink has created the
service orders for the LSR and
assigned a due date. (You can
view the five most recent
Confirmation notices for this LSR.)

Nothing

Error

(if your system
administrator has
not canceled Error
notices)

IMA has found one or more
nonfatal errors in the LSR, but
CenturyLink may be able to
correct the error(s) without your
assistance. (FOC not yet sent)

Monitor the status of the LSR. If
the CenturylLink service center
requests additional information to
correct the error(s), submit a
supplemental LSR to correct the
errors (or cancel the original LSR)
within 4 IMA business hours.
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Type of notice

Meaning

What you need to do

Jeopardy

One or more service orders for the
LSR are in jeopardy during
provisioning.

Use the jeopardy codes in the
notice to determine the cause of
the jeopardy. (Click on Jeopardy
Data under the heading Jeopardy
Resolution Responsibilities at
http://www.centurylink.com/
wholesale/clecs/
provisioning.html.)

If the jeopardy code is CO5 or SX,
submit a supplemental LSR to
correct the errors (or cancel the
original LSR) within 4 IMA
business hours. If the jeopardy
code is for a customer not ready
(CNR) reason, submit a
supplemental LSR to establish a
new DDD (desired due date) or
cancel the original LSR.

PSON (Pending
Service Order
notice)—if your
system
administrator has
requested PSONs

CenturyLink has created one or
more service orders for the LSR or
has generated the FOC during the
past hour.

Review the PSON. If you find
errors, submit a supplemental LSR
to correct them before the service
order is completed.

Reject

IMA has rejected the LSR because
of inaccurate or missing data
(fatal errors).

Use the Reject notice to correct
the errors, then resubmit the
original LSR—not a supplemental
LSR—with the appropriate
corrections (page 163).

For more information about LSR notices, see http://www.centurylink.com/
wholesale/clecs/ordering.html. Further information for specific notices is

available at http://www.centurylink.com/wholesale/clecs/Isog.html. Click one

of the following:

< Billing Completion Notice (BCN)

< Completion Notice

< Firm Order Confirmation-Manual (FOC)

= Pending Service Order Notice (PSON)

To view the notices for an LSR

1 In the Interconnect Functions window, select PreOrder/Order/

PostOrder.
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Viewing notices for a service request

2 In the Interconnect Mediated Access window, select PostOrder >
LSR/BRC Notice Inquiry.

LSR Notice Inquiry.

LSR Notices Query

Notice Type:  |COMPLETION v

Print Preview || E-mail || Startover | Nest == [ clear || Finish

|Java Applet Window

3 In the LSR ID field, type the LSR identification number.

4 In the Notice Type field, select the type of notice you want to review. (If
you want to view cancellation notices, select CONFIRMATION.)

5 Click Next.

IMA displays the type of notice you specified for the LSR. For information
about specific fields on the notices, click Local Response (LR) at

http://www.centurylink.com/wholesale/clecs/Isog.html.
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Monitoring the current status of service
requests and service orders

You can monitor the current status of service requests (individual LSRs or BRC
bulk requests) and/or service orders that have certain characteristics that you
specify. For example, you can monitor the status messages generated during
the past 24 hours for all LSRs that have Error or Jeopardy status. Or you can
monitor the status messages generated during the past 6 hours for all the
LSRs that you created. The statuses appear in a separate browser window and
are continually updated.

Status

Meaning

What you need to do

Bulk

CenturyLink has received your request
for a bulk disconnection, suspension,
or PIC/LPIC change and created the
individual LSRs.

Nothing, except possibly to confirm
that the status accurately identifies
the individual LSRs for your request.

Error

IMA has found one or more nonfatal
errors in the LSR and has sent you an
Error notice (if your system
administrator has requested error
notices). CenturyLink may be able to
correct the error(s) without your
assistance.

Continue to monitor the status. If the
CenturylLink service center requests
additional information to correct the
error(s), resubmit the corrected LSR
as a supplemental.

Hold

A service order for the LSR has been
placed on hold.

Continue to monitor the status.

Issued FOC

CenturyLink has issued an FOC
because it has generated one or more
service orders for the LSR and
assigned due dates. If CenturyLink has
issued more than one FOC, IMA shows
when each one was issued.

Nothing

Jeopardy
(LSR)

One or more service orders for the LSR
are in jeopardy during provisioning.

Use the jeopardy codes in the Status
Definition field (Click on Jeopardy
Data under the heading Jeopardy
Resolution Responsibilities at http://
www.centurylink.com/wholesale/clecs/

provisioning.html.) to determine the
cause of the jeopardy.
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Status Meaning What you need to do

Jeopardy The indicated service order is in Use the jeopardy codes in the Status

(Order) jeopardy of failing to meet the Definition field (Click on Jeopardy
assigned due date. Data under the heading Jeopardy

Resolution Responsibilities at http://
www.centurylink.com/wholesale/clecs/
provisioning.html.) to determine the
cause of the jeopardy.

« If the jeopardy is caused by non-
CenturyLink conditions, try to
resolve the conditions. If the
jeopardy causes the assigned due
date to be missed, send a
supplemental LSR with a new DDD.
Otherwise, continue to monitor the
status.

= |If the jeopardy is caused by
CenturyLink conditions, within 72
hours of receiving the initial
jeopardy notice, either an updated
jeopardy notification with more
specific details of the jeopardy
condition or a FOC advising of the
new due date will be sent to you. If
an updated jeopardy notice is sent,
we will also send a FOC advising
you of the due date CenturyLink can
meet when the RFS date is known.
Updated notification will be
provided within that 72 hour period.

See the matrix under the Jeopardy
Notice Timeline section of the
Provisioning and Installation
Overview (http://
www.centurylink.com/wholesale/
clecs/provisioning.html).

Order IMA has finished processing the Nothing

Completed indicated service order.

Physical CenturyLink has finished provisioning Nothing

Work the indicated service order.

Completed

Posted To The indicated service order has been Nothing except possibly to confirm
Be Billed posted to CenturyLink’s billing system. that the AN shows the most recent

BTN or SBN including the customer
code. If your system administrator has
requested BCNs, you have received—
or will soon receive—a BCN (billing
completion notice).

Rejected IMA has rejected the LSR because of Use the Reject notice to correct the
inaccurate or missing data (fatal errors, then resubmit the original
errors) and has sent you a Reject LSR—not a supplemental LSR—with
notice. the appropriate corrections. (See page

163.)

Request CenturyLink has finished processing all Nothing except possibly to confirm

Completed service orders for the LSR and has that the completion notice matches
sent you a completion notice. your request.
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To monitor current status

1 In the Interconnect Functions window, select PreOrder/Order/
PostOrder.

2 If you are monitoring status on behalf of another CLEC and if the menu bar
of the Interconnect Mediated Access window doesn’t already show the
corporate ID for that CLEC, continue with this step. Otherwise, skip to step

3.

a In the Interconnect Mediated Access window, click File > Select

Owner CCNA.

b From the list that appears, select the CLEC for which you are
monitoring status. Click Submit.

The CCNA for the other CLEC appears in the menu bar for the
Interconnect Mediated Access window.

3 In the Interconnect Mediated Access window, select PostOrder >

Status Updates.

Filters
Hours

User ID

Status Types
LSR Entered By

Statuses

¢
|

[v] LSR Statuses [_] Order Statuses

[i7 Gun [T EDI [ XML

[T Select All Statuses

Rejected

Error

Hold

Issued FOC
Jeopardy (LSR)
Jeopardy (Order)
Request Completed
Physical Work Completed
Order Completed
Posted To Be Billed
Bulk

X

’E Cancel ’gefT

[1v2 AcsletWindow

4 Specify the characteristics of the service requests or service orders you
want to monitor.

submitted by

= you—leave your user ID

« another user—type their user
ID

= all users—clear the field

To specify ... Do this ... In this field
The age of the status messages Type the maximum age (up to Hours

82 hours) of the status

messages you want to see.
Who created the LSRs To display the status of LSRs User ID

Whether you want to monitor Select LSR Statuses, Order Status Types
LSRs, service orders, or both Statuses, or both.

Whether you want to monitor Select GUI or XML, or any LSR Entered By
LSRs submitted via the GUI or combination of the two.

via XML
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To specify ... Do this ... In this field
The type of status you want to Check Select All Statuses or Statuses
monitor select one or more specific
statuses. To select more than
one status, hold down the CTRL
key and select the statuses you
want.
5 Click OK.
IMA opens a new browser window:
[V status Updates - U99. Q@El

TIME USER | PON WER AN LER 1D ooD LSR STATUS ORDER..| ORDE

ORDER STATUS ENTE.

| petais | | Ewer || Eman |

[E——

The window displays continually updated status information for the service
requests and service orders that have the characteristics you specified:

In this column ... IMA displays ...

TIME The time the status was assigned

USER ID User ID of the person who submitted the LSR or order
PON Purchase order number

VER Version number

AN Your customer’s account number

LSR ID ID number for the LSR

DDD Desired due date

LSR STATUS Status of the LSR

ORDERNUM Number of the service order

ORDER DUE Due date for the service order

ORDER STATUS Status of the service order

ENTERED BY Whether the LSR was submitted by GUI or XML

6 Do any of the following:

- If the window displays more status messages
click Filter and repeat steps 3 and 4. Narrow
the number of hours, users, kinds of statuses

than you want to see,
the search by reducing
(LSRs or service orders),

submittal methods, or specific statuses you monitor.
 To display a more detailed status message for one of the listed LSRs,

select that LSR and click Details.

e To e-mail the status information you just retri
the address you want to send the information

eved, click E-mail, type
to, and click Send.
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Checking the status of a specific LSR

< To continue with other tasks, click on the Interconnect Mediated
Access window.

Checking the status of a specific LSR

You can check the status of a specific LSR and its service orders.

To specify an LSR, you can specify either its PON or its ID. To specify a service
order, you first specify the LSR with which it is associated.

1

In the Interconnect Functions window, select PreOrder/Order/
PostOrder.

In the Interconnect Mediated Access window, select PostOrder > LSR
Status Inquiry.

Select the LSR whose status you want to check by doing either of the
following:

To select the LSR by its PON ... To select the LSR by its ID ...

a Click Select by CCNA/PON. a Click Select by LSR ID.

b Click Next and follow the guidelines b Click Next and go to “Selecting the LSR
directly below. by its ID” on page 157.

Selecting the LSR by its CCNA/PON
If you clicked Select by CCNA/PON, the following window appears:

LSR Status Inguiny @

April 2, 2012

CCHNA ! PON Query

CCHA cc

PON: YER:

Order Mumber

’ Frint Preview ” E-mail ” Start Over ” == Previous ” Mext == ’ Clear ” Finish ]

|

|Java Applet Window

The window shows the CCNA for your company. If your company is a payphone
service provider, the CCNA field shows PSP.

Fill in the blank fields, using these guidelines:

1
2

If you know your company code, type it in the CC field.

In the PON field, type the purchase order number for the LSR.

If the PON contains letters, be sure to use the same upper and lower cases
that were used when the LSR was first submitted.

If the PON has a version number, type it in the VER field.

If you don’t enter the version number, IMA provides the status of the most
recent version of the LSR with that PON.
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If you want the status of a specific service order, type the number of that
service order in the Order Number field.

If you don’t know the number for the service order, you can find it in the
next window, so you’ll have it for future reference.

Click Next.

In the window that appears, the fields indicate the LSR you specified:

In this field ...

IMA displays ...

PON

The purchase order number for the LSR

LSR Desired Due
Date

The completion date your company requested

LSR Due Date

The assigned completion date

LSR Completion Date

The date CenturyLink finished processing all service orders for
the LSR

The columns show the current status of the LSR you specified and its
associated service orders:

In this column ...

IMA displays ...

Whether the status is for an LSR or a service order

Type

LSR ID The identification number for the LSR

Order# The identification number for the service order
Status The status of the LSR or service order

Status Definition

An explanation of the status

6 When you are finished viewing the status history, do any of the following:
« To display the status history in a separate browser window, click Print

156

Preview.

« To e-mail the status history, click E-mail.
« To display the status history for another LSR, click Start Over.

< To go on to other tasks, click Finish.
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Selecting the LSR by its ID
If you clicked Select by LSR 1D, the following window appears:

LSR Status Inguiny @

LSR ID Query

CCHA cc

LSRID

Order Mumber

’ Frint Preview ” E-mail ” Start Over ” == Previous ” Mext ==

[ clear | Finish |

|

|Java Applet Window

The window shows the CCNA for your company. If your company is a payphone
service provider, the CCNA field shows PSP.

Fill in the blank fields, using these guidelines:

1 If you know your company code, type it in the CC field.

2 In the LSR ID field, type the identification number for the LSR.

3 If you want the status of a specific service order, type the number of that
service order in the Order Number field.
If you don’t know the number for the service order, you can find it in the
next window, so you’ll have it for future reference.

4 Click Next.

April 2, 2012

In the window that appears, the fields indicate the LSR you specified:

In this field ...

IMA displays ...

PON

The purchase order number for the LSR

LSR Desired Due
Date

The completion date your company requested

LSR Due Date

The assigned completion date

LSR Completion Date

The date CenturylLink finished processing all service orders for
the LSR

The columns show the current status of the LSR you specified and its
associated service orders:

In this column ...

IMA displays ...

Type Whether the status is for an LSR or a service order
LSR ID The LSR ID you entered

Order# The identification number for the service order
Status The status of the LSR or service order

Status Definition

An explanation of the status
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5 When you are finished viewing the status, do any of the following:

To display the status in a separate browser window, click Print
Preview.

To e-mail the status, click E-mail.
To display the status for another LSR, click Start Over.
To go on to other tasks, click Finish.

April 2, 2012
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Reviewing the LSR/BRC queue

You review the LSR/BRC queue so you can correct errors in individual LSRs

that were submitted after IMA business hours and that could not be processed
when IMA reopened for business. You can view these errors, correct them, and
resubmit the LSR. If you don’t resubmit the LSR, it is removed from the queue

after 1-30 days (your system

administrator sets the interval). You can review

and remove BRCs from the queue, but normally they are processed when IMA

reopens.
1 In the Interconnect Functions window, click PreOrder/Order/
PostOrder.
2 In the Interconnect Mediated Access window, select Order > LSR/
BRC Queue.
CCNA cc User|D
Queued LSR's
PON VER LSRID UsgerID Queue Status Queye Date Purge Date Rernove From List
< 3 .
View Error Messages
< > =
‘JaveADD\elW\nduw
3 In the User ID field at the top of the window, do one of the following:

company, type thei

to display queued LSRs that you created, leave your user ID
to display queued LSRs created by some other user in your

r user ID

to display all queued LSRs, clear the field

The window displays the LSRs in the queue. The following table defines

CenturyLink-specific fields

In this column ... IMA displays ...
LSRID The ID number CenturyLink assigned to the LSR
User ID The username of the user who created the original LSR

Queue Status

The status of the LSR in the queue

Queue Date

The date the LSR was submitted

Purge Date

The date an LSR will be removed from the queue if it hasn’t
been processed (established by the purge interval set by
your system administrator)

April 2, 2012
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In this column ... IMA displays ...

Remove From List = Blank if the LSR has not yet been processed (so that the

LSR remains in the queue).
= Yes if the LSR is being or has been processed (so that
the LSR can be removed from the queue).

4 Do any of the following:

To display the errors in an LSR in the queue, select the LSR and click
Display Errors.

To open an LSR in the queue, select the LSR and click Open
Highlighted.

To switch between listing all queued LSRs for your company (CCNA)
and all queued LSRs for a specific user, click Toggle User ID/CCNA
Query.

To keep an LSR in the queue if there’s a Yes in the Remove From List
column, click Undo Remove.

(IMA may put Yes in the column if you open the LSR, even if you don’t
correct its errors.)

To display the information in a separate browser window, click Print
Preview.

To e-mail the information in the window, click E-mail.

To close the window and remove all LSRs with Yes in the Remove
From List column, click Close.

Checking the estimated start time for a
service order

160

You can view the estimated start time for services orders on the day they are

due.

1 In the Interconnect Functions window, click PreOrder/Order/
PostOrder.

2 In the Interconnect Mediated Access window, select PostOrder >
Estimated Start Time.

Estimated Start Time Inquiry E]
Select Query Type

® Eelecthy CONAPON

© Selectby LSR NO

| Prntpreview ][ E-mail | stan over Nest x> [ ctear ][ Finisn_|

[

[E——

3 Select the LSR by doing either of the following:

To select the LSR by its PON ... To select the LSR by its ID ...
a Click Select by CCNA/PON. a Click Select by LSR NO.
b Click Next and follow the guidelines b Click Next and go to “Selecting the LSR
directly below. by its ID” on page 162.
April 2, 2012
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Selecting the LSR by its CCNA/PON
If you clicked Select by CCNA/PON, the following window appears:

Estimated Start Time Inquiry.

CCHNA ! PON Query

X

CCHA | 1Jgg

PON: YER:

STATE: ]

Order Mumber

’ Frint Preview ” E-mail ” Start Over ” == Previous ” Mext ==

[ clear | Finish |

|

|Java Applet Window

The window shows the CCNA for your company. If your company is a payphone
service provider, the CCNA field shows PSP.

Fill in the blank fields, using these guidelines:

1

April 2, 2012

In the PON field, type the purchase order number for the LSR.

If the PON contains letters, be sure to use the same upper and lower cases
that were used when the LSR was first submitted.

If the PON has a version number, type it in the VER field.

If you don’t enter the version number, IMA provides the status of the most
recent version of the LSR with that PON.

Select the state where the work for the LSR will be completed.

If you want the start time for a specific service order, type the number of
that service order in the Order Number field.

If you don’t know the number for the service order, you can find it in the
next window, so you’ll have it for future reference.

Click Next.

In the window that appears, the columns show the following information
for each of the service orders associated with the LSR:

In this column ...

IMA displays ...

Order#

The service order number

Due Date

The due date for the service order

Est Start Time

The estimated start time for the service order (if available)

Est Completion Time

The estimated completion time for the service order (if
available)

Technician Status

The status of the work in progress for the service order

CKL

The circuit ID for the service order

161
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6

When you are finished viewing the status history, do any of the following:

« To display the status history in a separate browser window, click Print
Preview.

« To e-mail the status history, click E-mail.
« To display the status history for another LSR, click Start Over.
< To go on to other tasks, click Finish.

Selecting the LSR by its ID

If

you clicked Select by LSR NO, the following window appears:

Estimated Start Time Inquiry. @

LSR HO Query

CCHA | 1Jgg
LSRNO
STATE: ]

Order Mumber

l

Frint Preview ” E-mail ” Start Over ” == Previous ” Mext == ’ Clear ” Finish ]

|

|Java Applet Window

The window shows the CCNA for your company. If your company is a payphone
service provider, the CCNA field shows PSP.

Fill in the blank fields, using these guidelines:

1
2
3

162

In the LSR NO field, type the identification number for the LSR.

Select the state where the work for the LSR will be completed.

If you want the start time for a specific service order, type the number of
that service order in the Order Number field.

If you don’t know the number for the service order, you can find it in the
next window, so you’ll have it for future reference.

Click Next.

In the window that appears, the columns show the following information
for each of the service orders associated with the LSR:

In this column ... IMA displays ...

Order# The service order number

Due Date The due date for the service order

Est Start Time The estimated start time for the service order (if available)

Est Completion Time The estimated completion time for the service order (if

available)
Technician Status The status of the work in progress for the service order
CKL The circuit ID for the service order

April 2, 2012
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5 When you are finished viewing the status history, do any of the following:

« To display the status history in a separate browser window, click Print
Preview.

« To e-mail the status history, click E-mail.
« To display the status history for another LSR, click Start Over.
< To go on to other tasks, click Finish.

Resubmitting an LSR that has been rejected

You can resubmit an LSR that has been rejected, following the guidelines in
the Reject notice. Note that you resubmit the original LSR (with the required
corrections). You do not submit a supplemental LSR.

1 Open the LSR as if you were going to use it as a template for a new LSR.
(Follow steps 1— 6 in “Using an existing LSR or BRC as a template” on
page 67.)

2 Revise the forms, following the guidelines in the Reject notice.

3 Submit the LSR as you normally would (page 75).

April 2, 2012 163
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Preparing a supplemental LSR

You prepare a supplemental LSR when you need to modify an LSR that you've
successfully submitted. You can

< cancel the LSR
< change the due date
« change other aspects of the LSR

You can prepare a supplemental LSR to resubmit an LSR that was rejected.
You can’t supplement Completed or Canceled LSRs—you must submit a new
LSR with a new PON. If you're preparing a supplemental LSR to change the
due date for an appointment you’ve scheduled, schedule a new appointment
first (see “Scheduling appointments” on page 59).

General guidelines for preparing supplemental LSRs are directly below.
Guidelines for preparing supplemental LSRs to change the due date on batch
hot cuts are on page 166.

General guidelines

1 In the Interconnect Functions window, select PreOrder/Order/

PostOrder.

2 In the Interconnect Mediated Access window, select Order > Open
LSR/BRC.
LSR Selection X

Selection Criteria

CCNA cc
PON: VER:
User ID

The Date Range will not he used when a PON is specified.
If the Completed Oniy, Canceled Only ar Completed and Canceled Onty Radio Button is selected, the Date Range can not exceed 90 calendar days.

@) All Pending Statuses (ncluding Purged) O All Pending Statuses
) Completed Only () Canceled Only () Completed and Canceled Gnly
Fram Date il To Date; i

Selection Results

PON WER Original User ID Qriginal Save Date Status LSRID

~

< >

[ PrintFreview || Evmail | [_Fetchisrs || open Highlighted || Furge Highlighted | [ ctear |[ Reset | cancel |

[

[1va AceletWindow

3 Type the PON for the LSR you want to supplement. If you don’t know the
PON, find the LSR you want by specifying search criteria. (See “Using an
existing LSR or BRC as a template” on page 67)

4 Click Fetch LSRs/BRCs.

IMA displays the LSR you specified. (If you specified search criteria, IMA
displays a list of the LSRs that meet your search criteria.)
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5 Double-click the LSR you want to supplement.

PON: 200408108

TOS: 1- Business

Farm Mame

Funt Group Informeation

Mo

Required__ Include

Order Information for, Existing LSR E]

VER:

‘fes -~
[1ng

[End User

[Yes []¥es
Resale Form Ves 7] fes
Listing Forms Mo No a
< >
[ Print Preview “ E-mail H Save ” Submit ” Use as Template H Clear ” Reset ][ Close ]

[E——

6 Type the version number in the VER field.

7 In the Form Name column, double-click Local Service Request.

Local Service Request
q

Administrative Section

3

CCNA FON
usg 20040810a

AN (NNN-X99-0995-595) MNAN
303-896-8461-

PG_of_  DITSENT
200408231604

V|| 2004008122

REQTYPE ACT RETTYP
EB [~
CONVIND Ml

v v
AGAUTH DATED
¥ - Authorization | 2004708721

M M

QK Print Preview E-mail

YER

Admin | Billing| Contact Remarks

DSPTCH  DDD APPTIME

PROJECT CHC

cC AENG ALBR SCA

LSR NO

LOCATY HTGTY LSR REJECT OVERRIDE
11412110 a

DLEC CCNA

APTCON DODO DFDT

I

TEST

v

CEO1 CBOZ

M| Y- Yes v | tesiOl

v

AUTHMM

PORTTYP:  ACTL: Al

BECMCI

v

APOT

SUP EXP

)

1-Cancel
2 - DDD change
3- Other

LST. Lso:

RPON RORD:

v

Pl

RTR

¥ | |C- Confirmation of LER

TOS: NPDI:

DLaTY:

SPEC:

Clear Resat Cancel

[

)

[E——

8 In the SUP list, select the option you want.

e If you select 1 - Cancel, don’t make any other changes.

If you select 2 - DDD Change, make sure that you’ve scheduled a
new appointment (page 62). IMA automatically updates the DDD,

APPTIME, and APTCON fields (on the Admin tab) to match the new
appointment. Don’t change anything else.

9 Submit the supplemental LSR as you would any other LSR. (See
“Submitting a service request (LSR or BRC)” on page 75.) If you changed
the due date, be sure to submit the supplemental LSR within 24 IMA
business hours of scheduling the new appointment so that IMA doesn’t

cancel the appointment.

10 If you have reserved one or more telephone numbers, you’ll need to
reserve them again. (See “Reserving telephone numbers” on page 54.)
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Guidelines for batch hot cuts
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To change the due date for a batch hot cut, you need to ensure that the
original appointment is canceled and that a new appointment is scheduled for
all the LSRs in the batch. To do so, you first retrieve the data from the original
LSR. You then cancel the original LSR, schedule a new appointment, submit a
new LSR (using the data you retrieved from the original LSR), and submit
supplemental LSRs for the rest of the LSRs in the original batch.

1

In the Interconnect Functions window, select PreOrder/Order/

PostOrder.

In the Interconnect Mediated Access window, select Order > Open

LSR/BRC.
[ LSR Selection [

Selection Criteria

CCNA (o103
PON: VER:
User 1D

The Date Range will not be used when a PON is specified.
If the Completed Only, Canceled Only or Completed and Canceled Only Radio Button is selected, the Date Range can not exceed 90 calendar days.

@ All Pending Statuses (neluding Purged) O All Pending Statuses

O Completed Only (O Canceled Only (O Completed and Canceled Only
From Date: i To Date. X

Selection Results

PON WER Original User ID Original Save Date Status LSRID

~

< >

[ PrintFreview || Email | [ Fetehisrs || open Highlighted ]| Furge Highlighted | [ ctear |[ Reset | cancal |

[ l

[1va AceletWindow

Type the PON for the original LSR. (This is typically the first LSR in the
batch, the LSR that has the PON you used to schedule the original

appointment.)

Click Fetch LSRs/BRCs.

IMA displays the LSR you specified.
Double-click the LSR.

[ Order Information for Existing LSR @
PON: 20040810a VER:
REQTYP:
Activity:
Tos: 1 - Busingss v
BAN -
Form Name Required Include
] fes ~
|Hunt Group Information Mo No
End User [Yes ] fes
|Resale Form es [¥]es
Listing Forms Mo [N @
< b4
Edit Form Clear All Forms
| PrintFreview || Email | [ gave || susmit |[ UseasTempate | [ clear [ Reset |[ close |
[ 15+ Aoplet Window

Click Print Preview and print the original LSR.

You'll use the information from the original LSR to create a new LSR (in

step 12) after you’'ve canceled the original LSR.

Type the version number in the VER field.
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In the Form Name column, double-click Local Service Request.

Local Service Request

3]
Administrative Section
CCNA  PON ¥ER  LSRMNO LOCGTY HTGTY LSR REJECT OVERRIDE
ugg 20040810a 11412110 a v
AN (NNN-3(99-0999-999) TAN DLEC GCNA
303-896-8461-
Admin | Billing| Contact| Remarks
PG_of_  DITSENT
200408231604
DSPTCH  DDD APPTIME APTGON DODO DFDT
V|| 2004008122 I
PROJECT CHE TEST
> v
REQTYPE ACT RSTTYP CIP CE01 CE02 Pl
EB [~ V| [Y-Yes v || test0l b
CONVIND Ml SUP EXP RTR
v v ~| C- Confirmation of LER v
cc AENG ALBR SCA
= = = 1 - Cancel
2- DOD change
AGALUTH DATED AUTHNM |3 Other
¥ - Authorization V|| 2004/08/21
PORTTYP:  ACTL: Al APOT: LST. Lso: TOS: NPDI: SPEC:
v 1 =
NG Nl SECNCI RPON RORD: DLOTY:
0
m PrintPreview || E-mail Clear Reset | Cancel
[ )
‘JavaApp\Elednw

10 In the SUP list, select 1 - Cancel. (Don’t make any other changes.)

11 Submit the supplemental LSR as you would any other LSR. (See
“Submitting a service request (LSR or BRC)” on page 75.)

12 When you receive the notice that the original LSR has been canceled,

a

b

Schedule a new batch hot cut appointment, using a new PON. (See
page 59.)

Create a new LSR from the information you retrieved in step 1 above.
(Be sure to use the PON you used for the rescheduled appointment.)

Submit the supplemental LSR as you would any other LSR. (Be sure to
submit it within 24 IMA business hours of scheduling the new
appointment so that IMA doesn’t cancel the appointment.)

13 Open each of the LSRs from the original batch, following steps 1-6 above.

a
b

April 2, 2012

Open the Local Service Request form.

Update the DDD, APPTIME, and APTCON fields to match the new
appointment.

Select 2 - DDD Change. Don’t make any other changes.

Submit each supplemental LSR as you would any other LSR. Be sure to
submit it within 24 IMA business hours of scheduling the new
appointment.
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Viewing DLRs

If you requested a DLR (design layout record) when you prepared an LSR (by
selecting D or X in the RTR field on the LSR form), you can retrieve the DLR
after you successfully submit the LSR. You can view it on your screen, e-mail
it, or print it. The DLR gives technical information on the facilities and
terminations that CenturyLink provides for a circuit—for example, cable
makeup, signaling termination compatibility, and bank type and system
mileage of the carrier channel. This information may be useful to your design
services engineers. To view a DLR, you retrieve it by specifying

the serial number for the circuit (directly below)
the telephone number for the circuit (page 169)
the carrier facility for the circuit (page 171)

the message trunk for the circuit (page 172)

Retrieving a DLR by specifying the serial number for
the circuit

1

168

In the Interconnect Functions window, select PreOrder/Order/
PostOrder.

If you are retrieving a DLR on behalf of another CLEC and if the menu bar
of the Interconnect Mediated Access window doesn’t already show the
corporate ID for that CLEC, continue with this step. Otherwise, skip to step
3.

a In the Interconnect Mediated Access window, click File > Select
Owner CCNA.

b From the list that appears, select the CLEC for which you are retrieving
the DLR. Click Submit.

The CCNA for the other CLEC appears in the menu bar for the
Interconnect Mediated Access window.

In the Interconnect Mediated Access window, select PreOrder > View
DLR.

Circuit ID Format Types
© Serisl Hurmhet
O Telephone Number
©) Carrier Facility
O Message Trunk

| Prntpreview ][ E-mail | stan over Mot x> [ ctear ][ Finisn_|

[

[E——
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4 Select Serial Number, then click Next.

7

View DLR

Serial Number Format

ACNA

Prefix  SWC Code and Modifier  Serial Number Sufiz €O Segment

[ PrintFreview || Email || startOver || =< Previous || Newt=- [ ctear [ Finish |

[

[1v2 AceletWindow

Fill in at least the required fields. The table below shows guidelines for
CenturyLink-specific fields.

In this field ... Type ...
Prefix (optional) The LOC A LATA
SVC Code and Modifier The two to four letters right after the prefix in the serial
number that identifies the circuit
Serial Number A one- to six-digit number that identifies the circuit
Suffix (optional) A three-character extension of the serial number
CO The exchange carrier that assigned the circuit ID
Segment (optional) The segment of a multi-point circuit
Click Next.

The Details field shows the DLR information. (The Circuit Format and
Circuit ID fields show identifiers for the serial number by which you
retrieved the DLR.)

When you have viewed the DLR, do any of the following:

< To display the information in a separate browser window, click Print
Preview.

e To e-mail the information in the window, click E-mail.
e To view another DLR, click Start Over.
< To go on to other tasks, click Finish.

Retrieving a DLR by specifying the telephone number
for the circuit

1

April 2, 2012

In the Interconnect Functions window, select PreOrder/Order/
PostOrder.

If you are retrieving a DLR on behalf of another CLEC and if the menu bar
of the Interconnect Mediated Access window doesn’t already show the
corporate ID for that CLEC, continue with this step. Otherwise, skip to step
3.

a In the Interconnect Mediated Access window, click File > Select
Owner CCNA.
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170

b From the list that appears, select the CLEC for which you are retrieving
the DLR. Click Submit.

The CCNA for the other CLEC appears in the menu bar for the
Interconnect Mediated Access window.

In the Interconnect Mediated Access window, select PreOrder >
View DLR.

View DLR 3]
Circutt ID Format Types

@) Benial Humbel

©) Telephone Number

© Carrier Facility

O Message Trunk

| PrintFreview || Evmail || start Over Nt = [ ctear [ Finish |

[

[1va AceletWindow

Select Telephone Number, then click Next.

View DLR X

Telephone Number Format

ACNA

Prefix  SWC Code and Modifier NPA NKX Line Extension  Segment

[ PrintFreview || Email || startOver || =< Previous || hewt=- [ ctear [ Finish |

[

[1va AceletWindow

Fill in at least the required fields. The table below shows guidelines for
CenturyLink-specific fields.

In this field ... Type ...
Prefix (optional) The LOC A LATA
SVC Code and Modifier The two to four letters right after the prefix in the serial

number that identifies the circuit

Line The specific line in a central office

Extension (optional) The type of equipment or extension being used

Segment (optional) The specific segment of a multipoint circuit
Click Next.

The Details field shows the DLR information. (The Circuit Format and
Circuit ID fields show identifiers for the telephone number by which you
retrieved the DLR.)

When you have viewed the DLR, do any of the following:

< To display the information in a separate browser window, click Print
Preview.

e To e-mail the information in the window, click E-mail.
e To view another DLR, click Start Over.
< To go on to other tasks, click Finish.
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Retrieving a DLR by specifying the carrier facility for

the circuit

1 In the Interconnect Functions window, select PreOrder/Order/

PostOrder.

2 If you are retrieving a DLR on behalf of another CLEC and if the menu bar
of the Interconnect Mediated Access window doesn’t already show the
corporate ID for that CLEC, continue with this step. Otherwise, skip to step

3.

a In the Interconnect Mediated Access window, click File > Select

Owner CCNA.

b From the list that appears, select the CLEC for which you are retrieving
the DLR. Click Submit.

The CCNA for the other CLEC appears in the menu bar for the

Interconnect Mediated Access window.

3 In the Interconnect Mediated Access window, select PreOrder > View

View DLR 3]
Circutt ID Format Types

@) Benial Humbel

©) Telephone Number

© Carrier Facility

O Message Trunk

| PrintFreview || Evmail || start Over

Nt = [ ctear [ Finish |

[

[1va AceletWindow

4 Select Carrier Facility, then click Next.

Carrier Facility Format

ACHA

Channel Group Number  Facility Type  Location A

Laocation 2

[ printPreview ][ E-mail | startover | <<Previous ][ new>» [ ctear ][ Finisn_|

[1va AceletWindow

5 Fill in at least the required fields. The table below shows guidelines for
CenturyLink-specific fields.

In this field ...

Type ...

Channel Group Number

The number of the channel group

Facility Type

The type of facility (e.g., T1 or T1ZF)

Location A

The originating CLLI of the circuit

Location Z

The terminating CLLI of the circuit
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Viewing DLRs

6

7

Click Next.

The Details field shows the DLR information. (The Circuit Format and
Circuit ID fields show identifiers for the carrier facility by which you
retrieved the DLR.)

When you have viewed the DLR, do any of the following:

< To display the information in a separate browser window, click Print
Preview.

e To e-mail the information in the window, click E-mail.
e To view another DLR, click Start Over.
e To go on to other tasks, click Finish.

Retrieving a DLR by specifying the message trunk for
the circuit

1

172

In the Interconnect Functions window, select PreOrder/Order/
PostOrder.

If you are retrieving a DLR on behalf of another CLEC and if the menu bar
of the Interconnect Mediated Access window doesn’t already show the
corporate ID for that CLEC, continue with this step. Otherwise, skip to step
3.

a In the Interconnect Mediated Access window, click File > Select
Owner CCNA.

b From the list that appears, select the CLEC for which you are retrieving
the DLR. Click Submit.
The CCNA for the other CLEC appears in the menu bar for the
Interconnect Mediated Access window.

In the Interconnect Mediated Access window, select PreOrder > View

DLR.

View DLR X
Circuit ID Format Types

@ Berial Humbet

O Telephane Number

O carrier Facility

© Message Trunk

[ Print Preview “ E-mail “ Start Qver Next == [ Clear ” Finish ]

[E——

Select Message Trunk, then click Next.

View DLR X
Message Trunk Format

ACNA

Trunk No.  Traffic Class  Office Class  Use Code  Traffic Modifier  Location A Pulze &Dir LocationZ

PrntPreview || E-mail statover || <<pravious |[ neas» clear || Finish
‘Java Applet Windows
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5—After submitting service requests
Monitoring the status of batch hot cuts

5 Fill in at least the required fields. The table below shows guidelines for
CenturyLink-specific fields.

In this field ...

Type ...

Trunk No.

The trunk number

Traffic Class

The routing arrangement

Office Class

The switch type

Use Code

The type of service offered on trunk group

Traffic Modifier (optional)

Additional trunk group information

Location A

The originating CLLI of the circuit

Pulse & Dir (optional)

Type of pulsing and direction of pulse

Location Z

The terminating CLLI of the circuit

6 Click Next.

The Details field shows the DLR information. (The Circuit Format and
Circuit ID fields show identifiers for the message trunk by which you

retrieved the DLR.)

7 When you have viewed the DLR, do any of the following:

« To display the information in a separate browser window, click Print

Preview.

e To e-mail the information in the window, click E-mail.
e To view another DLR, click Start Over.
< To go on to other tasks, click Finish.

Monitoring the status of batch hot cuts

You can open a separate browser window to monitor the status of batch hot
cuts scheduled for your company or completed during the past 7 days. (You
may not be able to monitor the status of batch hot cuts for another CLEC even
if you are their agent. For each scheduled batch hot cut, IMA displays the due
date, the CLLI for the switch from which the service is provided, the last event,
new events (if any), and the details of the batch hot cut.

1 In the Interconnect Functions window, click Batch Hot Cut Status.

/@ Batch Hot Cut Status - Microsoft Internet Explorer (D=1
~ User: ¢l

Batch Hot Cut Status ser CEC—““
ogout

CLEC: U99 Date: 07 |/[25 |¢[2005 |CLLL

Refresh Interval | off v [ Refresh Now ][ Download Al ]
{*All times are in Mountain Tirme)
CLEC  Due Date CLLT  *Last Event New Events

Recerds 0 thr 0 of 0

Firet Page H Last Page ][ Next Page H Prev Page

&] Done

%3 Local intranet

April 2, 2012

173

http://www.centurylink.com/wholesale/cmp/review_archivesystem.html



5—After submitting service requests User’s Guide—IMA 32.0
Monitoring the status of batch hot cuts

2 Do one of the following:

To list all batch hot cuts scheduled for your company or completed
during the past 7 days, clear the Date field and leave the CLLI field
blank.

To list the batch hot cuts scheduled for a specific date and/or for a
specific switch, type the scheduled date in the Date field and/or the
CLLI code for the switch in the CLLI field.

= For the CLLI field, use the code for the switch from which the
service originates

< For the Date field, remember that you can specify future dates or
dates up to 7 days in the past.

Tip:You can use the percent sign (%) as a wildcard in the CLLI
field.

3 Click Filter.

IMA lists all batch hot cuts that meet the criteria you specified.
If more than 18 records are listed, use the buttons at the bottom of the
window to navigate through the list.

4 Do any of the following:

To view the status and related information for any of the batch hot cuts,
click View Details. (When you are done, click Previous to return to
the main status window.)

Tip:To sort any of the columns, click the column heading.
To refresh the data automatically, select a refresh interval.
To manually refresh the window. click Refresh Now.

To list the batch hot cuts for a different date or switch, repeat steps
2-3.

To close the window, click Logout.

To download the list so you can view it in a spreadsheet, click

Download All. If you select Download All, IMA prompts you to open
or save the file.

Caution: If you select Open, depending on your computer settings,

the file may open within your browser (instead of in a
separate window). If this happens, use the Back button in
your browser to get back to your IMA session. If you close
the browser window, you lose your IMA session and any
unsaved changes.
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As needed

Several tasks are not tightly tied into the process of preparing, submitting, and
following up on LSRs. Accordingly, you can do these tasks at any time. You can

< modify your personal profile (directly below)
 change your password (page 175)
- view the corporate user profile for your company (page 177)

« view BAN (billing account number) information for your company
(page 180)

- find the NC, NCI, and SECNCI codes for a product (page 181)
< view and download line loss notifications (page 183)

- display a list of the agent or owner CLECs for your company (page 189)

Modifying your personal profile

After you've created and saved your personal profile, you can modify it further
as needed.

1 In the Interconnect Functions window, click User Administration.

{2 PersonalProfile - Windows Internet Explorer E@E
& - | E3|ES 21

Fie Edt Wew Favortes Tooks Hel

Personal Profile

Name: |IMA Documentation
Telephone Number: [111-222.3333
E-Mail Address: |imadocs@qwestcom
Fax: | 1234567890
Street Address: 930 15th Street
Floor: |5
Room/Mail Stop:
City: |Denver
State: |[CO v
Zip/Postal Code: 80202

Update Database

Return to Main Menu

W Local intranet 100% -
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6—As needed
Changing your password

2 Click in each field to be modified, and change the information. (Remember
to use the format 555-555-5555 for the telephone and fax numbers.

3 Click Update
IMA indicates

Database.
that your personal profile has been updated.

4 Click Return to Main Menu.

Changing your password

For security reasons, you should change your password often.

1 In the Interconnect Functions window, click Set Password.

ﬁ Set Password - Windows Internet Explorer Q@E

& -2

File Edt Wiew Favorites Tools

b 4t fiHome - mhPrint

~ b Page - ) Tooks - @ Hep ~

|4/ = Al

Help

Set Password

Enter New Password.

0Old Password:
New Password:

Re-Type New Password:

Return to Main Menu

& Local intranet F100% -

2 Do the following:

In this field ... Type ...

Old Password

Your current password

New Password

Your new password (6—8 characters, at least one of which is

Re-Type New Password

a number or special character)

3 Click Set Password.
IMA changes your password.

April 2, 2012
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Viewing your company’s corporate user
profile

You can view your company’s corporate user profile. The corporate user profile
lists, by state, what services your company is allowed to offer. It also verifies
how your company wants to receive various types of notices. This is a view-
only window. To change the corporate user profile, contact the CenturyLink
Wholesale Systems Help Desk at 888-796-9102 and select option 2.

To view your company’s corporate user profile

1 In the Interconnect Functions window, click System Administration.
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6—As needed
Viewing your company’s corporate user profile

Under Account Administration, click View Corporate User Profile.

Corporate User, Profile - Windows Internet Explorer,

(<]

)~ [&

o 42 [ [ (2B

{ Bl Edt View Favortes Took  Hel

W e MjHome v @hPrnt ~ [-Page - £ Took ~ @) Help -

Corporate User Profile

Corporate User ID: U99

Corporate User Name: [[Your company name]

Certified to do Business

State Business

]
]
-

[Residence |Coin Non-Impaired

‘Arizona

<

<

Colorado

K

<

Tdaho

<

<

K

Towa

<

MMinnesota

<

<

<

Montana

<

MNebraska

<

<

<

New Mexico

<

MNorth Dakota

T

<

<

Oregon

<

South Dakota

T

<

[Utah

K

<

[Washington

K

<

<

Wyoming

b e e e e e e e e e e
b e e e e i ¥ e e N
b e e e e e e e e e

<

Select El ic Line Loss

~

[ Wireless

[ Send Line Loss to E-Mail:
and/or Fax

[ Certified

[ Send Line Loss to Trading Partner ID-

Select GUI Line Loss Notifications

Line Loss Notification Inactive

Select Electronic Status Update Options
[FILSR Statuses [] Order Statuses [¥]Enable BHC Statuses

Receive Non-Fatal Errors

CLEC TAP/Lifeline Guideline Compliance

L1
L1

2008-02-14 13:31:16.0

by CLEC authorized officer: |

on date:

L

ticket # I

Updated:

Thu Nov 20 11:00:46 MST 2008

[IProhibit LSR Reject Override

Return to System Administration

Dane

% Local intranet & 100%

IMA displays the corporate user profile for your company:

In this field ...

IMA displays ...

Certified to do Business

The check boxes show the states in which your company is
certified to do business and the type of business you are
certified to do.

Wireless

If the check box is selected, your company is authorized to
do wireless business.

Select Electronic Line
Loss Notifications

If your company wants to receive line loss notifications via
IMA XML, the check box is selected, and the field shows the
trading partner to which the notifications are to be sent.

April 2, 2012
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In this field ... IMA displays ...
Select GUI Line Loss If your company wants to receive line loss notifications via
Notifications the IMA GUI, the check box is selected and the field shows

the e-mail address and/or the fax number to which the
notifications are to be sent.

Select Electronic Status If your company uses IMA XML, this shows the status
Update Options updates you've asked receive and indicates whether you
want to be notified of non-fatal errors.

CLEC TAP/Lifeline If your company has indicated that you have TAP/Lifeline

Guideline Compliance certification, the check box is selected and the field shows

« the name of the CLEC officer who authorized the TAP/
Lifeline certification

= the date and number of CenturyLink’s help desk ticket

Prohibit LSR Reject If the check box is selected, you can’t resubmit LSRs that
Override were rejected because of errors listed in the LSR Override
table.

3 When you are done, click Return to System Administration.
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Viewing BAN information for your company

Viewing BAN information for your company

You can view a list of the BANS (billing account numbers) assigned to your
company. You can also view information on each BAN.

To view the BANs for your company

1 In the Interconnect Functions window, click System Administration.

2 Under Reports, click Get BAN List.

(= Billing Account Number List - Windows Internet Explorer: Q@EI
PR
G- = 3 [6)[x 3

Fie Edt Wiew Favortes Tooks Hep

T & Mprome - ciPdnt v |2k page - G Took - @) Help -

Billing Account Number List

Corporate ID: U99
Corporate Username: Qwest

Billing Account Number Description
123-B11-1234-111 test
123-C11-1234-111 test

Return to System Administration

% Local intranet. # 100% v

IMA displays the billing account number(s) assigned to your company. This

is a list of all BANs that appear in the BAN list in the Order Information
for New LSR/BRC.

To view information for each BAN

1 In the Interconnect Functions window, click System Administration.

2 Under Account Administration, click View Billing Account Number.

G- @ %]

Fie Edt Yew Favortes Tooks Hep

{2 Billing Account Number - Windows Internet Explorer =13
ol

% &t [MjHome ~ @hPhnt v |- Page = {F Tooks - @) Hep -

Billing Account Number

Enter Billing Account Number for Corporate ID: TU%9.
Billing Account Number:

Return to System Administration

& Local intranet F100% -

3 Type the BAN you want to view information for, and click Get BAN
Information.

IMA displays the information on the BAN you specified.
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Finding the NC, NCI, and SECNCI codes for a
product

You can view the NC, NCI, and SECNCI codes for many products, along with
descriptions of the codes and products drawn from CenturyLink’s Technical
Publications. If your system administrator has configured your workstation to
allow for copying and pasting between applications, you can copy and paste
the code for your product into the LSR form. The codes are displayed in a
separate browser window, which you can leave open while you do other tasks.

1 In the Interconnect Functions window, click View CLEC Reference
Data.
(If you are in the Interconnect Mediated Access window doing other
PreOrder, Order, or PostOrder tasks, click File > Exit, then click Return To
Main Menu.)

/A Reference Data Table Maintenance Tool - Microsoft Internet Explorer =1E3

Reference Data

&] Done % Local inkranet:
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6—As needed
Finding the NC, NCI, and SECNCI codes for a product

In the Reference Data list, select IMA_PRODUCT_NCCODES - IMA
Product NC/NCI Codes.

/2 Reference Data Table Maintenance Tool - Microsoft Internet Explorer

Reference Data

EBX

Product NC Code NCI Code

ERODUCT HC CODE  HCI CODE SEC HCI CODE  DESCRIPTION

DESIGN TRKS TGNA O4E4Z.E wwhwdEeAnatt  Type I EcM signaling at e
DESIGN TRKS TGNA O4EAZ. N wwhararssatt  Type I E<M signaling at e
DESIGN TRKS TGNA O6EAZ.E wEmmrmrsaatt  Type I E<M signaling at e
DESIGN TRKS TGNR O6EAZ.N TEREFTEEAATT  Type [ ESN signaling at =
DESIGN TRKS TGNA QIR B SRESTETOIen: Type II EgM signaling at ¢
DESIGN TRKS TGNA OGEBZ. N wrksrsssast  Type 11 EcM signaling at «
DESIGN TRKS TGNA OSEBZ.E wwhwderAnatt  Type I1 E<M signaling at
DESIGN TRKS TGNA 0BEBZ.N wrmmrmrsaatt  Type 11 EM signaling at «
DESIGN TRKS TGNR TL11E wwmmrmrrants  FIC - Convert te NCI D2EA
DESIGN TRKS TGNR TL11M TEEETTIAAALT  FIC - Convert ta NCI DaEA
DESIGN TRKS TGNA TL1ZE ~ seEssssessas FIC - Convert to NCI OSEL
DESIGN TRKS TGNA TLizM wwhaarasats  FIC - Convert to NCI DEEE
DESIGN TRKS TGNA TL31E wwhaaeknast  FIC - Convert to NCI DSEA
DESIGN TRKS TGNA TL31M wrmmrmrsaatt  FIC - Convert to NCI DGEA
DESIGN TRKS TGNR TL3ZE wwmmrmrsaatt  FIC - Convert te NCI OSEB:
DESIGN TRKS TGNA TL3ZM  sEEssssessas FIC - Convert te NCI OSEE:
DESIGN TRKS UDN& O4E4Z.E wwhwdEeAnatt  Type I EcM signaling at e
DESIGN TRKS UBNA O4EAZ. N wwhararssatt  Type I E<M signaling at e
DESIGN TRKS UDNA O6EAZ.E wEmmrmrsaatt  Type I E<M signaling at e
DESIGN TRKS UDNZ O6EAZ.N TEREFTEEAATT  Type [ ESN signaling at =
DESIGN TRKS UDN& QIR B SRESTETOIen: Type II EgM signaling at ¢
DESIGN TRKS UDN& OGEBZ. N wrksrsssast  Type 11 EcM signaling at «
DESIGN TRKS UBNA OSEBZ.E wwhadaisnats  Type I1 E<M signaling ac to,
< b4
&] Dore & Local inkranet:

Select the products and codes you want to display.

To display ...

Do the following ...

The codes for a specific product

Select the product from the list.

A specific NC code

Type the code you want to display in the NC field.

Tip: If you know only part of a code, type “%”
(percent sign) before and after the part of
the code you know.

A specific NCI code

Type the code you want to display in the NCI field.

Tip: If you know only part of a code, type “%”
(percent sign) before and after the part of
the code you know.

Click Search.

IMA displays the codes for the product(s) you selected.

To display the items in any column in alphabetical order, click the column

head.

When you have found the codes you need, do any of the following:

e To print the codes, click PRINT.
(Because the descriptions are quite long, you might want to print in
landscape mode.)

e To close the Reference Data window, click LOGOUT.
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Viewing and downloading line loss notifications

Viewing and downloading line loss
notifications

April 2, 2012

If your system administrator has requested line loss notifications, you receive
a notification when you lose a WTN to another service provider. You can view
and download the line loss notification as soon as the other provider’s service
order has been completed. (You can only view line loss notifications for your
corporate ID—even if you are an agent for another CLEC.)

In IMA, you can view and download line loss notifications (for the past six
months) to see what line or lines have been lost. You can search for line loss
using any or all of the field in the window. The three most common ways to
search for losses are by completion date (CVD—page 184), telephone number
(WTN—page 186), and circuit ID (ECCKT—page 187). If you choose to search
by filling in your own combination of fields, use these guidelines to help you:

1 In the Interconnect Functions window, click Line Loss.

£ Windows Internet Explorer E@@
(< IS AR ¥4 [x o
File Edit Wiew Favorites Tools Help
T2t MpHome - dmPrnt v [ Page v () Took v @) Help -
.
Line Loss

Selection Criteria

ACCTNO:

WIN: ECCKT:
ORDW: PONW:
CVD: TRACKID:

CORP ID: U9

SUBMIT | [ CLEAR ] [ MAINMENU

& Local inkranet #100% -

2 Fill in one or more of the fields to identify the lost account:

In this field ... Type ...

ACCTNO The main account number on the service order
(Use the format 000-000-0000 or 000-000-0000-000)

WTN The working telephone number at the customer’s service
address

ECCKT The other service provider’s circuit identification

ORDW The other provider’s service order (LSP) nhumber

PONW The other provider’s purchase order number for the new

service order (LSP)

CVvD The completion date (Use the format YYYY/MM/DD)
TRACK ID The tracking number for the notification
CORP ID Your corporate ID (automatically filled in)
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6—As needed
Viewing and downloading line loss notifications

Tip: To avoid having your search time out, fill in as many fields as you
can. If your search times out, select additional criteria to narrow

your search.

3 Click SUBMIT.

The Line Loss window shows the line(s) your company has lost.
For an explanation of the fields in the window, see “Interpreting line loss
information” on page 188.

4 Do one of the following:
To search for other line loss notifications, click Criteria.
To go on to other tasks, click Main Menu.

To download the list so you can view it in a spreadsheet, click
Download All. If you select Download All, IMA prompts you to open

or save the file.

Caution:

If you select Open, depending on your computer settings,

the file may open within your browser (instead of in a
separate window). If this happens, use the Back button in
your browser to get back to your IMA session. If you close
the browser window, you lose your IMA session and any

unsaved changes.

Retrieving line loss information by completion date

1 In the Interconnect Functions window, click Line Loss.

{2 Windows Internet Explorer A=
£ F MIETIES L~
Fie Edit Wiew Favorites Tools Help
¢ fptome - A Pdnt v |52 Page ~ ik Tooks + @) Help -
Line Loss
Selection Criteria
ACCTNO:
WIN: ECCKT:

ORDW: PONW:

CVD: TRACK ID:

CORP ID: U39

SUBMIT | [ CLEAR | [ MAINMENU

| 100% v

% Local intranet

2 In the CVD field, type the completion date you want to retrieve line loss
information for. (Remember, you can on retrieve information for the past
six months.)

April 2, 2012
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3 Click Submit.

6—As needed
Viewing and downloading line loss notifications

IMA lists all lines lost for your corporate ID on the date you specified.

= Windows Internet Explorer

G- &

Fle Edt Wiew Favortes Took  Hep

T & fGyHome - dwhPrint

~ |5k Page ~ {J Tooks + @) Help +

8]=E]

¥ [*2) | X R~

ACCT NO ORDW
303-C12-3456-888 D12123434

218-987-6543-123  DORIRTETEA

PONW
10001000

ABCO1

Line Loss

CvD WIN
0410672008

04/06/2008  213-987-6543

TERS/DID VIN

ECCKT TRACK ID NPDI
29 L3FU 222333 M3 1001125222

1001126122

April 2, 2012

[ Criteria ][ Wain Menu H Download All

& Local intranet F100% -

Do one of the following:

If you are done reviewing the line loss information and want to search
for other line loss information, click Criteria.

If you are done reviewing line loss information and want to go on to
other tasks, click Main Menu.

If you need help interpreting the line loss information you retrieved,
see “Interpreting line loss information” on page 188.

If IMA displays a No Matching Records Found, click Criteria and
check the information you entered. If the information you typed is
correct, there is no loss information available (possibly because the loss
occurred more than six months ago).

If you receive a message that the line loss query as timed out, follow
the directions on the screen.

If you want to download the line loss information as a spreadsheet,
click Download All.
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6—As needed
Viewing and downloading line loss notifications

Retrieving line loss information by telephone number

In the Interconnect Functions window, click Line Loss.

(= Windows Internet Explorer

G- =

v\z, x\

Fie Edt Yew Favortes Tooks Hep

% 4 Eprome - @ Pt

~ |52 Page ~ { Tools ~ @) Help -

Line Loss
Selection Criteria

T S —

wise [ ] EcekT: |

orow: ] eonw:. [
eo: ] tRackm:[ ]

CORP ID:

SUBMIT | [ CLEAR | [ MAINMENU

% Local intranet

| 100% v

2
information for.

Click Submit.

In the WTN field, type the telephone number you want to retrieve line loss

IMA shows the loss for the telephone number you specified.

{2 Windows Internet Explorer

G- =

3= |

|2
Fle Edt Wew Favortes Toos Hep
% &t [MjHome ~ @Prnt v [ Page - 3 Tooks - @ Hep -
.
Line Loss
ACCT NO ORDW PONW CVD WIN TERS/DID YIN ECCKT TRACKID NPDI
218-987-6543-123 D9RIBTETEA ABCO1 04/06/2008 218-937-6543

1001126122

[ Criteria ][ Main Menu ][

Download All

& Local intranet H100% -

4 Do one of the following:

for other line loss information, click

other tasks, click Main Menu.

If you are done reviewing the line loss information and want to search

Criteria.

If you are done reviewing line loss information and want to go on to

If you need help interpreting the line loss information you retrieved,

see “Interpreting line loss information” on page 188.
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Viewing and downloading line loss notifications

If IMA displays a No Matching Records Found, click Criteria and

check the information you entered. If the information you typed is
correct, there is no loss information available (possibly because the loss
occurred more than six months ago).

the directions on the screen.

click Download All.

Retrieving line loss information by circuit ID

1

/= Windows Internet Explorer

In the Interconnect Functions window, click Line Loss.

G- e

#[4) [x] |

File Edit Wiew Favorites  Tools

& & fGyHome - dwhPrint

~ |5k Page ~ {3 Tooks + @) Help -

Help

wiwe [
orow: |
eo: ] tRackm:

Line Loss
Selection Criteria

T S —

ECCKT: |

poNw: [ ]

CORP ID:

SUBMIT | [ CLEAR | [ MAIN MENU

2

% Local intranst ®00% -

information for.

3

Click Submit.

IMA lists all lines lost for your corporate ID for the circuit ID you specified.

{= Windows Internet Explorer

In the ECCKT field, type the circuit ID you want to retrieve line loss

If you receive a message that the line loss query as timed out, follow

If you want to download the line loss information as a spreadsheet,

G-

o x| 2
Ele Edt Wiew Favorites Tooks Help
o & freme - dshPure - [ page ~ i Tools - @ Heb -
Line Loss
ACCT NO ORDW PONW CVD WIN TERS/DID VTN ECCKT TRACK ID NFDI
303-C12-3456-828 D12123434 10001000 04/06/2008 29 LXF1UI 222333 M3 1001125222
[ Critaria H tdain Menu ][ Download Al
& Local intranst FA00%

4 Do one of the following:
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6—As needed
Viewing and downloading line loss notifications

If you are done reviewing the line loss information and want to search
for other line loss information, click Criteria.

If you are done reviewing line loss information and want to go on to
other tasks, click Main Menu.

If you need help interpreting the line loss information you retrieved,
see “Interpreting line loss information” on page 188.

If IMA displays a No Matching Records Found, click Criteria and
check the information you entered. If the information you typed is
correct, there is no loss information available (possibly because the loss
occurred more than six months ago).

If you receive a message that the line loss query as timed out, follow
the directions on the screen.

If you want to download the line loss information as a spreadsheet,
click Download All.

Interpreting line loss information

Depending on the loss information available, some of the columns may be
blank. Use the following table to help you interpret the information you

obtained:
In this field ... IMA displays ...
ACCTNO The main account number on the service order
ORDW The other provider’s service order (LSP) humber
PONW The other provider’s purchase order number for the new
service order (LSP)
CvD The completion date (Use the format YYYY/MM/DD)
WTN The working telephone number at the customer’s service
address
TERS/DID The terminal number on a multi-line hunting line or the
number of the trunk or line being used for direct inward
dialed calls
VTN The voice line telephone number
ECCKT The other service provider’s circuit identification
TRACK 1D The tracking number for the notification
NPDI Whether the line was converted to wireless or wireline:
= B = wireless to wireline
= C = wireline to wireless
= V = VOIP to wireline/wireless
If this field is blank, the loss was from wireline to wireline

Formatting downloaded line loss information

Depending on your computer settings, you may have trouble viewing numeric
PONs with more than 15 digits in Excel. To view these PONs and avoid losing
the last digit, do the following:

1 Open the line loss file in Excel.
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Viewing a list of agent or owner CLECs

2 Select column A, then click Data > Text to Columns.

3 In the Original data type box, select the Delimited option button, then
click Next.

4 In the Delimiters box, select the Comma check box and be sure it's the
only box selected in the window, then click Next.

5 In the Data preview box, click the column that starts with PONW.
6 In the Column data format box, click the Text option button.

7 Click Finish.

Excel converts the file you downloaded into a spreadsheet and leaves the
numeric PONs with same characters in text format as were downloaded
(instead of converting the last digit to zero).

Viewing a list of agent or owner CLECs

You can display a list of the agent or owner CLECs for your company (identified
by their corporate ID). The list also shows the beginning date of their
agreement with your company and—if the agreement has been
terminated—the date it will expire.

1 In the Interconnect Functions window, click System Administration.

2 In the IMA System Administration window, under Reports, click Get
Agent/Owner List.

(= Get Agent/Ovwner List - Windows Internat Explorer.

@ < A | 42| % o=
Ele Edt View Favorites Took Help
dr o fGHome - @Pmne - [k Page - {0 Tools - @) Help -

Get Agent/Owner List

Corporate ID: U99

Application: | IMA v
Relation: | Agent v

Get Agent/Owner List

Return to System Administration

Done & Local intranet 100% -

3 In the Relation list, select whether you want to display the agent CLECs
for your company or the owner CLECs.

4 Click Get Agent/Owner List.
IMA lists the corporate IDs of the agent or owner CLECs for your company.
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